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Declaration of Conformity

Manufacturer’s Name: Fractal Audio Systems, LLC
Manufacturer's Address: 4 Wilder Drive, Plaistow, NH 03865 USA

Declares that the product:
Product name: FM3 Product option: None

Conforms to the following Product Specifications:

Safety: EN60065:2014
EMC: EN55013:2013
EN55020:2007+A11:2011
EN55024:2010
EN61000-3-2:2014
EN61000-3-3:2013

Supplementary Information:
The product herewith complies with the requirements of
the Low Voltage Directive 2006/95/EC
and the EMC Directive 2004/108/EC.

Clifford Chase
President / CEQ
January 22, 2018

EMC/EMI

This equipment has been tested and found to comply with the limits for a Class B Digital device, pursuant
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. There is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

4
4
4

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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Legal Notices

Fractal Audio Systems FM3 Owner’s Manual. Contents Copyright © 2019. All Rights Reserved.
No part of this publication may be reproduced in any form without the express written permission of Fractal Audio Systems.

Fractal Audio, the Fractal Audio Systems logo, Axe-Fx, FM3, Humbuster, UltraRes, FASLINK are trademarks of Fractal Audio Systems. Manufacturer names
and product names mentioned herein are trademarks or registered trademarks of their respective owners, which are in no way associated with or affiliated
with Fractal Audio Systems, LLC. The names are used only to illustrate sonic and performance characteristics.

mportant Safety Instructions

WARNING: To reduce the risk of fire or electric shock, do not expose this appliance to rain or
moisture.

CAUTION: To reduce the risk of fire or electric shock, do not remove screws. There are no user
serviceable parts inside. Refer servicing to qualified service personnel.

—_

Obey all warnings on the FM3 chassis and in this User Guide.

Keep away from sources of heat such as ducts, registers or appliances that produce heat.
Do not obstruct or cover over the side or bottom ventilation holes.

Connect only to a standard grounded AC outlet of 100-240V, 47-63 Hz.

Keep the power cord in good condition. Do not kink, bend, or pinch.

If the cord becomes damaged, discard and replace it.

If not using your FM3 for extended periods of time, disconnect from AC power.
Protect the unit from rain and excessive moisture.

Refer servicing to qualified personnel only.

Stop operation of the unit and obtain service if:

- Liquids or excessive moisture enter the unit.

- The unit operates incorrectly or performance is inconsistent or erratic.

- The unit has been dropped and/or the enclosure damaged.

10. Prolonged exposure to high volume levels can cause hearing damage and/or loss.
The use of hearing protection in high volume situations is recommended.

N
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A Manual for Online and Print Use

This manual is intended for use in desktop, tablet, and smart phone readers. It includes clickable links and bookmarks to make navigation
and cross-reference easy. We recommend against printing, because firmware updates tend to make older manual versions fall out of date.
That said, considerations have been taken for those who prefer paper. You are granted permission to print this PDF for personal use only.
A copy center or online printer can print and bind a book for you from the PDF file. Hopefully those with screen readers can forgive the
changes made herein to accommodate the print version: all links also include a page or section numbers, page spreads have extra margins
towards the binding edge, and blank pages have been included to preserve page and chapter flow.
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1 INTRODUCTION
WELCOME

Thank you for choosing the Fractal Audio Systems FM3, an all-in-one amp modeler, effects processor and foot
controller based on the award-winning Axe-Fx Ill and its companions, the FC-6 and FC-12. The new FM3 places
some of our best technologies into a highly portable, “grab-and-go” format. It is ruggedly built to withstand the
rigors of touring, while still delivering the nuance, accuracy, and sound quality that have earned Fractal Audio its
place in the world's top studios and on stage with some of the biggest tours in the world. Never before have we
offered so much in a unit so compact as the FM3.

Sonically, the FM3 is the direct descendant of our flagship, with an ultra-high quality signal path and the latest
ARES amp models. FM3 also includes many of our most popular features like scenes, channels, modifiers, flexible
routing, footswitch layouts, USB recording/re-amping/playback, and much more. It is expandable with a FASLINK™
[l port supporting up to two FC controllers for up to 24 additional footswitches. It is also cross-compatible: FM3-
Edit not only delivers everything you've come to expect from our best-in-class software, but even converts Axe-Fx
Il presets for the FM3 (and vice versa).

FM3 truly demonstrates that good things come in small packages. No other platform offers the same sonic
performance while being as flexible and fun. This unique combination has made Fractal Audio the tool of choice
for some of the world’s mightiest guitar heroes, yet we also hear again and again from “weekend warriors” who
tell us that our products make them “a better player,” on a permanent honeymoon, in love with their tone.

Whether you want the pure simplicity of a great guitar straight in to a classic amp, or choose to venture into totally
unexplored sonic territory, the FM3 delivers the legendary Fractal Audio experience — and fits it in a backpack.

We hope you enjoy using it as much as we have enjoyed creating it.

Fractal Audio Systems
January 2020

|—



1 INTRODUCTION

FEATURE SUMMARY

The FM3 is powered by a 3-Core “Griffin” DSP with one ARM
and two SHARC+ cores, plus a GPU. It is the only product
of its kind to feature Fractal Audio’s ARES amp modeling,
cab sims, and legendary stompbox and studio effects.

Durable steel chassis with protective endcaps
designed to withstand the rigors of touring.

FM3 features an ultra-high-quality signal path
for extremely low THD and noise floor.

FM3 features our “crown jewel”: ARES amp modeling
technology developed for the Axe-Fx Ill. ARES captures

the sound and feel of real tube amps, with hundreds of
models offering an impressive range of clean tones, elusive
“edge of breakup”, and everything from warm, touch-
sensitive overdrive to face-melting modern distortion.

The FM3 Cabinet Simulator block loads up to two
impulse responses for extremely accurate response
and dynamic remixing including visual phase alignment.
2,048 factory cabs include every option from the Axe-Fx
Il plus all 189 “Legacy” Cabs from the Axe-Fx II/AX8.

1,024 User Cab memory locations allow you to load
Cab Packs and other 3rd party IRs. Compatible
formats include, .ir, .syx, and .wav; Sixteen Scratchpad
memories are provided for experimentation.

As a multi-effects unit, the FM3 includes a superb
selection of state-of-the-art “blocks” based on those from
Axe-Fx llI, including 42+ drives, 50+ reverbs, 30+ delays,
compressors, EQs, filter, chorus, flanger, phaser, pitch
shift, rotary, tremolo, synth, wah and many more.

Input and Output blocks provide incredibly flexible
routing, with setup diagrams included for FRFR, direct
FOH plus “live” power amp and guitar cabs, creating an
“FX Loop” for pedals, simultaneous electric and acoustic/
piezo, the popular “four cable method”, and more.

512 Preset memories can each store an entire rig
with its own amp, cab, effects, and much more.

12x4 layout grid, with “Zoom Out" option to show the
entire grid on one page, including VU meters!

Eight nameable “Scenes” per preset eliminate “tap
dancing” and allow for quick sound changes - including
easy “spill-over” of effects like delay and reverb, plus
Scene MIDI messages for complete rig integration.

“Channels” give each block up to four different sound
settings. One drive block, for example, can provide four totally
different drive pedal sounds with no extra CPU “cost.”

Easy-to-read, precision full-screen tuner includes
a bar graph and virtual strobe display.

4x4 USB audio capabilities allow for recording,
playback, re-amping and more.

FM3 features our latest interface and navigation controls,
featuring the same custom color display as the flagship
Axe-Fx I, with five knobs with on-screen labels providing
instant access to both turn and push functions.

N

Dedicated hardware navigation controls for NAV, VALUE and
PAGE provide great ergonomics and efficiency, plus instant
familiarity to those coming from another Fractal Audio product.

Three onboard footswitches use our “FC” system for extreme
flexibility, with nine layouts containing 12 switch definitions
each. A new “Views” feature maximizes the utility of FC Layouts.

Each footswitch has its own mini LCD display to show
the function of the switch, plus a variable color LED ring
which shows the category and status of the switch.

Every switch can have its own fully-customizable tap and
hold functions. Change presets, banks, scenes, effects,
channels, operate the looper, tuner, tap tempo, and more.

Per-Preset Switches: any preset can cleanly and easily override
any footswitch in any layout, providing incredible flexibility.

Modular Control! Those who wish for more footswitches
can use FASLINK™ to connect one or two FC-6 or FC-12
controllers. These integrate seamlessly with onboard
switches and also offer additional switch/pedal jacks.

Two pedal jacks each allow connecting external switches
or expression pedals like the Fractal Audio EV-1 or EV-2.

Four top panel LED input meters plus two output “clip” LEDs
provide visibility of critical levels. Onscreen animations
show level for every block, input, output, and more.

Input 1 is ultra-low noise, with a 1/4” mono Instrument
input featuring “Secret Sauce IV” for optimized signal
from your guitar or bass. Output 1 is Stereo, with
Balanced XLR jacks, plus a stereo headphone out.

Input 2 is Stereo, with balanced 1/4” inputs.

Output 2 is Stereo, with 1/4" designed for “unity gain”
with the knob “wide open”, and featuring Humbuster™
technology to help combat noise from ground loops.

An independent SPDIF output can transmit a choice of signals.

MIDI IN and combination OUT/THRU ports, backed
by a rich MIDI implementation with extensive MIDI
transmit and remote-control possibilities.

“Client-Server” architecture allows multiple FC series
foot controllers and FM3-Edit to control the FM3 and
update each other seamlessly and instantly.

A connected computer allows the use of FM3-Edit, our
world-class editor for Mac and PC, and Fractal-Bot,
for firmware updates plus backup and restore.

FM3-Edit allows FM3 to load Axe-Fx Il presets, within
the limits of local block and CPU resources.

A built-in backup firmware ROM allows recovery
in the event of complications during an update
without the need for professional service.

The FM3 has upgradeable firmware allowing for
constant improvement and innovation.



1 INTRODUCTION

THE SETUP MENU

Throughout this manual, you will be directed to the SETUP menu of the FM3 for a range of options including
I/0, MIDI, global settings, and more. The SETUP menu includes the following areas:

» The FC Controllers/Onboard Switches menu includes all settings for the onboard switches or a
connected FC controller.

= The Global Settings menu includes options which govern the global behavior of the FM3.

= The /0 menu contains settings for all inputs and outputs, including levels, audio options, and
switches or expression pedals connected directly to the FM3.

= The MIDI/Remote menu contains MIDI settings, plus several pages of remote controller assignments
for the many remote-controlled functions of the FM3.

= The Utilities menu contains readouts, utilities, and a control to adjust screen brightness.

To access and use the SETUP menu:

»
»
»

Press HOME.

Push the “E" soft knob for the SETUP main menu.

Use the NAV buttons to select a sub-menu and press ENTER to make a selection.

Use PAGE and NAV buttons to get around. Use VALUE and knobs A-E to make changes.
You never need to store changes to the SETUP menu. All changes take effect immediately.

Press HOME at any time to return home.

Use these links for instant access to the SETUP menu topics in this manual:

SETUP
—— FC Controllers/Onboard Switches p. 87
—— Global Settings p. 89
— 1/0 p.92
—— MIDI/Remote p.95
—— Utilities p. 99

[ J%]



1 INTRODUCTION

QUICK CONNECT GUIDE

Perhaps the best and most flexible way to enjoy your FM3 is through a full-range system such as studio monitors,
a high-quality PA, or full-range cabinets designed specifically for guitar. All of the factory presets are designed for
this type of setup.

The FM3 is incredibly flexible, however, and many other types of setups are supported, including those which
integrate with tube amps, USB recording, 3rd-party outboard equipment, and much more.

Find additional setup diagrams in Section 4. %‘:
The most basic setup instructions appear below: -
o Begin with all level knobs turned down. L R @
Connect your guitar to FM3 OUT 1 [MAIN]

Instrument input (Input 1).

The FM3 is also perfect for bass
and other instruments.

i | ouT 1
0 Connect Output 1 to your mixer, studio IN 1 [NSTR] Use I I Add

Out1lL Out1R

monitors, audio interface, PA system, full-
range speakers, power amp inputs, etc. for for
Mono

) Stereo
«  For amono rig, use Out 1 Left.

«  For optional stereo, connect Out 1 Right.

«  Use XLR-to-XLR cables or XLR-to- @ @
TRS cables when connecting to
balanced inputs. Use XLR-to-1/4" \ /

(TS) cables for unbalanced inputs.

[ @O [oece

' ‘.l .l ': ': ': l _

0 @

9 Slowly turn up the front panel OUT 1
knob and adjust the level on your monitors as desired.

FRFR speakers, Studio Monitors

Explore factory presets by turning the VALUE wheel. Audio Interface or Mixer

Select Scenes within a preset by using NAV Up/Down. oUT1

The front Out 1 knob adjusts the
level of what you hear in this setup.

FRFR = "Full Range, Flat Response"

FRFR stands for “Full-Range, Flat Response,” used to describe a system which aims to reproduce the entire
audio spectrum without compromise. In comparison, most traditional guitar speakers have limited range
- they cannot reproduce extended lows and highs -- and are not at all “flat” - meaning some frequencies
are markedly louder or quieter. Full-range flat response studio monitors, high-quality PA speakers, and FRFR
speakers designed specifically for guitar should be able to reproduce anything you send to them. Of course,
even these may vary, depending on which brand and model you choose.

4



1 INTRODUCTION

SETTING LEVELS

Setting proper levels is critical, but easy, with abundant meters to inform you about levels on the FM3.

INPUT LEVELS

The FM3 comes ready-to-use for the typical guitar with passive pickups. To check levels,
connect a guitar to INPUT 1. Choose your loudest pickup setting and set all the guitar
controls to “wide open.” Play loud, open chords to push the levels as you watch the

IN 1 [INSTRUMENT] meter LEDs. It's OK to tickle the red LED once in a while, but if actual
clipping occurs, you must pad the input as follows:

» Open the SETUP: I/0: Audio menu page.

» Navigate to the INPUT 1 PAD parameter. Turn the VALUE knob to increase this setting. The
possible values are 0dB, 6dB, 12dB, and 18dB. Be aware that as you increase this setting you also
increase the noise floor, so set it as close to 0 as possible for the best signal-to-noise ratio.

Input 2 can be adjusted with its own Input 2 Pad parameter on the same menu page.
You can also monitor all levels on the Meters page of the Home menu (shown below).

Input Pad adjustments do not affect gain levels or what you hear. As you pad the input of the A/D
converter, the output is boosted by the same amount. This eliminates clipping but ensures unity gain.

OUTPUT LEVELS

Output levels are easy to monitor by S
paging to the Meters page of the Home
page. Should your output levels be too Kttt

high, the OUT 1 CLIP or OUT 2 CLIP

LEDs on the front panel will light. If you are clipping the
outputs, you will need to lower the level INSIDE your
presets. The top panel OUT 1 knob comes after the
converters and only affects the level of what you hear.

Ras-FAN . o

HIRIR! ||||II_
o I 3
ll II 1

Output 1 is ready to be connected to consumer

line level inputs (-10 dbV). If you are connecting to
professional-grade equipment operating at +4dBu, set
the nominal output levels as follows:

» Page SETUP: 1/0: Audio
» Adjust Output 1: Output Level to +4dBu.

The Meters page of the Home menu shows all I/0 levels.

Learn more about the 1/0 Menu on p. 92

Section 7: 7 Leveling Presets is dedicated to the
subject of adjusting preset levels.

Output 2 is designed so that turning the OUT 2 knob all
the way up produces a unity gain signal.

The Layout also has a Meters view showing block levels.

lon



1 INTRODUCTION

HUMBUSTER™ CABLES

For OUTPUT 1, use XLR-to-XLR or XLR-to-1/4" TRS cables when connecting to balanced inputs.
Use XLR-to-1/4" (TS) cables when connecting to unbalanced inputs.

For OUTPUT 2, standard 1/4" (guitar) cables may be used, but there is a better option. Humbuster™ cables can
significantly reduce unwanted hum due to ground loops. A Humbuster cable has one TRS end (like a balanced

cable) and one TS end (like a guitar cable). The TRS end connects to the FM3. The TS end connects to your amp
or other device.

Humbuster cables are available from http:/www.fractalaudio.com/cables. You can make your own by following
the diagram below. Be sure to use high-quality connectors and shielded cable.

TIP  SLEEVE TR T SLEEVE TIP

MONO VS. STEREO

Ve The FM3 comes pre-configured for stereo but you can connect it in mono with no issues. If you
9 are NOT running in stereo, you may find that certain presets or settings produce unexpected
"%  results. For example, a panner sounds like a tremolo when one channel is missing. A ping-pong

“../ delay may ping but never pong. Stereo enhancers or certain types of modulation may not be
apparent at all. Tone may change completely if amps or cabs have been hard panned. Here is
an overview of several scenarios, with recommended settings for each.

A

» Stereo: No special settings required.

» Half-Stereo: Leaving the FM3 in its default stereo configuration but connecting only
one (Left) output results in a “half-stereo” setup. This works fine, aside from the
exceptions mentioned above (ping-pong, panning, etc). No special settings required.

» Dual Mono: If you want to force your rig to mono, dual mono is a good choice. Sonically, this
is identical to half-stereo, with the same limitations, except that mono signal is produced
at both the left and right jacks so you can connect to two monitors. To switch to dual
mono, open SETUP: I/0: Audio and set Mode for the desired output to “COPY L->R".

» Summed Mono: In this setup, left and right channels are added together resulting in an identical
mono signal at both left and right outputs. This has the advantage of not discarding half of
the sound, but summing has its own issues. For example, short delays or phase differences
between channels can result in strange artifacts or even cancellation. To switch to summed
mono, open SETUP: I/0: Audio and set Mode for the desired output to “SUM L+R".

On the FM3, a flexible block-based 1/0 system makes it easy to use different outputs with different
settings. See the “The Fractal Audio Blocks Guide” for more on Input and Output Blocks.

All options of the 1/0 menu under SETUP are detailed in Section 13: Setup Menu.

6
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THE HOME PAGE: PRESETS

Once you have connected your FM3 you can begin to audition factory preset sounds. Remember that aside from
a few templates, the factory presets are designed for use with full-range speakers / monitors / headphones. (See
Section 4 for details on many other types of setups.)

The FM3 contains 512 preset memories, each like a fully independent rig with its own amps, cabs, effects,
settings, controllers, and more. When you consider everything that is possible with Scenes and Channels, a single
preset can cover an entire song, or even a whole show.

Here's how to explore the factory presets: Previous Scene

» Press HOME to show the Home page,

a

where you can switch presets.
To change presets, turn the VALUE Previous 4
knob or use the NAV buttons. Preset

Many factory presets contain extra Scenes.
You can switch between Scenes using the NAV buttons or by
turning knob A. v

See p. 15 for an introduction to Scenes. Next Scene

Next

NAV
} Preset

OTHER HOME MENU FUNCTIONS

»

The push functions of the five knobs on the Home page of the Home menu provide access to other areas:
= Tuner

= Layout grid (p. 14 and p. 40)

= Controllers (p. 65)

= FC Per-Preset (‘Per-Preset Switches” on p. 79; also “The Footswitch Functions Guide” on p. 18)

» Setup (p.3 and p. 87)

Turning knob E changes between different foot control “Layouts” (p. 69).

A mini-Tuner appears at the top of the Home page itself in the form of two » 4
green triangles. When both are shown, the note is in tune.

The Home menu also provides access to the Presets directory page,

listing all presets in a scrolling list sorted by number.

» PAGE to the Presets page to show the directory.

= To sort alphabetically by name, press the “Sort A-Z" button.

= The ENTER key loads the selected preset and returns to the Home page.

The Meters page provides visual indication of all input and output levels, including USB.

N



1 INTRODUCTION

LAYOUTS

The FM3 is based on our popular FC controllers. The central concept behind all these products is the footswitch
Layout. A layout is a set of 12 footswitch definitions. You can change the layout to change what the footswitches
do. All layouts and switches can be completely customized. The FM3 provides eight layouts in total, plus one
special “Master” layout (covered below). Layouts have both numbers and names to make them easier to manage.

There are multiple ways to change the layout on the FM3. The easiest is probably to turn knob E from the Home
page of the Home Menu. You wouldn’t be able to do this easily while you are playing, however, so we created the
Master Layout Menu and Layout Switches so you can select layouts with your feet.

THE MASTER LAYOUT MENU

Let’s look at the Master Layout Menu or “MLM” and how to use it:

@ Press and hold footswitch 2 in any normal layout
to enter the Master Layout Menu (“"MLM").

0 TAP any footswitch on any MLM page to select a
new layout and exit the MLM.

L G (PRESS J

HOLD € While you're in the MLM, hold the left or right switches to step through
three different “views” -- each with its own menu choices shown below.

The layouts themselves are detailed on p. 71.

‘

LAYOUT 1: LAYOUT 3: LAYOUT 4: LAYOUT 6: LAYOUT 7:
PRESETS EFFECTS CHANNELS PER-PRESET| | PERFORM

LAYOUT 5:

LAYOUT 8:
UTILITIES

/ PRESS PRESS
AND AND J
HOLD - HOLD

MLM1 MLM2 MLM3

MLM1

Learn more in Section 10: L ayouts & Switches.

loo
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FOOTSWITCHES

The FM3 has three built-in footswitches, each with its own mini-display and vari-color LED ring. Footswitches
can be used to change presets, select scenes, toggle effects, and much more. This page introduces the basic
concepts, while Section 10: Layouts & Switches covers this subject in more detail.

SWITCHING PRESETS

Let's begin with how to explore the factory presets using the footswitches.

When the FM3 starts up, it loads the PRESETS footswitch layout. In this layout, the three footswitches each select
a single preset. Preset names are shown in the mini-displays. The current preset will have a bright ring and the
others will be dim.

A “bank” is a group of three presets. To change to the next bank of three presets, press and hold the right
footswitch. To change to the previous bank, press and hold the left footswitch.

The FM3 boots up to the Presets footswitch layout.

In this layout, three footswitches select three different presets.

Deluxe Verb Plexi 50W FAS Modern
Press and hold the left switch Press and hold the right switch
to load the previous bank of three presets. to load the next bank of three presets.

You can use the MANAGE PRESETS feature of FM3-Edit to drag and drop presets of the FM3 into any order
you wish. Put your favorites in groups of three so you'll have what you need without a lot of bank changes!

FOOTSWITCH FUNCTIONS

Every footswitch in every layout (see next page) can have its own independent functions for Tap and Hold

n ou

Function. Functions are arranged in Categories like “Presets”, “Scenes”, or “Effects”.

LED RING COLORS

Every footswitch Category has its own default LED ring color. You can change these default colors on the Ring
Colors page of the FC Controllers/Onboard Switches menu under SETUP. You can also change the color of any
individual switch. See “Edit a Switch” on p. 78.

MINI DISPLAYS

The Mini-Display for each switch shows a label for the Tap function. While the switch is depressed — even for a
normal “tap” — the label changes momentarily to show the Hold function.

See “The Footswitch Functions Guide” for more information.

ho



1 INTRODUCTION

EXPRESSION PEDALS

This section is for pedals connected to the local “Pedal” jacks of the FM3.
For pedals connected to an FC Series controller, see your FC Owner’s Manual.

Each of the two Pedal jacks of the FM3 support one expression pedal (or 1 to 2 switches).

EXPRESION
PEDAL

TRS

TRS Cable

TRS

PEDAL JACK

uuuuuuuuuuuuuuuuuuuuu

oooo

FM3 | O -

oooo

FAQ:

TIP SLEEVE

TO CONNECT & CALIBRATE AN EXPRESSION PEDAL...

Expression pedals should have a linear resistance taper and must have a maximum
resistance in the range of 10-100kQ. Expression pedals must be used with Tip-Ring-
Sleeve (TRS) cables.

Connect your expression pedal to one of the FM3 Pedal jacks with a TRS cable, then
follow these instructions:

1. From the Home page, open SETUP: 1/0: Pedal.

2. For pedal jack 1, set Pedal 1 Setup to “PEDAL 1 (EXP/SW TIP)"
(or use Pedal 2 Setup if that's the jack you're connecting to)

3. Navigate down to the Calibrate function for your pedal and press the ENTER.
4. Follow the on-screen instructions to perform calibration. Press HOME to finish.

= Be sure to see the next page for instructions on assigning your new pedal.
= |f something doesn’t work, check a different pedal or cable!

FRACTAL AUDIO EV PEDALS

The Fractal Audio Systems EV series of
expression pedals are perfect for use with all
Fractal Audio Systems products. The EV-1 is

a full-sized expression pedal. The EV-2 is a
compact version. These pedals feature rugged
cast metal casings, a high quality 100kQ
potentiometer, and built-in analog volume
pedal capability.

Learn more at https:/www.fractalaudio.com

WHAT IS TRS? “TRS" stands for TIP-RING-SLEEVE and describes the
configuration of a 1/4" end plug or jack with three connectors. Normal guitar cables
are “TS" (Tip-Sleeve) since they lack the ring required for a third contact. Expression
pedals require TRS cables because full control voltage is transmitted to them on

| | one contact (the tip), while less than full voltage is returned to on another (the ring)
CJ]:. so the host device is able to sense and utilize the pedal position. The third contact

RING

(sleeve) is connected to ground.

10
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1 INTRODUCTION

GLOBAL EXPRESSION SETUP

FM3 Pedal Jack 1 can be assigned as the “External 1 Controller” for use with factory presets as a Wah.
Follow the instructions below.

1. From the Home page, open SETUP: MIDI/Remote: External.

2. NAV down to External Control 1.

3. Turn the A or VALUE knob to select PEDAL 1 (EXP/SW TIP)

4. Press EXIT when finished.
You can test the pedal using Factory presets in the range 000-064.

External 1 can also easily be assigned as Volume, Whammy, or almost anything else on a per-preset basis.
Learn more about assigning pedals and switches to sound parameters in Section 9: Modifiers.

GLOBAL VOLUME SETUP

The FM3 allows global remote control of the volume at any input or output via a pedal or MIDI CC of your choice.
To set up a pedal for global volume, follow the instructions below. Be careful that you don't accidentally assign
the same pedal to both Volume and an External Controller as described above!

First you'll need to decide which global volume option you prefer:
* Input volume affects gain/distortion and the behavior of level-dependent blocks like the compressor or gate.

=  Qutput volume does not affect gain or level-dependent blocks, but
scales everything you hear including effect tails.

To set Global Volume:
1. From the Home page, open SETUP: MIDI/Remote: Other.
2. NAV to the entry for whichever volume you want to control: Input 1 or 2, or Output 1 or 2.
3. Turn the A or VALUE knob to assign a controller to your selected entry.

= Select “PEDAL 1 (EXP/SW TIP)” for the onboard Pedal jack (or #2 if you are using that one)
4. Test and EXIT when finished.

Learn more about the MIDI/Remote menu options on p. 95.



1 INTRODUCTION

EXTERNAL SWITCHES

This section is for switches connected to the local “Pedal” jacks of the FM3.
For switches connected to an FC Series controller, see your FC Owner's Manual.

Each of the two Pedal jacks of the FM3 can support one or two switches instead of one expression pedal. This
requires a simple setting change. Any make-break switch type may be used with the FM3 in this way. Connect
switches in any of the ways illustrated below:

SINGLE SWITCH SWITCH SWITCH “DUAL’
(TIP) (TIP) (RING) SWITCH
(o] [o_e]
TS TS TRS
2
£
S =
[~}
S 2 o
= = n
3 o =
@
2
TS TRS TRS
PEDAL JACK PEDAL JACK PEDAL JACK
i n . Some "Dual”
i opeo 0o0o switches work
sfwg?io’g%e FM3 DOD DDDS DOD DEDDD over a single
‘tj”;:%i‘z;" 00000 8 ¢ i 00000 ¢ ¢ TRS cable.
— — —/ — —
EXTERNAL SWITCH SETTINGS SWITCH ASSIGNMENT
External switches require a simple setup: Since each jack supports TWO
» Page to the Pedal page of the 1/0 menu under SETUP. d|ffgrent SW'tCh.eS’ you ”. find multlple
options for assignment in the modifier
» Set Pedal 1 Setup to “ONE SWITCH" or “TWO SWITCHES" source menu and the various MIDI/
depending on what you have connected Remote menu pages.

(or use Pedal 2 Setup if that's the jack you're connecting to).

» Next, navigate down to the SWITCH SETTINGS section
and select the TYPE and POLARITY for each of your

Pedal 1 (EXP/SW TIP) is switch 1 tip.
Pedal 1 (SW RING) is switch 1 ring.

switches. See p. 94 for more on this setting. Pedal 2 (EXP/SW TIP) is switch 2 tip.
» Press HOME to finish. Pedal 2 (SW RING) is switch 2 ring.

Even more powerful, however, is the STAND IN SWITCH feature, which allows them to perform the same

@ External Switches can be used with many per-preset and global options found in the MIDI/REMOTE MENU.
functions as the onboard switches.
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1 INTRODUCTION

USB AUDIO

USB provides the FM3 with a host of great audio features. With 4x4 channels, you can play backing tracks, record
processed audio or DI signals, re-amp in real-time, and more.

See Section 3: USB for full details on the USB capabilities of the FM3.

FRACTAL-BOT & FM3-EDIT OO)

In addition to providing audio capabilities, USB allows you to use our
companion software applications Fractal-Bot and FM3-Edit.

Fractal-Bot is a small, simple program used to update the FM3 when new
firmware is released. It includes tools to backup or restore presets and other
custom settings and can be used to install downloaded presets or cabs.

FM3-Edit is a full-featured software editor/librarian for the FM3. If you are

comfortable with audio software or plug-ins, you will probably enjoy using

this program. FM3-Edit offers great ease of use and convenience, plus some “power-user” routines that aren't
possible on the unit itself (e.g. Performance Page editor, Block Library, Scene Swap). It also provides great tools
for managing presets and banks, installing Cab Packs, and more.

You can download FM3-Edit for Mac or Windows at https:/www.fractalaudio.com/fm3-edit

F YRy
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1 INTRODUCTION

INTRO TO THE LAYOUT GRID

Behind every preset is the Grid, a matrix of rows and columns that is the key to unlocking the true potential of

the FM3. In the world of traditional gear, our options are restricted by budget, space, weight, and the limits of the
equipment itself. Building a rig means making hard choices. With the FM3 however, these limits are replaced by a
vast, ever-growing “inventory” of virtual amps, cabs, effects, and more. Every single preset gives you the flexibility
to design a unique rig composed of whichever components you choose.

To create a preset, virtual pieces of gear called blocks are selected from an inventory and placed into the slots
of the layout grid. Each block represents a different component like a wah pedal, amp, or reverb unit. Blocks are
connected together using virtual cables. You can split, merge, or create parallel paths as needed. Passive shunts,
like cables, carry signal through empty grid spaces. Special input and output blocks connect to the various jacks
and USB signals of the FM3. Here is an illustrated overview of the concept:

Passed
toOUT1 :
Jacks

:' ............................................ The Layout Grid ............................................

Let's review what's happening above. Signal flow begins at the Input 1 block on the left. It is connected by a cable
to the Wah block, which in turn connects to a shunt. The shunt has no effect on the sound and is shown only to
introduce the idea of how it can be used to carry signal from one block to another. The shunt is connected to

an Amp block (we might set its type to “Plexi T00W High"), which in turn feeds a Cab (one of the many “4x12"
options, perhaps). This is connected to a Reverb and then to an Output block. In this limited example, many grid
spaces are empty, and only some of the columns are shown. In reality, the size of a preset is limited only by the
grid structure, block inventory, and total processing power (“CPU"). The FM3 can create presets large enough to
cover a song, a set, or even an entire show.

@ The layout “Z0O0M” feature shows the whole grid at once. Look for the ZOOM button on Layout menu pages.
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1 INTRODUCTION

INTRO TO SCENES AND CHANNELS

Imagine a professional rackmount system rig like the ones used by guitar heroes for decades. In such arig, the
various components — pedals, guitar amp, rack units — are usually connected to a central switching unit so they
can be switched in groups without “tap dancing.” Some components may also have settings that the switcher can
change, like the channel of an amp, or the MIDI program of a delay unit. As described on the previous page, an
FM3 preset is like this rig: it consists of “blocks” (amp, cab, effects) all connected together in a certain way.

In the traditional rig, you can set up and save different combinations and channels: Clean, Rhythm, Lead, etc.
Scenes on the FM3 allow you to easily create these saved combinations within a preset. Scenes don't rewire
the rig or change what gear it contains. Instead, they switch blocks on or off, and set which “Channel” each
component is set to. Each preset contains eight scenes and like presets, FM3 Scenes also have their own names.

Scenes can also offer an advantage over presets in terms of sound changes. When you change scenes, the FM3
doesn’t need to reload the entire “rig.” Instead, it just sets the blocks and channels as needed for the new scene.
This is not only faster, but also allows easy “spillover” of delay and reverb tails.

Channels on the FM3 make blocks extremely flexible. Each channel contains a fully independent set of
parameters for the entire block. For example, Channel A of a Drive block might be a clean boost, B could be an
overdrive, C could be a distortion, and D could be a Fuzz. That's four completely different drive sounds from just
block. This can be used to conserve CPU power when compared to single-use blocks used one at a time.

SCENES AND CHANNELS: A VISUAL EXAMPLE

[ IN1 cMp|i—{DRV [{—AMP[i—{cAB [s—{cHo ;LY [;—ouT 1]

Here is our preset. The Input 1 block feeds a Compressor, which is connected to a Drive, then an Amp and Cab,
then Chorus, Delay, and finally the Output 1 block.

[ IN1 —{eMP[i— v —{aMP[i—{cAB [{—{cHoli—

SCENE 1 - “Clean”: For scene 1, the Drive and Delay blocks are bypassed. We dial in the Compressor, Amp,
Cab, and Chorus for a classic clean tone. Notice that the amp says “1A”. This means we are using Amp 1, set
to channel A. Let's imagine it as the “ODS-100 Clean” model. We name this scene “Clean”.

—{DRV [{H—AMP[E—{cAB [J—0| — 0UT1

SCENE 2 - “Crunch”: To create scene 2, we bypass the Compressor, Chorus, and Delay and engage the Drive.
The Channel of the Amp block is changed from “A” to “B”, which we dial in as a “Euro Blue” model. Remember,
each channel has a totally independent set of settings, so we can dial in every amp parameter exactly as we
want it: Drive, Treble, Mid, Bass, Master, and many more. We then dial in Channel “A” on the drive block with a
good “screamer” sound by selecting the “TS808 OD" type. Let’s name this scene “Crunch”.

[ IN1 —cMpPE—{pRrv[i—AMP[E—{cAB i —{oy |i—out 1]

SCENE 3 - “Lead”: Here's our soaring lead. The Chorus is bypassed. We've changed the compressor to
Channel “B” and dialed it in for sustain. The amp is the same as the “Crunch” scene but the Drive changes to
“B”, which we'll make a “Ruckus LED". The Delay is on channel “B” set for ping-pong echoes with higher mix
and feedback. We name this scene “Lead".

Learn more about these topics in Section 5: Presets and Section 6: Scenes & Channels.

15



1 INTRODUCTION

GRID EDITING: QUICK START

Learn more about the layout grid in Section 5. Meanwhile, here’s a very quick primer:

»

From the Home page, press LAYOUT (knob B) or ENTER to show the
grid (that is, the “Edit” page of the Layout menu).

Use the NAV buttons to move the cursor around the grid.

To change any block, turn the VALUE knob to cycle through the list of available blocks.

When you find the block you want, press ENTER to confirm. Press EXIT to cancel changes.

On the grid, “push” functions of the B, C, and D knobs allow you to toggle a block’s Bypass state,
Delete a block, or create/remove a connector Cable between any two blocks in adjacent columns.

To save any changes, press STORE, ENTER, ENTER.

BLOCK EDITING: QUICK START

Learn more about editing blocks in Section 5: Presets. Meanwhile, here’s a very quick primer:

»
»
4

Parameter o feeeieee @ @ @ @
Highlighted . :

Open the layout grid (see above), select the desired block and press EDIT to open its menu.
Use the PAGE buttons to navigate menu pages.

Many blocks have a TYPE page, which allows you to dial in multiple settings with one knob.
Examples include setting an Amp to “USA Lead+" vs. “Tweed 5F1", or a reverb to “Cavern” or “Large Spring”.

Use the A, B, C, D, and E knobs to edit on-screen parameters. From
any block’s Edit menu, press EXIT to return to the grid.

To save any changes, press STORE, ENTER, ENTER.
The stylized diagram below shows a typical edit menu page with annotations:

Block Name and Number Menu Pages (Tabs) 1/0 Meters
Block Type Current Scene/Channel Tuner :
Drive 1 : Type (Ba.sic} Expert ! Mix Al
Current T808 OD: Scene: 1 ~ Channel: A —— =
Parameter
Value BOX ................................................ ( ......................... 500 >
Current

DOrive Tone Mix Level
Inactive Row
is dimmed ...................

(NAV Up/Down

to change rows)

Push(FunC)tions ~~~~~~ ¢ RESET ) ( BYPASS ) ( MODIFIER ) ( ) (MORE 10f2)

A-E : : : : :
Resets Bypassor  Adds a Modifer A yellow dot Reveals the
this Block to Engage this to the current  shows Modifier Scene/Channel

defaults block parameter capability Selector
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1 INTRODUCTION

THE FRACTAL AUDIO BLOCKS GUIDE

The FM3 is based on our flagship rackmount processor, the award-winning Axe-Fx Ill. Both the FM3 and the
Axe-Fx Ill use presets built from blocks, and the blocks on both devices share many of the same parameters and
settings. A separate manual covers these blocks in complete detail. More than a simple reference, it contains
background information, tips, and extra material to help you make the most of your Axe-Fx or FM3.

The Fractal Audio Blocks Guide can be downloaded from https://www.fractalaudio.com/fas-bg

Srracma
BLOCKS GUIDE

Complete Reference for
Blocks and Parameters
o The Aae-Ex 11 E ERED
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1 INTRODUCTION

THE FOOTSWITCH FUNCTIONS GUIDE

The FM3 is also based on — and can be used with — the Fractal Audio FC series foot controllers. The FM3, the
FC-6, and FC-12 all use a system of Layouts and Footswitches (p. 8) and in Section 10: Layouts & Switches.
Each Footswitch has its own Tap function and a separate Hold function, drawn from a list shared by all of the
above products. These are detailed in a separate manual, the Fractal Audio Footswitch Functions Guide.

Find this guide at https://www.fractalaudio.com/fas-ffg

ﬁn ACTAL
ALDID Y B TERME

FOOTSWITCH
FUNCTIONS TS
GUIDE

g B 8o

res rels GNB
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2 HARDWARE OVERVIEW

2 HARDWARE OVERVIEW
THE TOP PANEL
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0 Chassis — The FM3 is housed in a rugged 3U steel chassis with a sleek anodized aluminum front panel and
protective end caps. A pair of high-strength handles make the unit easy to manage.

0 Color Display — A large 800x480 color display is optimized for readability in the most difficult conditions,
with greater brightness and contrast than “off-the-shelf” displays.

0 Output Level Knobs 1&2 — These knobs independently control the volumes at the corresponding rear panel
outputs. Output 2 is at unity gain when set fully clockwise.

0 A, B, C, D, and E knobs — Five endless rotary push-knobs perform different functions depending on which
page is shown in the display. Many pages show turn functions in blue and push functions as buttons. Most
Edit pages show one or two rows of five knobs for easy 1:1 operation. On vertical menu pages, knob functions
are indicated on-screen with labels (“A” through “E”).

o HOME Button — This button shows the Home menu—a convenient starting point for loading or editing
presets, and accessing the tuner, controllers, metering, global setup options, and performance pages.

19



2 HARDWARE OVERVIEW

0 EDIT Button — This button opens the Edit menu to edit blocks selected on the Layout grid. You can also tap
EDIT sequentially to step through all blocks in the current preset (top-to-bottom, left-to-right). See “Presets”
on p. 39 for more on editing presets.

o STORE Button — Enters the Store menu where you can save presets and enter names for presets or scenes.
See “Saving Changes” on p. 47.

e TEMPO Button — Tap this button once to show the Tempo page of the Controllers menu, or tap 2+ times to
set a new tempo. The tempo can also be entered using MIDI or a remote switch. After setting the tempo,
press EXIT to go back to back to wherever you were. See “Tempo” on p. 83. Press and hold the Tempo
button as a shortcut to access the tuner.

o VALUE Knob — The VALUE knob performs different functions on different menu pages. In the Home menu,
it selects presets. In Layout (grid) pages, it is used to add or modify blocks on the grid. In Edit menus, it
changes parameter values, selects from lists, and more.

@ NAV Buttons — The four NAV buttons perform different functions on different menu pages. On the preset
pages of the Home menu, they select and load Presets (Left/Right) and Scenes (Up/Down). In other menu
pages, they select between on-screen parameters or options, moving the “focus” of the VALUE knob, as
indicated by a blue highlight and brighter blue text.

m ENTER and EXIT Buttons — The ENTER button executes commands, commits changes, accesses sub-menus,
and more. EXIT works for cancel, escape, and various other functions.

@ PAGE LEFT and PAGE RIGHT — These step through menu pages, shown as “tabs” at the top of the display.

@ Meter Bridge — Four LED meters show the levels at input and output jacks. For input meters, the red LED
indicates -6dB. As directed in the Introduction (p._5) a Pad setting is provided for adjustment. For output
meters, the red LED indicates -1 dBFS and is therefore a more immediate indication of clipping. When the
outputs clip, this usually means that the levels inside your presets are too loud.

TIP: You can also find on-screen meters on the Meters pages of the Home menu and the Layout.

@ Status LEDs — Five LEDs indicate important information. The Tempo LED flashes to show the current Tempo.
The Edited LED lights whenever the current preset has been altered but not saved. The MIDI In LED lights
while MIDI data is being received at the MIDI Input or via USB. The OUT 1 CLIP and OUT 2 CLIP LEDs indicate
that internal signal levels are too high. (See “Meter Bridge”, above.)

@ Footswitches — The switches of the FM3 use our proprietary Solid State Switching (SSS™) technology,
featuring extremely smooth, quiet, action, and no mechanical contacts to fail. Each footswitch can be
assigned your choice of one “Tap” and/or one press-and-hold (“Hold”) function. These can be different on
every “Layout,” and there are eight different layouts, plus one special layout called the “Master Layout Menu”.
Learn more in Section 10: Layouts & Switches.

Three Footswitches.. Plus 6, or 12, or 24 more!

The FM3 has three onboard switches, making it the perfect compact all-in-one way to enjoy Fractal Audio’s
legendary amp models, speaker cab simulation, and effects. If you need additional footswitches, however, you
can also connect up to two FC controllers, each with six or twelve additional switches with all the same fully-
integrated capabilities as the onboard switches. In addition, each of the onboard PEDAL jacks of the FM3 can
be used for one or two external switches instead of an expression pedal if you choose.
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2 HARDWARE OVERVIEW

THE REAR PANEL
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@ Input 1 [Instrument] (mono) — (1) 1/4" Jack (unbalanced) — Connect your instrument’s output to this jack,
intended specifically for use with electric guitars, acoustics, and basses, and other similar instruments. The
FM3 uses our proprietary “Secret Sauce IV” circuitry from our Axe-Fx products.

Output 1 L+R (stereo) — (2) XLR-Male (balanced) — Use the XLR jacks to connect to the balanced inputs of
FRFR speakers, mixers, studio monitors, etc. Use the ground lift switch if necessary to reduce 60-cycle hum.

TIP: Balanced audio connections are resistant to noise and interference. Use cables balanced at both ends
when connecting to the balanced inputs of other devices. When connecting to unbalanced 1/4" inputs, use
cables or adapters with an XLR (Female) on one end and an unbalanced 1/4" jack on the other.

@ Headphones Output — 1/4" Stereo Jack — Connect headphones here to monitor Output 1 (see above).

Input 2/FX Return L+R — (2) 1/4" Jacks (balanced) — Connect balanced or unbalanced line level signals
here. Input 2 can be used with the outputs of pedals or processors as an FX Return, or as an auxiliary input
for use with stereo line level sources such as mixers, synthesizers, backing track players, and more. Another
popular use is for inputting the second output of piezo-equipped guitars.

TIP: Balanced audio connections are resistant to noise and interference. It is best to use XLR or TRS
(3-conductor) cables when connecting to the balanced outputs of other devices. Use regular TS-type cables or
adapters (2-conductor) when connecting to unbalanced outputs like those on most guitar pedals.

@ Output 2 L+R - (Stereo) — (2) 1/4" Jacks (Humbuster) — Use these 1/4" unbalanced outputs to connect to
unbalanced inputs, such as those on many guitar power amps and other devices.
Humbuster™ technology on Output 2 can significantly reduce hum from ground loops. This requires special

Humbuster Cables, available at https:/shop.fractalaudio.com/cables/ (Learn more on p. 6.)

Output 2 is designed for unity gain applications such as the popular “Four-Cable Method” and other
scenarios. Set the OUT 2 Level knob fully clockwise for unity gain. See Section 4 for more.

m Pedal Inputs — (2) 1/4" Jack — These are used to connect external expression pedals or switches to control
various functions of the FM3. See “Expression Pedals” on p. 10 and “External Switches” on p. 12.
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2 HARDWARE OVERVIEW

FASLINK Il Connector — This allows you to connect the FM3 with one or two FC-6 or FC-12 foot controllers.
FASLINK™ uses a standard XLR cable for 2-way communication and also powers the first FC without an
external “wall wart” adapter. (See your FC Owner’s Manual for more on daisy chaining and other options.)

NOTE: The FASLINK Il port on the FM3 is designed for our FC Series of foot controllers and is NOT compatible
with the FASLINK port on our MFC-101 MIDI foot controller. Connecting an FM3 to an MFC-101 via FASLINK
should not cause any damage, but it will not work.

USB — This provides the FM3 with 4x4 USB audio capabilities when connected to a compatible Mac or PC
for use with a DAW or other audio applications. The FM3 is NOT a USB MIDI Device. It uses “COMM over
USB" channels for Fractal-Bot and FM3-Edit, but will not appear as a MIDI device in a DAW or other MIDI
program. See Section 3: USB for important information on USB.

MIDI Ports — The MIDI IN port of the FM3 allows you to control various MIDI functions including preset and
scene selection, effect bypass, channel changes, parameter changes, and more. See “Sending and Receiving

MIDI” on p. 113 for more information on the various ways the FM3 works with MIDI.

@ SPDIF Out — Digital Output — This transmits a digital output signal at a fixed rate of 48k. The SPDIF out can
transmit your choice of signals as per the setting of the SPDIF Out Source parameter.
(See “I/0: AUDIO Page” on p. 92.)

Power Switch — This turns the power on or off. The FM3 features pop suppression, but it is still advisable to
turn down or mute connected devices when powering on or off.

AC Power Receptacle — Insert the supplied power cable and connect the other end to a grounded AC power
receptacle. The FM3 has a universal power supply, which means it can be used around the world by simply
changing the cable.
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3 USB
COMPUTER INTEGRATION

With a USB connection to a computer, the FM3 provides 4x4 audio interface capabilities, including computer
audio playback, recording, and re-amping in your DAW or other audio applications. Two separate USB-Serial/Audio
Drivers are required for Windows operating systems. No driver is required for Mac operating systems.

The FM3 is NOT a USB MIDI Device. It uses “COMM over USB” channels for Fractal-Bot and FM3-Edit, but will not
appear as a MIDI device in a DAW or other MIDI program.

WINDOWS MINIMUM REQUIREMENTS

Two separate USB-Serial/Audio Drivers are required for Windows operating systems.

0S: Windows 7 SP1 or newer (all versions compatible with x86 or x64).
CPU: Intel Core 2 @1.6 GHz or better, or AMD equivalent.

Memory: 1GB minimum.

USB: USB 2.0 support required.

Driver: Two different drivers are required for use under Windows.

The Windows drivers can be downloaded at http://www.fractalaudio.com/support

Step-by-step instructions are included with the installer.

MAC MINIMUM REQUIREMENTS

0S: 0S X 10.9 or later required for USB audio. An issue in older OS X versions causes audio pops.
Note: Older Mac 0S versions may work for MIDI-over-USB (Fractal-Bot, FM3-Edit, etc.).

CPU: Intel Processor.

Memory: 512MB minimum.

USB: USB 2.0 support required.

Driver: No driver is required for Mac 0S.

Important: If you are using a USB-C to USB adapter on a newer Apple computer, plug the USB-C adapter into a
the port on your Mac first, allow it several seconds to “wake up” and then connect a USB cable and FM3
into the adapter.
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3USB

USB AUDIO

RECORDING

@ COMPUTER INPUTS 142
Source: The output of the OUT 1 block on the FM3's grid.
Application: Record the stereo processed output of the FM3.
@ COMPUTER INPUTS 3+4
The source is selectable in Setup: 1/0: Audio: USB 3,4 Record Source

» Source: INPUT 1: (Default Setting) The Signal at the Input 1 Jack.
Application: Record a DI for re-amping.

Note: This mono signal appears at both USB 3 and USB 4 but would typically be recorded in mono.
Note: If Input 1 Source is not set to ANALOG, this will result in silence!

» Source: INPUT 2: The Signal at the Input 2 Jacks.
Application: Record a stereo source with no processing.

PLAYBACK

OuT1l

grid block

IN 1/INSTR

D> COMPUTER OUTPUTS 1+2

Destination: The Output 1 jacks (and headphones).
Applications: Play stereo audio from the computer through the FM3.

NOTE: USB Audio is mixed with any signal from the grid and passed to the outputs.

> COMPUTER OUTPUTS 3+4
The destination is selectable in Setup: 1/0: Audio: USB 3,4 Playback Destination

» Destination: INPUT 1 BLOCK: (Default Setting)
The input of the Input 1 block on the grid.
Application: Transmit computer audio to the grid for re-amping/processing.

» Destination: OUTPUT 2: The Output 2 jacks..

Applications: Play a second stereo track pair from the computer through the FM3.

OUTPUT 1

IN 1

grid block

-OR-
ouT 2
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BASIC PLAYBACK

The specific steps for recording in your OS or DAW will vary based on your setup, but the basic idea is to select
the FM3 as your audio interface, make any application-specific settings, and begin playback.
On Mac 0S, no driver is needed.

= Connect the FM3 to an available USB port.

= Open System Preferences: Sound and select the FM3 under “Output”.

= System Audio such as iTunes playback, should now appear at FM3 Output 1 Left and Output 1 Right.
On Windows you must install two separate driver files first.

» Find FM3 USB Audio Setup and FM3 USB Serial Driver Setup at:
https://www.fractalaudio.com/fm3-downloads/

= Once the drivers are installed, open Sound Settings under System Settings and select the FM3.
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Whichever OS you are using, confirm that the FM3 is receiving audio during playback by viewing the Meters page
of the Home menu, where you should see meter activity on USB IN 1L and 1R. If you turn up the OUT 1 LEVEL
knob, you will also see meter activity on ANALOG OUT 1L and 1R and hear audio at the connected speakers.

BASIC RECORDING

The specific steps for recording in your OS or DAW will vary based on your setup, but the basic idea is to select
the FM3 as your audio interface, set the project sample rate to 48k, create a track, assign the desired input, and
begin recording.


https://www.fractalaudio.com/fm3-downloads/

3USB

USB RE-AMPING

The FM3 USB Audio capabilities are perfect for “re-amping,” a method in which the raw, un-processed DI output of
a guitar is recorded and then re-processed later through the amp, cab, and effects of your choice.

Re-amping has many benefits. First, it allows you to record when inspiration strikes, capturing a DI instead of
obsessing over the final tone. Later, you - or a mix engineer — can redesign the sound as your track’s production
advances. Punches and edits made on the DI track are also made virtually inaudible by the re-amping process.

The FM3 allows you to dial in new tones while simultaneously listening to the track for context.

STEP 1: RECORDING

The following tutorial assumes that you have connected Output 1 L/R to monitors or headphones. The details
may vary from one DAW to another, but this guide should be easy to adapt to your own environment.

In your DAW, select the FM3 as the main audio interface. Set the main outputs to FM3 Outputs 1+2.
Create a new project in the DAW, and set its sample rate to 48kHz.

OPTIONAL: Record or insert any backing tracks and test their playback at FM3 Output 1.

Connect your guitar to the Instrument input of the FM3 and select any preset desired.

Now record the DI:

= Create a mono track. Name this track something like “Guitar DI”. Set its input to FM3 Input 3.
This will record the signal at the Instrument jack with no processing.

= Arm this Guitar DI track for recording, making sure that Software/Input Monitoring is NOT enabled.

= Hit RECORD and roll the track. You will hear the processed guitar but record the DI.
Note: You can simultaneously record processed guitar on a different track at the same time if you want!

= Be aware: while a processed track will show “hot” levels, the level of a DI track will appear to be very low.
This is NORMAL! You are recording the raw signal exactly as it comes out of your guitar.

= YOU HAVE NOW RECORDED YOUR DI!
STEP 2: RE-AMPING

Before re-amping, we must first check some settings on the FM3. Press HOME and open SETUP. Navigate to the
1/0 menu, and change Input 1 Source to “USB (CHANNELS 3/4)". (Remember to change this back when you finish
re-amping!) Also make sure that you have not changed USB 3,4 Playback from its default setting of “INPUT 1".

6. Change the output of your “DI”" track to FM3 Output 3.

7. NOTE: You may wish to turn down the volume of the studio monitors before testing playback as follows:
Solo the DI track, then rewind and hit PLAY. You should hear the DI being processed by your FM3 preset.

8. Now prepare to record the processed output of the re-amp:

= (Create a stereo track. Name it something like “Guitar Re-Amp 1".

= Set its inputs to FM3 Inputs 1+2.

= Arm your re-amping track for recording, making sure that Software/Input Monitoring is NOT enabled.
9. Rewind, hit RECORD, and roll the track. The output of the preset is recorded!

aRwb=

Again, the method described here is basic, but it should serve as a guide to get you started.



4 SETTING UP

4 SETTING UP

This section provides an overview of common setups using the FM3. When setting up, begin with all level knobs
turned down and all devices powered off. The FM3 features pop suppression on startup, but speakers or monitors
should still be powered on last whenever possible. A basic AC surge/spike protector is also recommended.

Remember that the FM3 is extremely flexible and there are many options not detailed here.

GENERAL PRINCIPLES

INPUTS

» Setting Input Levels is important. See “Setting Levels” on p. 5.

» The Input 1/Instrument jack features “Secret Sauce IV” to lower the noise floor, but
you can also safely connect guitars and other instruments to Input 2.

» Input 2 is balanced. Use balanced 1/4" cables when connecting to balanced devices.

OUTPUT 1

» Output 1 defaults to -10 dBV, a lower level “consumer” format. Change this to +4 dBu when
connecting to pro audio equipment. Find this setting under SETUP: 1/0: Audio.

Use female-to-male XLR cables when connecting Out 1 to the balanced XLR inputs of other devices.

Use XLR female to TRS male cables when connecting Out 1 to the balanced 1/4" TRS inputs of other devices.
Use XLR female to TS male cables when connecting Out 1 to the unbalanced 1/4" inputs of other devices.
Use the FM3's ground lift switch if required to combat the hum caused by ground loops.

FM3 OUTPUT 2

Use regular guitar cables to connect Out 2 to the inputs of pedals, amplifiers, and other devices.

Use Fractal Audio Humbuster™ cables whenever possible to combat the hum of ground loops. (See p. 6.)
Use TS male to XLR male cables when connecting Out 2 to the balanced XLR inputs of other devices.
The optional Out 2 Boost/Pad setting can help optimize the noise floor in some cases. (See p. 93.)

v v v v

»
»
»
»

MONO/STEREO

» Any setup can easily be adapted for mono or stereo with some simple changes to input and output settings.
» See “Mono vs. Stereo” on p. 6 for an introduction.

USING THE AMP BLOCK WITH TRADITIONAL GUITAR SPEAKERS

» When using the FM3 amp block into traditional (not full range) guitar speakers, certain advanced
parameters require consideration. On the “Speaker” page of the Amp block, set Speaker
Drive to zero. You may also wish to zero Speaker Compression. Also consider setting LF
Resonance Frequency to match your connected cab if you know its resonant frequency.

FC CONTROLLERS

» Any setup shown here also works perfectly with one or more FC-6 or FC-12 foot controllers connected.
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FRFR/DIRECT

Global Settings: Default
Presets: Factory or Custom

This setup takes full advantage of the ability of the FM3 to recreate all aspects of an “end-to-end” guitar chain, with
virtual stompboxes, amps, cabs, rack effects, and more. It is the most versatile and popular setup, offering the
greatest flexibility in terms of tone.

Output 1 is connected directly to full-range, flat response (“FRFR") speakers or a PA. A number of manufacturers
offer FRFR products designed specifically for guitar, but any high quality PA speaker or monitor can be used.
Some FRFR systems have a built in amplifier, while others have separate amp and speaker components.

All Global and 1/0 settings on the FM3 can be left at default settings for this setup, and factory presets can be
used without modification.

Adjust overall levels using the front panel OUT 1 knob.

An optional FC-6 is shown in this diagram. The FM3 is designed to be expanded with up to two FC Controllers.

CONNECTIONS

» Connect your guitar to
Input 1 (Instrument ).

» Connect Output 1 to
the input(s) of your
FRFR System. Use Left
for mono or Left and
Right for stereo.

FASLINK 11
Port (Male)

» If you're using a mixer,
be sure to connect the
FM3 to line level inputs
rather than mic level
inputs. Also, “zero out”
all other channel settings
to begin. Contact your
mixer's manufacturer if
you have any questions.

MIDIIN_ OUT/THRU

e

ol . )

o

FASLINK Il
Port (Female) 0ptiona|
E OUTPUT ' Optional FC-12 or FC-6
. 1R : for Stereo

PERSONAL
FRFR
MONITORS




BASIC RECORDING SETUP

Global Settings: Default
Presets: Factory or Custom

The FM3 can serve as the heart of a recording rig.
Connect studio monitors directly to Output 1 L+R.
The setup shown here is identical to the FRFR/Direct
Setup (previous page) with the exception that it adds
a computer for playback and recording. This setup has
the advantage of allowing easy re-amping over USB.
Note that all computer audio and project settings must
be set to 48 kHz, which is the fixed internal sampling
rate of the FM3.

The top panel OUT 1 level of the FM3 works as the
master, adjusting the overall levels of the FM3 and
computer playback simultaneously. For additional
control, adjust levels inside the computer or use the
USB 1/2 Level parameter of the FM3

found in SETUP: 1/0: USB.

FM3-Edit and Fractal-Bot use the same USB connection.

4 SETTING UP
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STUDIO MONITORS COMPUTER

THIRD-PARTY
AUDIO INTERFACE

As detailed above, the FM3 is a high-quality, standalone
USB audio interface, but it can also be used to add
world-class guitar processing and effects to an existing
studio setup with a third-party audio interface.

While this does not allow FM3 “native” re-amping over
USB, there are many reasons why you might prefer to
use an existing interface, such as the ability to run at
sample rates other than 48k, additional input or output
channels, mic preamps, etc.

» Connect your guitar to FM3 Input 1 (Instrument).

» Connect your studio monitors and computer
to your audio interface according to the
instructions of its manufacturer.

» Connect FM3 Output 1 L+R to a stereo line
level input pair on your audio interface.

» Connect the FM3 to the computer via USB
to enable FM3-Edit and Fractal-Bot.
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COMPUTER
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NEUTRAL (FRFR) POWER AMP & SPEAKERS

Global Settings: Modified (see below)
Presets: Factory or Custom

This popular setup uses both traditional guitar speakers and full range and flat response (“FRFR”) power amp.
Such amps are usually solid-state and designed specifically for pro audio or FRFR guitar. This is a “neutral” amp
without tonal coloration. What goes in is what comes out — only louder.

This setup uses amp modeling in the FM3. Effect blocks can be used before and/or after the amp. Since we're
using traditional guitar speakers, we don’t need speaker cab modeling from a Cab block.

DISABLE SPEAKER CAB MODELING CONNECTIONS

Using real speakers and modeled speakers at the same  » Connect your guitar to Input 1 Instrument.
time would be redundant, so this setup requires youto ) Connect Output 1 L to the input
disable or remove the FM3 Cab block. You can do this of your power amp, which will typically be XLR.

manually in every preset you use, or take advantage of You can also use an XLR to 1/4" cable if needed.
an easy global setting:

» Connect the power amp to a speaker
» Navigate to SETUP: Global Settings: Config. as directed by the manufacturer.
» Change Cabinet Modeling to “BYPASSED".

A “NEUTRAL’ POWER AMP...

This setup uses a sonically “neutral” power amp.

This will typically be a solid-state amp designed
specifically for “FRFR Guitar” or pro audio applications.
In comparison, the power amp in most tube amps is not
flat at all. Power amps can have a very pronounced tone
and dynamic feel, making up a huge part of the sound of
a guitar rig.

OE L5253 - (
NO®: =~~~
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The FM3 is in fact capable of modeling both preamp
and power amp tone. While other setups use just the
preamp modeling (see next page) this setup also uses
power amp modeling since our neutral power amp is
contributing little to nothing in this regard.

Using power amp modeling in the FM3 has several
benefits. First, since the power sections of different
amps sound and feel very different from one another,
modeling provides a very accurate experience as you
change amp models. The power amp of a “deluxe amp”
with no master volume is going to be extremely different

from that of a “recto”, for instance. Therefore, do NOT

disable power amp modeling in the FM3 when using a GUITAR

neutral power amp. SPEAKER
CABINET

One setting you should change, however, is OUTPUT

MODE on the Advanced page of the Amp block edit
menu. Set it to “SS PWR AMP + CAB". See the Blocks
Guide (p._17) for more on this parameter.
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TRADITIONAL GUITAR POWER AMP & SPEAKERS

Global Settings: Modified (see below)
Presets: Factory or Custom

This setup uses traditional guitar speakers with a “non-neutral” power amp designed specifically for use with a
traditional guitar preamp. This might be the power section of a head or combo, or a rackmount tube amp.

DISABLE POWER AMP MODELING

This setup uses a “non-neutral” power amp, which
contributes its own coloration and dynamic feel to

the overall sound. Modeling these same power amp
characteristics in the amp block of the FM3 would
therefore be redundant, so you will want to disable
power amp modeling. Some power amps, however, are
more subtle, and some players like to leave power amp
modeling in the FM3 turned on, even though their amp
has its own coloration and feel. Try it both ways and let
your ears be your guide.

You can disable power amp modeling manually in
the Amp blocks of your presets by setting the Supply
Sag parameter in each one to 0.0, or you can take
advantage of an easy global setting:

» Navigate to SETUP: Global Settings: Config.
» Change Power Amp Modeling to “OFF".

DISABLE SPEAKER CAB MODELING

This setup uses traditional guitar speakers, which
typically have strong tonal coloration. Using modeled
speakers at the same time would be redundant, so this
setup requires you to disable or remove the FM3 cab
block. You can do this manually in every preset, or take
advantage of an easy global setting:

» Navigate to SETUP: Global Settings: Config.
» Change Cabinet Modeling to “BYPASSED".

Uuumuumm e— IIII@.H
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Instead of the power section of a head or cab, you can
also use rackmount power amp designed for guitar.

CONNECTIONS

» Connect your guitar to FM3 Input 1 Instrument.

» Connect the FM3 to the power amp input. You can

use FM3 Output 1 with an XLR-to-1/4" cable, or

use FM3 Output 2 instead, which has the added

benefit of Humbuster™ technology to combat

the hum of ground loops. To make the change,

add the Out 2 block manually in every preset,

or take advantage of an easy global setting:

= Navigate to SETUP: 1/0: Audio and change
Output 2/Copy Output 1 to “ON”". Output 2 will
now replicate the signal normally sent to Out 1.

Connect your power amp to a guitar speaker

cabinet as directed by the manufacturer. (If it's

a combo, the speaker is already connected.)

__________

Optional for Stereo
to a second amp

.

Amplifier
°c dpo0oS @

HEAD OR
COMBO
WITH
POWER AMP IN
OR
FX RETURN

L
0
¢
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FRONT-OF-HOUSE + PERSONAL FRFR MONITOR

Global Settings: “Out 2 Copy Out 1" Turned ON
Presets: Factory or Custom

This setup sends identical signals to the front-of-house PA and your personal FRFR monitor, with separate level
controls for each. The FM3 creates a fully modeled end-to-end guitar tone for the ultimate in flexibility—stompboxes,
amps, cabs, post effects, and more.

Output 1 is used for the PA. This will presumably be a balanced connection, so use XLR cables. Set your levels using
the front panel OUT 1 knob (and leave them alone... keep the sound tech happy!)

Output 2 is used as an independent copy of Out 1 to feed your FRFR monitor. To produce the copy, you can use an
easy global setting change instead of inserting the Output 2 block manually in every preset. Navigate to SETUP:
1/0: Audio and change Output 2/Copy Output 1 to “ON”. Output 2 will now replicate the signal being sent to Out 1.

CONNECTIONS

» Connect your guitar to FM3
Input 1 (Instrument).

» Connect Output 1 to the
front-of house system.

= |f you are working with a sound
technician, be sure to tell them
that you are outputting a line
level input — NOT a microphone
level signal. They should use a
balanced line input without a

(f@ SEracTaL

....................

preamp. : OUTPUT . Optional
. ! . ! for Stereo
= Also tell them you are sending o J. 0T .0 LS J . ST L ;
a fully processed “mix-ready” fglr"s"t’::'e'o

sound, and that — at least to start
— they should “zero” the channel
with no EQ or processing.

» Connect Output 2 to the input
of your FRFR monitor. This is
NOT a balanced output, so use
Humbuster™ or regular guitar
cables and adapters as needed.

FRONT-OF-HOUSE PERSONAL FRFR MONITOR
MIXER/PA
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FRONT-OF-HOUSE + GUITAR SPEAKER BACKLINE

Global Settings: Default, check I/0 Mono/Stereo settings
Presets: Custom

In this setup, custom presets simultaneously send two different signals at once to two different FM3 outputs. The first
is a “direct” or “FRFR” signal for front-of-house, complete with speaker simulation. The second feeds a power amp —
without speaker simulation — into real guitar speakers for an authentic backline experience. As shown below, this is
achieved using the Output 2 block, which taps the signal prior to the cab block.

[ IN1 |- waH H DRV |{ AMP H cHo | pLy }i{;]—[oun]
ouT?]

Output 1: Front of House - The signal with speaker sims is sent via Qutput 1 to a full-range PA system. This provides
all the benefits of going direct, with versatile, consistent tone at very controllable volume levels. Set output levels
using the OUT 1 knob and leave them alone after soundcheck. Remember, when using a mixer, use line level inputs
and avoid channel settings that might undesirably color the sound.

Note: Notice that the Cab block is placed after the “post” FX. If a stereo signal is required at Output 1, the cab block
must also be set for stereo use. Learn more about the Cab block in the Blocks Guide.

Output 2: Backline - This signal is basically identical to the first, but without speaker simulation because it goes
to a power amp and traditional guitar speaker. This provides a very familiar playing experience with great natural
sustain feedback, and stage level (“moving air”). You must use a neutral power amp (see p. 30) since power amp
modeling needs to be active for Out 1, and it cannot be both on and off at the same time.

..........

: OUTPUT | optional
' : for Stereo

Optional
for Stereo

POWER
AMP
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"FEECTTT R SPEAKER
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CONNECTIONS » Connect Output 2 to the input of your power

, amp. Again, we are assuming a neutral

» Connect your guitar to Input 1 (Instrument). power amp is in use (see p. 30).

» Connect Output 1 to the front-of-house N
PA. Inform the sound technician that the

FM3 outputs a direct, line-level signal.

Humbuster™ cables are recommended for
output 2 to combat hum from ground loops.

» Connect your amp to a speaker cab
as directed by the manufacturer.
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FX PROCESSOR ONLY (“PRE")

Global Settings: check 1/0 Mono/Stereo settings, see also “Tip” below
Presets: Custom

In this setup, the FM3 is used as a virtual pedalboard, providing access to our vast collection of industry-leading
effects. It is placed between your guitar and amp like a traditional stompbox. You'll need custom presets, but as
with all FM3 setups, you are free to insert effectsin any order or arrangement. Presets must not contain Amp or
Cab blocks for this setup. They should be created with an understanding of how effects sound in front of your
amp'’s preamp and the distortion it generates. (You may wish to look into the term “pedal platform amp” for more
on this subject.) FM3 Output 2 is used in this setup, because it is designed for unity gain. A sample preset layout

is shown below:
[ N1 H cmp H{wan | prv | by H Rev |Houtz)

CONNECTIONS

» Connect your guitar to FM3
Input 1 Instrument.

» Connect Output 2 L to the input of your amp.
A Humbuster™ cable is recommended.

= To extend this configuration for optional
stereo, connect Output 2 R to the input of a
second amplifier.

* You can in fact use the FM3 to select
between two different amps by changing
channels on the Output 2 block. You might
program this by making the following L __ ...
settings: : ]
- Channel A: Balance Center (Both Amps) teneeooe '

N
[
'

- Channel B: Balance Left (Left Amp) OPts':’e",ZLfor

- Channel C: Balance Right (Right Amp)

- Channel D: (Not used) =

(See "Scenes & Channels” on p. 49 for 52.000009 ¥ ]

more info.) €L mM'CoOmBO GUITAR
» Setthe FM3 OUT 2 knob fully clockwise AMP

for unity gain if desired, and adjust
your amp as you normally would.

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad function on Output 2 can be used to lower the noise floor. To find the right setting, adjust
this to be as high as possible without clipping, as indicated by a red LED on the front panel meters. The volume
won't change but you should hear the FM3's noise floor drop as you increase boost/pad. Find this option under
SETUP: 1/0: Audio.

34
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FX PROCESSOR ONLY (“POST")

Global Settings: check 1/0 Mono/Stereo settings, see “Tip” Below
Presets: Custom

The FM3 can be used as a multi-effects processor in the loop of an amp, providing access to our industry leading
effects for those who may not be not ready to make the jump to amp modeling (Don't worry, it's OK; you'll get
there someday).

FM3 Input 2 is used in this setup to accommodate your amp’s line level FX send.
FM3 Output 2 is used in this setup, because it operates at unity gain when the Out 2 knob is all the way up.

You will need to create custom presets for this setup. These must have NO Amp or Cab blocks, and must contain
only those effects that sound good to you after the distortion stage of your preamp. An example is shown below:

(N2 H eq [ cHo |{pwv1 H{piv2 H Rev |Houtz)

CONNECTIONS

» Connect your guitar to your amp's
instrument input as you normally would.

» Connect the FX Send of your amp to FM3
Input 2 L. Adjust Input trim on the FM3
if needed in SETUP : 1/0 : Input.

» For the setup shown here, set Input 2 Mode to
“LEFT ONLY” under SETUP: 1/0: Audio. (It is rare
but not unheard of to use two preamps in stereo.)

spore

: OUTPUT : Connect to FX RTN
' 2R . of a second amp for
""""" optional stereo.

» Connect FM3 Output 2 L to the FX Return of your AMP
amp. A Humbuster™ cable is recommended. wadqm
» Set the front panel OUT 2 knob fully 5o Q00O0NOS o= | 'N|SNTR

clockwise for unity gain, or as desired

for appropriate volume levels.
= To extend this configuration for optional stereo,
you would typically connect Output 2 R to the FX
return of a second amplifier. SPEAKER
PARALLEL FX LOOP? CABINET
If your amp’s FX loop is parallel, your FM3 presets must
be further customized so that no dry signal passes
through the FM3. This generally limits the effects you

can use, how they must be arranged, what their mix
setting must be, and more. If your amp is switchable,
the series setting is certainly easier to use in this case.

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad function on Output 2 can be used to lower the noise floor. To find the right setting, adjust
this to be as high as possible without clipping, as indicated by a red LED on the front panel meters. The volume
won't change but you should hear the FM3's noise floor drop as you increase boost/pad. Find this option under
SETUP: 1/0: Audio. 35
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FOUR-CABLE METHOD (“4CM")

Global Settings: Default, but see “Tip” Below

Presets: Custom

The Four-Cable Method (“4CM”) setup inserts the FM3 in two different places of the signal chain. Each of these
requires its own separate blocks within a custom preset. First, the FM3 processes signal between your guitar and
amp, where a chain of “pre” effects like wah and drive are used. Next, it processes signal in your effects loop,

where a chain of “post” effects like delay and reverb appear.

A 4ACM setup requires special presets with no Amp or Cab blocks. A stylized illustration appears below. (See also
factory preset #382). Signal hits the FM3 first, where it is processed by the pre effects. Output 2 feeds the front
of your amplifier. The amp’s FX Send is connected to In 2, where a chain of post effects processes signal and
passes it to Output 1 and your amp’s FX Return. Note that the pre and post chains are not connected to each
other at all on the FM3 grid. In fact, either chain can be as simple or as complex as desired.

[ N1 H{waHH DRV H{ - }Hour2|

Pre-FX

IN2 H by H Rev H <« Hour1

Post-FX

CONNECTIONS

» Connect your guitar to FM3 Input 1 (Instrument).

» Connect FM3 Output 2 L to the front input of your
amp. Set the front panel OUT 2 knob fully clockwise
for unity gain operation. A Humbuster™ cable is
recommended to combat hum from ground loops.

» Connect your amp’s FX Send to Input 2 L. FM3
Input trim can be adjusted in SETUP: 1/0: Audio. On
the same page, set Input 2 Mode to “LEFT ONLY".

» Connect Output 1L to the FX Return of your amp.
You will need an XLR-female to 1/4" TS (NOT TRS!)
cable in most cases. Set the front panel OUT 1
knob as desired for appropriate volume. To extend
this configuration for optional stereo, connect
Output 1 R to the FX Return of a second amplifier.

» The 4CM is fairly intricate and has questionable
benefits compared to the setup called “Traditional

Guitar Power Amp & Speakers” on p. 31

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad function on Output 2 can be
used to lower the noise floor. To find the right setting,
adjust this to be as high as possible without clipping,
as indicated by a red LED on the front panel meters.
The volume won't change but you should hear the
FM3’s noise floor drop as you increase boost/pad. Find
this option under SETUP: 1/0: Audio.

]
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INSERTING OUTBOARD GEAR

Global Settings: As per your usual setup, check I/0 Mono/Stereo Settings
Presets: Custom

The typical “direct” setup (p._28) uses just Input 1 and Output 1 on the FM3. This leaves Input 2 and Output 2
available for a “send-and-return” insert for outboard gear. Custom presets are required for this setup, with output
and input blocks added for the send and the return (see illustration below).

[ N1 | cMP H wAH [ bRv H Amp H caB [HouT2/H IN2 [ by HouT1]

Serves as a SEND  Serves as a RETURN
Notice that the Out 2 block IS connected to the In 2 block. This is because IN 2 is specially designed to work as
a bypass for the entire loop, allowing signal to flow from In 1 to Out 1 even when the outboard gear is not in use.
You can operate this with a footswitch, or control it with scenes.

One final comment: don't jump to the conclusion that an insert is the best way to use 3rd party gear. You can
achieve great results simply by connecting things in series like traditional pedals. The FM3 works great when
used with pedals between your guitar and its input. Similarly, you can connect its outputs to the inputs of other
processors. One advantage of using an insert, however, is that outboard gear can be controlled by an FM3 presets
scenes, or even recorded via USB.

CONNECTIONS

» Connect your guitar to FM3 Input 1 (Instrument).

» This example assumes Output 1 is
connected to a PA or FRFR monitors.

» Connect Output 2 L as a “send” to the input of
your outboard device. Use Output 2 R for optional
stereo. Adjust output levels using the front panel
OUT 2 knob, remembering that Output 2 provides
unity gain when the knob is fully clockwise.

* You can also adjust the levels of any individual
Output block, or on your outboard device.

» Connect the output of your outboard device to
Input 2 L as a “return.” Use Input 2 R for optional
stereo. Adjust levels on your outboard device or
pad Input 2 of the FM3 under SETUP: 1/0: Audio.

Optional
for Stereo

OUTBOARD GEAR
(PREAMP, PROCESSOR, PEDAL, ETC.)

The FM3 can send MIDI to control 3rd party devices. Connect a MIDI cable from the MIDI Out of the
FM3 to the MIDI IN of the connected device. Then program the required MIDI messages using either a
“Scene MIDI Message” or a Control Switch MIDI Message.
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4 SETTING UP

ELECTRIC AND ACOUSTIC

Global Settings: Set Input 2 Mode to “Left Only” under SETUP: 1/0: Audio
Presets: Custom

This setup is provided for those who wish to use the FM3 to process an electric guitar and an acoustic guitar
at the same time. It also works for guitars equipped with dual output from magnetic and piezo pickups. Special
presets containing the Input 2 block are required as illustrated below. For this setup, the electric and acoustic
signals are combined into one stereo output, but if you learn to use Input and Output blocks effectively, this will
open other options such as different guitars appearing at different outputs.

See the Blocks Guide for more information.

CONNECTIONS

»

Connect your electric guitar to
FM3 Input 1 (Instrument).

Connect your acoustic guitar (or the piezo side
of your electric) to FM3 Input 2 L. Set Input 2
Mode to “LEFT ONLY" under SETUP: 1/0: Audio.

Connect FM3 Output 1 to your PA, mixer, or

monitors as you would in any other “direct” setup.

Create a preset as shown below where IN 1 is the
electric guitar and IN 2 is the acoustic/piezo.

Compressor and EQ blocks are a great
way to add level and tone controls to
your acoustic or piezo signal.

Note that in the example, the two chains
are sharing a reverb block, which sounds
great and is also economical. It is also
possible to share many other blocks.

If you wanted the acoustic to go to its
own output, you could insert the output
2 block and connect to that instead.

A basic starting template is provided in
factory preset 380: “Mag & Piezo FM3”

EXAMPLE PRESET

Electric

EEREEE e )
EEESEESSEED,

P.A. or FRFR MONITOR

| INT H{WAH}{ DRV |-{ AMP | cAB | DLy

REV |-{oUT1|

' IN2 H{cmpH EQ H cHo

Acoustic
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9 PRESETS

OVERVIEW

» The FM3 contains 512 preset memory locations. Each preset is like
a full rig with its own amp, cab, effects, and more.
» Every memory location, including the Factory Presets, can be changed or completely overwritten.
» If you want to restore the factory presets (or install the newer versions we sometimes release), you
can download these from https://www.fractalaudio.com and re-install them using Fractal-Bot.
» Every preset has its own name that you can change as you store it.
» Presets are built on a “Grid” by inserting, connecting, and dialing in “Blocks.”
» Every preset contains eight “Scenes”, each with its own name.
» Blocks contain “Channels.” See “Intro to Scenes and Channels” on p. 15.
» Compared to the Axe-Fx Ill, the FM3 will have smaller presets, but a single preset
can still potentially cover an entire song, or even an entire gig.
» Please review “Intro to the Layout Grid” on p. 14 before reading this section.
SELECTING PRESETS

Different areas of the FM3 provide different ways to select (or “load”) presets:

On the Home page - Use the NAV LEFT and NAV RIGHT buttons or turn the VALUE knob.

On the “PRESETS" directory page of the HOME menu - Use the NAV buttons to
select a preset and press ENTER. Presets in the directory are sorted in numerical
order. To re-sort alphabetically, press the SORT A-Z button (Push-knob E).

Foot Switches - FM3 footswitches have a range of “preset select” options.

MIDI - MIDI Bank and Program Change messages may be used to select presets using the
industry-standard “Controller 0 + PC” method. See “MIDI Reference Tables” on p. 115. MIDI

Custom PC Mapping is also supported, see “Program Change Mapping” on p. 53.

FM3

036: FAS Modern

Heavy Heavy
Awash in Madness FX
Big Drive Scene /2=Skrillex

Basic Drive Tighter Gate
Clean and Bone Dry

Clean with Sweet Pedals
Postmodern Rings Twice
4-Channel Synth Sequence

(¥ Scene
TUNER LAYOUT CONTROLLERS | | FC PER-PRESET

The Home Page of the Home Menu
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5 PRESETS

THE LAYOUT GRID

The grid is a 12x4 framework for building presets. Think of grid rectangles as slots into which blocks are inserted
and connected together to create a signal processing path. Each grid space and every cable is stereo (though not
all blocks are). You don't need separate left and right paths!

Access the grid from the Home page by pressing the ENTER button or the LAYOUT Push-knob.

In the default view, the FM3 display shows only a 6x4 section of the 12x4 grid. Navigate to off-screen areas using
the E knobs, or the NAV buttons. A bottom scrollbar indicates where you are in the overall left-to-right layout. To
show the entire grid at once, zoom out with the ZOOM button (Push-knob A).

Meters  Tools Layout cPu m 40% Meters  Tools

(> Scene: 1 Channel Block Level Row Column (3 Scene: 1 Channel Block Level Row Column
Z00M BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS
The grid normally shows four rows and six columns. Zoom out to show the entire grid at once.
You can scroll left or right with navigation controls. This also reveals VU meters for leveling scenes and presets.

WORKING WITH BLOCKS

As explained in “Intro to the Layout Grid” on p. 14, FM3 presets are using blocks pulled from a large inventory
of amps, cabs, stompboxes, studio effects, mixers, and more. To navigate around the grid you must move the
cursor — a yellow rectangle controlled by the NAV buttons or the D or E knobs.

TO INSERT A BLOCK...

» NAV to the desired grid location.

» Turn the VALUE wheel to step through the list of blocks.

» Press ENTER to confirm or EXIT to cancel changes.

» Asyou insert blocks, they are removed from the list, but every preset has the entire inventory to begin with.

TO CHANGE OR REMOVE AN EXISTING BLOCK...

» To CHANGE a block, select it and turn VALUE to the desired type.
» To REMOVE a block, select it and turn VALUE until “None” is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

TIP: A shortcut makes it easy to remove an existing block or convert it to a shunt. Select
[ DELETE ] the block and press the DELETE button (Push-knob C). A deleted block is replaced by a
shunt. Delete a shunt to leave an empty space.
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TO BYPASS OR ENGAGE A BLOCK ON THE GRID...

» Use NAV buttons to select the block.
» Press the BYPASS button (Push-knob B). Bypassed blocks are dimmed or “grayed out” on the grid.

RESETTING A BLOCK/CHANNEL

Blocks on the FM3 remember their last used settings, even as you place them on the grid. You may want a fresh
start before or after making changes. RESET takes only two button presses and can be performed at any time.

» Ifitisn't already open for editing, select the desired block on the grid and press EDIT.
[ RESET ] » Press the RESET button (Push-knob A). You are prompted to reset the current channel.
» Press ENTER to confirm. You can reset other channels in a block as they are used.

SHUNTS

A shunt is a sonically transparent block—like a cable which carries signal from one point to another. Like grid
spaces, a shunt is stereo; you don't need two for left/right. You can use shunts to span empty space in any preset.

TO INSERT A SHUNT...

» NAV to the desired grid location and turn VALUE until “SHUNT" is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

INPUTS AND OUTPUTS

Input and Output blocks are required to get input signals to the grid or pass signal to output jacks. All factory
presets use Input 1 and Output 1. Other setups may require different Input and Output blocks.
See Section 4 on “Setups” for examples. See “The Fractal Audio Blocks Guide” for more information.

BLOCK DISPLAY TYPES

The color display of the FM3 shows different grid block states as follows. Several examples appear below. Notice
that the selected block has a bold yellow outline and the bypassed block is grayed out.

Input Bypassed Selected Normal Shunt Output
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MOVING BLOCKS, ROWS, AND COLUMNS

A special “Tools” page in the Layout menu contains various utilities to MOVE individual blocks or entire rows
or columns UP, DOWN, LEFT, or RIGHT. When a block or a grid row or column is moved, it swaps places with the
item in the space it is moved to. This may result in certain connector cables being modified or removed, so be
sure to look over how the elements of your preset are connected before moving things around.

» Open the Tools page of the Layout menu.

» Select a function with the FUNCTION knob (A): Move Effect/Column/Row, Left/Right/Up/Down.
» Use the NAV buttons to select the Block, Row, or Column you wish to move.

» Press ENTER to execute the move.

CONNECTOR CABLES

Just like physical gear, the blocks in the FM3 need to be connected together for signal to flow. This is done using
virtual cables, which run from one grid block to another. With even one cable missing, your preset may be totally
silent! Like shunts, connectors are stereo and totally transparent.

TO CREATE A CONNECTOR CABLE...

» On the grid, navigate to the block where you wish the cable to BEGIN. You can't start from an EMPTY space!
» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.

» If you wish to connect to a different ROW, use NAV up or nav down to
select the desired destination. You can’t skip columns!

» Press ENTER to make the connection. To cancel, press EXIT instead.

= Be sure to select a destination that is not already connected to the block
you started from, or you will REMOVE that cable (see below).

TO REMOVE A CABLE CONNECTOR...

Cables are removed in much the same way as they are created.

» On the grid, NAV to the block where the cable begins.
» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.
» NAV to select the “other end” of the cable you wish to remove. You can't skip columns!
» Press ENTER and the cable will be removed. To cancel, press EXIT instead.

SHORTCUT: To connect across multiple empty grid columns with a series of shunts and cables,
select any block that is followed by a series of empty spaces, then press-and-hold the ENTER
button. The intervening spaces will be automatically filled with shunts and connected with cables.
Careful: any existing cables encountered along the way will be REMOVED!

_ in/stereo out. The grid allows up to four full stereo paths, and you do NOT need to create parallel grid
"-.xx =4 paths for stereo! Some blocks internally process audio in mono (such as Amp or Drive) but even these
%/ generally have Input Select and Output Balance parameters.

42

9 Remember, on the FM3 grid, each component is STEREQ. Shunts, cables, and many blocks are stereo



5 PRESETS

THE RULES OF FM3 CABLES

» No cable = No sound. Even one missing link will break the chain.

» Signal flows from LEFT to RIGHT.

» A cable MUST originate from a BLOCK or a SHUNT. You cannot start from an EMPTY location.

v

If you try to connect to an EMPTY location, a SHUNT will be created there.

v

You can ONLY connect to blocks in the next column to the right.

The diagram below illustrates the above:

The % is the block where we will begin.
The v shows valid possible destinations.

The © symbol shows destinations that are illegal/unavailable.

dE@@
alzgitle

JYWE
zlele

Any columns farther left or right would also be illegal/unavailable.

If the Y were in a different ROW, every v would still be in the same place.

» You may freely SPLIT or MERGE up to four ways at any point. This is sonically transparent and there is zero
risk of signal degradation or phase problems. CROSSING is also possible. Here are some examples:

Split Merge Cross Complex

—
-

i
.
s

_ J/\ J

ol
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BLOCK INVENTORY

For a complete guide to all blocks and parameters, see “The Fractal Audio Blocks Guide”
The following table contains an overview of every block. Each preset has the entire inventory to choose from.

BLOCK

AMP Amp

CAB Cab

CHO Chorus
CMP Compressor
DLY Delay
DRV Drive

ENH Enhancer
FLT Filter

FLG Flanger
FOR Formant
GTE Gate/Expander
GEQ Graphic EQ
IN  Input

LPR Looper
MGT Megatap
MID MIDI

MIX Mixer
MTD Multi-Delay

MBC Multiband Comp.

MUX Multiplexer
OUT Output

PEQ Parametric EQ
PHA Phaser

PIT Pitch Shift
PLX Plex Delay
RES Resonator
RTN Return

REV Reverb

RNG Ring Mod
ROT Rotary

MIDI Scene MIDI
SND Send

SYN Synth

TTD Ten-Tap Delay
TRM Tremolo
VOL Volume/Pan
WAH Wah

DESCRIPTION

Here it is! 260+ amp models in one block!

Speaker cab simulation with both “Factory” and “User” banks.

Create classic mono and stereo modulation effects including vibrato.
Control dynamics and add sustain.

Up to 8000 ms of delay, with types for analog, digital, tape, and more.
Types including boost, overdrive, distortion, fuzz, and many more.
Classic and modern modes to create and control spatialization.
Includes low pass, high pass, band pass, and many other types.
Various types cover everything from subtle modulation to extreme jet.
Create dynamic vowel sounds with this multi-mode formant filter.
Useful for everything from subtle control to extreme effects.

A variety of modes allow easy, flexible tone sculpting.

Injects the signal from physical inputs onto the grid.

A powerful looper with great remote control options.

This 40-tap delay creates fantastic sonic patterns.

The Scene MIDI Block transmits MIDI when a scene is selected.
Allows you to mix up to four stereo signals.

A variety of special delays including diffuser, quad-tap, and more.
Three-band compressor that is great for mastering or dynamic EQ.
This input selector routes one of many inputs to an output.
Transmits signal to the corresponding physical output jacks.

The 5-band parametric equalizer allows precise control of tone.

A variety of vintage and cutting edge phaser effects, including ‘vibe.
Includes detune, harmonizer (intelligent/custom), whammy, and more.
Up to eight delay lines interacting in a matrix. Gorgeous!

Resonant comb filters in parallel can create cool resonant sounds or chords.

Receives signal from the Feedback Send block.
World-class recreations of vintage springs, rooms, halls, and more.

The extremely flexible ring modulator provides for a range of cool effects.

Simulates a classic rotary speaker with multiple microphones.

Auomatically sends MIDI PC or CC messages whenever a scene is loaded.

Transmits signal to the Feedback Return block.

A 3-voice monophonic synth that tracks what you play.

Set the time, pan, and spacing of one to ten separate echoes.
Creates classic trem, plus auto-pan or extreme psycho acoustic effects.
Simple volume block also offers channel input/output tools.
The classic wah, with multiple types based on classic originals.

Each preset also includes a Controllers block that is not placed on the grid.
Certain blocks found on the Axe-Fx lll do not appear on the FM3.
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EXAMPLE PRESET GRIDS

These FM3-Edit screen captures show how blocks are combined to form presets.

Ex 1: Bare bones! Amp and Cab. No effects.

Ex 2: Here some effects are added before the amp and after the cab.

| |
CRRIriE | E Dizlay | ||'-::-.'-:|T||
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EDITING EFFECT BLOCKS

Blocks are fully programmable, allowing you to dial in every setting as desired. The Edit menu for every block
contains one or more pages, each with multiple parameters which control various functions. Here's a quick guide
covering how to access and work with the different types of Edit menu pages.

OPENING AN EDIT MENU
» On the Layout grid, select the desired block and press EDIT.

» OR... from anywhere on the FM3, just press EDIT to jump right to the Edit menu for the selected block.

CHANGING PAGES

» Most Edit menus have multiple pages, shown as “tabs” — : :’B‘HSG’E‘X ‘;‘*Mix
at the top of the menu (red arrows, right).The color of Analog e T e e
the tabs matches the color of the block on the grid. e 00% Sy

» Tap the PAGE buttons to page left or right. oz O ™ ™

Voices Tempo Rate Depth Time
EDITING “KNOB” PAGES 1
» Most Edit menu pages show up to five knobs,
switches or selectors. To make changes, use the
five physical knobs below the display (green arrows, (] reser ) (gveass ) (mogrier ) ( Rrow ) (MORE Loke)
right) or the NAV buttons and VALUE knob. @ @ O @ @
» You will hear all changes in real time. B c D E
» If a menu page has two rows of knobs, use
NAV UP/DOWN to switch between them.
" 1)
EDITING MENU PAGES Chorus 1 Type Basic fExpert} Mix
» Some pages have vertical lists of parameters. Anelog Stereo Scene:1_Channel:A e
» Use the NAV UP/DOWN buttons to step through o poncut gg%ﬂd'*;g
the list or NAV LEFT/RIGHT buttons to jump. 0 LFO Type TRIANGLE
E Auto Depth Low
» The A knob and the VALUE knob operate Phase Reverse  NONE
the selected parameter. Width 500 %
. LFO2 Rate 0.050 Hz
» B, C,D, andE knobs control other parameters in LFO2 Depth 00%

Stereo Spread © 100.0 %

the list, as shown by blue labels on the list. T (BSs (WO (W (VoRETeD)

Multiband Compressor 1 f[)onﬁg} Mix
» Some blocks have special Edit menus, with parameters Scene:1 _Channel: A —
arranged in rows and columns. Some of these include
interactive meters or graphs. Use NAV and VALUE or Low Mid High
C Fi 500.0H 10000 H
AB,C,D,E knobs to move around and make changes. Thieshold | -B0dh  -20db “100b
Ratio 1.000 20.00 2.000
i Attack 10.00 10.00 10.00
» For 1_'YPE pages, such as Amp Type, just NAV through pltack 1000ms - 1080ms 1000 ms
the list to make a selection and turn the page or press Level -20008  -6.000B
. . N Detector Fast RMS Peak RMS+Peak
EXIT when finished. Selections take effect instantly. Mute OFF - gy
& Nav Value Value Value
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SAVING CHANGES

After editing a preset, you may want to save the results.
Every preset in the FM3 can be modified. There are no permanent presets.

When you change the current preset in any way, the front panel "EDITED" LED lights until you STORE or load a new
preset.

TO STORE A PRESET...
» Press STORE to show the STORE page.

» Turn the VALUE wheel or B knob if you wish to save to a different location.

» Press ENTER to display “Do you want to overwrite the Preset?”
» Press ENTER again to confirm, or EXIT to cancel.

» The message “SAVED!" is shown when saving is complete.

TO CHANGE THE PRESET NAME...

The FM3 has 512 preset memory locations. You can edit the name of any preset while storing.
» Press STORE to show the STORE page.
» NAV down once to the PRESET line.

= Turn the B knob to move the cursor.

The C knob selects UPPER CASE letters.

The D knob selects lower case letters.

The E knob selects numbers.

The VALUE knob selects ALL characters, including symbols.
= You can use up to 31 characters in a preset name.

» You can also NAV to any Scene name to edit it in the same way.

» Press ENTER to Store, then press ENTER again to confirm.
» The message “SAVED!" is displayed and the new location (if any) is loaded.

Scene naming is a powerful capability. Aside from stating what a specific scene is
intended for, the names of unused scenes can be used for short notes or reminders.
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PRESET CPU LIMITS

The CPU of the FM3 is used mainly for sound processing. A preset with nothing but an Amp and Cab is less
demanding than a preset with a Wah, Drive, Amp, Cab, Delay and Reverb.

You can check the current CPU level at any time by viewing the mini CPU meter at the top of the layout grid.

The maximum allowable load is approximately 80%. There are safeguards to prevent you from pushing the FM3
too far. Should CPU levels rise above the allowable limit, the FM3 will disable sound processing and flash the
warning, “CPU LIMIT - Muted”. This allows you to remove blocks or change settings to solve the problem.

Another safeguard is that the FM3 will prevent you from inserting a block that would push the CPU over the limit.
If this happens, you can make changes to reduce the current CPU load and try again. You might remove an effect
that is less important. Adjusting certain parameters can also help.

Here are a few of the common block parameters whose settings have a notable effect on CPU usage:

= Amp: Output Comp: Set to "0" for the least CPU usage.

= Cab: Mute: Using two IRs demands more CPU than using one.
Set the mic Preamp Type to NONE and set Room Level to 0%.

= Reverb: Quality and Echo Density. Lower = less CPU.

= Compressor: Set Type to one of the "PEDAL" options to use less CPU.
= Phaser: Stages. Lower = less CPU.

= Filter: Order and Q. Lower = less CPU.

» Multitap Delay: Type. Different types have different CPU requirements.
= Plex Delay: Number of Delays affects CPU usage.

= Synth: Turn extra voice type parameters OFF to conserve CPU

= Modifiers also affect CPU usage.

TIP: The Fractal Audio Wiki keeps a list of CPU saving ideas.

CPU & USB

On the FM3, CPU usage does not increase when USB is connected.
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6 SCENES & CHANNELS

Before reading this section, please review “Intro to Scenes and Channels” on p. 15.

A Scene can be thought of as a preset within a preset. Scenes can turn blocks on or off, change block Channels, and
more. Scenes don't need to be created—they’re already there, ready to be set as desired. To save any changes to
any scene, you must save the entire preset. There are many benefits to using scenes. By switching multiple blocks,
they eliminate the need to “tap dance” on switches. They also offer the easiest way to ensure perfect “spillover”
of effects like delay and reverb. Scenes can also change overall volume levels, send MIDI messages, and more.
Each Scene also has a name.

WHAT SCENES INCLUDE...
< Each Scene stores ALL of the following:
¥ .
N 1. The Bypass state of every block in the current preset: on or off.

>
A & | 2. Thecurrent Channel of every block in the current preset.

3. The current “Scene Level” of the Output blocks.
4. The settings of four Scene Controller knobs used as Modifier sources.

Scenes can use the Scene MIDI block to send up to 8 MIDI PC or CC messages each
time a new scene is selected. See the Blocks Guide for more information.

Each scene also has its own Name.

CHANNELS

The Channel feature is almost self explanatory. Most blocks have some number of channels (typically four), and
for each channel you can set every parameter of that block to any setting. It's like having multiple blocks in one.
For example, Channel A of a Drive block might be a “clean boost”, B could be a “screamer”, and so on.

So, while Scenes can't change individual parameter values, they CAN change the channel, and each channel has
its own parameter values.

DON"T: Set a parameter (for example, Amp Treble to “6") then change to a new scene and change the value of
that parameter (ex: Amp Treble to “10”). The change will affect all scenes!

DO: Dial in a block (ex: the Amp) however you want it. Now, change the Scene AND set that block to a new
Channel. Now you can now change ALL settings for that block. These will take effect whenever you load that
same channel — whether in this scene or any other. (This concept is illustrated on p. 15.)

F AQ. WHY NOT JUST CHANGE PRESETS? Preset changes give you total

® flexibility. You can change anything and everything in every preset, but there are also
drawbacks. Synchronizing multiple presets can be tedious, it takes care to get levels and spillover just right,
and while preset changes are fast, Scene changes are even faster and can be seamless.
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HOW TO CHANGE A BLOCK'S CHANNEL

Different areas of the FM3 provide different ways to change block channels:
= On the GRID - Select the desired block and turn the Channel knob (B).
The current Channel is shown above the knob.

= While EDITING a BLOCK - Press the MORE button (Push-knob E) to show the Scene/Channel strip.
Use the CHANNEL-/+ buttons (Push-knobs C & D) to select a channel.
The current channel is shown near the top center of every page in the Edit menu.

= Foot Control - The onboard switches of the FM3, or those on a connected
FC Controller offer a range of dedicated “Channel” options.

= MIDI - MIDI and other controllers such as a connected external footswitch can be used
to change the Channel. See “Selecting Scenes & Channels Remotely” on p. 52.

SETTING UP CHANNELS

Whenever you edit a block, you are already programming at least one Channel (usually Channel A). Programming
additional channels is easy: simply select the desired channel as described above, set the various parameters to
their new values, and then save the preset.

TO COPY ONE CHANNEL TO ANOTHER...

The Tools page of the Layout menu (“grid”) provides a utility to copy one Channel to another. This works within a
single block only; you can’t copy a Channel from one block to another, or from one preset to another.

Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY CHANNEL" is shown on the display.

Use the D knob to select the scene you want to copy from. Channel letters are shown above the knobs.
Use the E knob to select the location you want to copy to.

Press ENTER or the on-screen EXECUTE button (Push-knob C) to complete the copy.

Test your preset and remember to STORE to make the changes permanent.

Skl wbd=

While you can’t copy channels across blocks or presets on the FM3 itself, you can do this using
FM3-Edit, the free companion software editor for the FM3.
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SELECTING SCENES

Different areas of the FM3 provide different ways to select a Scene.

= On the Home page - Use the NAV UP/DOWN buttons or turn Push-knob A. The current scene is highlighted.
= On the GRID - Turn the Scene knob (Push-knob A). The current scene is shown above the knob.

= While EDITING a BLOCK - Press the MORE button (Push-knob E) and then use the SCENE -/+ buttons
(Push-knobs A & B). The current scene is shown near the top center of every page in the Edit menu.

= Foot Control - The onboard switches of the FM3, or those on a connected
FC Controller offer a range of dedicated “Scene” options.

= MIDI - MIDI can be used to change the scene. See “Selecting Scenes & Channels Remotely” on p. 52.

THE DEFAULT SCENE

When a new preset is loaded, it automatically starts on whichever Scene was selected when the preset was last
saved. So, to set the default scene for any preset, simply select the desired Scene and then save the preset.

SETTING UP SCENES

Whenever you create a preset, you are already using at least one Scene (usually scene 1). Programming additional
scenes is easy. Here are step-by-step instructions for setting up scenes:

TO SET UP A NEW SCENE OR EDIT AN EXISTING ONE...

1. Load the desired preset and select the desired Scene.
2. Bypass or engage each block as desired.
= On the Layout (grid) or while editing any block, use the BYPASS button (Push-knob B).
= Oruse any assigned footswitch or remote controller to bypass/engage the block.
3. Set the Channel for each block as described on the previous page.
4. Test and save your preset. On the STORE page, NAV to any new scenes and name them (see p. 47).

Always test ALL scenes in your preset—even those you think you might not use.
Ensure that there are no unpleasant volume jumps or other surprises in case of accidental mis-steps later.

TO COPY ONE SCENE TO ANOTHER...

The Tools page of the Layout menu contains a way to copy one scene to another (not including the scene name).
This works only within a single preset.

1. Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY SCENE" is shown on the display.

Use the D knob to select the scene you want to copy from. Scene numbers are shown above the knob.

Use the E knob to select the location you want to copy to. You can also choose to copy one scene to “ALL".
Press ENTER or the on-screen EXECUTE button (Push-knob C) and the copy operation is completed.

Test your preset and remember to STORE to make the changes permanent.

S gk wbd

Not even FM3-Edit can copy a Scene from one preset to another. This is because there is no way
to ensure that the scene would work at all in its new home. You can copy certain parts of the
sound of a given scene by copying blocks or channels, but this can be tricky.

a1
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SELECTING SCENES & CHANNELS REMOTELY

Scenes and Channels can be selected using MIDI or Global Controllers. Several options are provided.

SCENE INCREMENT AND DECREMENT

The Scene Increment and Decrement functions allow you to step up or down through scenes one at a time. You
must first assign each function its own CC# or pedal/switch option in the MIDI/Remote menu under SETUP. The
function is triggered by any value of the controller.

SCENE SELECT
The Scene Select option uses the value of a MIDI controller to select specific Scenes. You must TABLE 1
first assign a CC# to Scene Select in the MIDI/Remote menu under SETUP. CC Values & Scenes
The scene is set by the value of the controller (not the controller number itself... see FAQ below). 0 =Scene
Values begin at 0, while Scenes are numbered from 1, so “Value + 1 = Scene number” 1=Scene 2
(see table 1, right). The series continues, repeating scenes 1-8 across CC values up to 127" 2 =Scene 3
EXAMPLE: Imagine you want MIDI to select scene 3. Open the MIDI/Remote menu and assign 3 = Scene 4
your desired CC# to “Scene Select”. Let's use CC#34 in this example. To load Scene 3, send 4 = Scene 5
CC#34 with a value of “2" to the FM3 (Scene 3: 3-1=2) 5=Scene 6
6 = Scene 7
CHANNEL SELECT 7 = Scene 8

This uses the value of a controller to select a specific Channel. Each block has its own dedicated  tagLE 2
setting for channel select, found across the listings on the Channel page of the MIDI/Remote

CC Values & Channels
menu under SETUP. 0 = Channel A
The Channel is set by the value of the controller (not the controller number itself... see FAQ 1 = Channel B
below). Values begin at 0, which is Channel A, and it continues from there. (See table 2, right). 9 = Channel C
As with Scene Select (above) the series continues, repeating Channels A-D across values to 127. 3 = Channel D

1 In mathematical terms, that's Scene# = [(CC Value mod 8) +1]

~ MIDI CC Number and CC Value... What's the difference?
FAQ. MIDI Control Change messages —aka “CCs"— have a number (0-127) and a value (0-127).

The number is like an “ID” which is used to distinguish one CC from another and set its
function in a receiving device. A simple example might be a MIDI expression pedal that sends CC#7 which is
interpreted as “Volume” on the receiving end. The FM3 lets you designate CCs for various controllable items in
several lists found in the MIDI/Remote menu under SETUP.

Once a CC# is set to control a function, the value of that CC tells the function what to do. Some functions—like
Volume— interpret data across a continuous range from 0-127. Other functions—like Bypass—simply toggle
OFF for a low value and toggle ON for a high one. Other functions might be triggered by any value.

Different types of physical controllers transmit values in different ways. A pedal that rocks continuously from
heel-to-toe sends a stream of continuous values from 0-127. A switch sends a single value for OFF (typically
0) and another for ON (typically 127). Other MIDI controllers offer other options.

As described above, both the CC number and its value are the key to selecting Scenes and Channels via MIDI.
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PROGRAM CHANGE MAPPING

Another way to select Scenes via MIDI is using PC Mapping, which allows a single incoming MIDI Program
Change (PC) message to select your choice of both Preset and Scene. This is a popular option in cases where
a connected MIDI foot controller lacks the sophistication to transmit the MIDI messages required for scene
selection.

The PC Mapping parameter on the General page of the MIDI/Remote menu under SETUP must be enabled for
custom mapping to be in effect. With this option set to “ON”, an internal table re-maps each incoming MIDI
Program Change message so it can load your choice of preset and scene. The map is limited to 128 entries so
MIDI BANK SELECT messages are ignored while PC Mapping is enabled.

With PC Mapping option set to “OFF”, MIDI Program Changes load presets on a 1:1 basis and Bank Select
commands are processed as usual as per “MIDI Reference Tables” on p. 115.

BUILDING THE MAP
The mapping table is on the Mapping page of the MIDI/Remote menu under SETUP.

To use it, follow this simple process:
1. NAV to the row for whichever Program Change message you want to re-map.

2. Use the B knob to set the desired value for Map to Preset.
This is the preset that will load when the selected Program Change message is received.

3. Use the C knob to set the desired value for Map to Scene. You can choose a scene by its number, or select
“AS SAVED" to load the default scene saved in your preset. (see p. 51 for more on Default Scene).

4. Repeat steps 2 through 4 for any remaining Program Change messages you wish to remap.
5. EXIT when finished. You do not need to store settings in the SETUP menu.

The custom map parameters remain intact but not active when if you switch PC Mapping Off.

TRANSMITTING MIDI WITH SCENES

The Scene MIDI Block allows each scene can to transmit up to eight MIDI messages.
See “The Fractal Audio Blocks Guide” on p. 17 for more on this block.

SCENE LEVELS

Each of the Output blocks includes eight parameters that allow you to cut or boost the level for any scene. Using
these adjustments is a quick way to balance or boost scene levels when other level options are not available.
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SCENES, CHANNELS & MODIFIERS

The Modifier system of the FM3 provides extensive automation and remote control options.

Modifiers are detailed in Section 9 on p. 59 but here is a summary of important information about Scenes,
Channels, and modifiers.

SCENE CONTROLLERS

Remember that parameter settings cannot be changed by a scene. Of course, you can change the Channel, but this
is not quite the same thing (it’s also possible that all of your channels are already in use). The Scene Controller
system bridges the gap between these worlds, providing a way for individual parameters or groups of parameters
to have different values in different scenes.

See “Tutorial: Scene Controllers” on p. 68.

CHANNELS & MODIFIERS

By default, any modifiers are shared across all Channels of a block. This is a great convenience in most cases,
avoiding the need to apply the same modifier multiple times as you change channels.

In some cases, you may notice that if you change an effect Type from one channel to the next, certain parameters
are either not present at all, or appear with different names. For example, in the Delay block, the Mono Tape delay
has a parameter called “Head 2 Ratio”, while this same parameter is called “L/R Time Ratio” in the Dual Delay. A
modifier on one will affect both.

The option is also provided to limit a modifier to ONE channel (“A” vs. “All”, for example).

SCENE REVERT

Scene changes made in the display of the FM3, or via Fm3-Edit, remain in effect until you save them or discard
them by loading a different preset. Changes made via footswitches or MIDI, however, may work differently,
depending on a Global setting called Scene Revert. With Scene Revert turned on, Scene changes are discarded as
soon as you load a new Scene. Here are two examples so you can compare how Scene changes work with Scene
Revert OFF vs. ON:

Ex 1: SCENE REVERT OFF (default) Ex 2: SCENE REVERT ON

1. You load SCENE 1. DRIVE 1 is OFF. 1. Youload SCENE 1. DRIVE 1 is OFF.

2. You turn DRIVE 1 ON with a Footswitch. 2. You turn DRIVE 1 ON with a Footswitch.
3. You change to SCENE 2. 3. You change to SCENE 2.

4. You change BACK to SCENE 1. 4. You change BACK to SCENE 1.

5. Drive will still be ON, as you last left it. 5. Drive will be OFF as you last saved it.

TO ENABLE/DISABLE SCENE REVERT...

1. Page to the General page of the MIDI/Remote menu under SETUP.
2. NAV to SCENE REVERT and set it “ON" or “OFF" as desired.

3. EXIT to finish. (You do not need to STORE changes in SETUP.)
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7 LEVELING PRESETS

This section is about balancing levels across Presets, Scenes and Channels. It is NOT about how to correctly set
FM3 input or output levels to prevent clipping (compare “Setting Levels” on p. 5).

Musicians and audio technicians face a universal challenge of getting levels “right.” Legions of techs and
engineers mix bands in real time from the smallest basement jams to the biggest festival stages. The world has
quickly realized that the advanced modeling technology created by Fractal Audio actually makes this job easier.
(Wise front-of-house engineers are some of our biggest fans!) A tube amp often needs to be too loud to be
controllable. Speakers, mics and pedals are quirky and require constant control. In comparison, Amp modeling,
speaker cab simulation, and virtual effects, give us cranked sound at low volume, PLUS precise controls, accurate
meters, and fewer overall compromises. A few simple rules of thumb will put you in total control of your levels.

Control is not everything though: a second challenge remains. Levels must be understood in context. Our hearing,
speakers, and surroundings are all variable. You can learn the basics in this overview, but consider exploring this
subject further to delve deeper into the world of acoustics and audio engineering.

THINGS TO KNOW

» Our ears deceive us. A phenomenon known as the “equal-loudness contour” effect (aka
“Fletcher Munsen” effect) results in different perceptions of tonal balance at different
volume levels. At lower volumes, low and high frequencies seem to be relatively quieter.
Learn more about this effect and compare your sound levels at “gig” volumes!

» Different speaker systems change our perceptions of relative volume. Set levels on the system you
will perform through, or ideally, use the best and most accurate speakers you can find. Be prepared
to make adjustments on other systems. (This goes for your tone as well as your level.)

» Our surroundings, or the context of playback, also change our perceptions of loudness. Two
guitar sounds may appear to be relatively equal in level when you audition them alone, but may
sound totally different when you are “competing” in a mix against other instruments such as
bass and drums, or when played in a problematic performance space. Adjust in context.

THE RULE OF THUMB

» There are a lot of different ways to adjust levels on the FM3. A good rule of thumb is to use
the Level parameter of the Amp block. See “The Method” on the next page for an explanation
of how to work through this process across Presets, Scenes and Channels.

» Above all, use common sense. Rely on meters, but don't set levels solely on how they look. USE YOUR EARS!

EXCEPTIONS TO THE RULE

» When the Amp block is placed prior to a “level-dependent” or dynamic effect such as a compressor, gate,
or ducking effect, bend the rule of thumb and adjust the output of the last dynamic block instead.

» This is also the case for any nonlinear effects such as drive which may in rare cases (such as Tape
Saturation or Bitcrusher effects) be placed after the amp. Adjust Level for these blocks instead of the amp.

» If you have prominent Drive/Saturation in the Preamp simulation of the
Cab block, adjust the Level of the Cab block instead.
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A METHOD FOR LEVELING

The Layout Grid grid provides an excellent environment for leveling presets, scenes, and channels. From the Home
page, press ENTER to open the layout menu. The page buttons change between Edit and Meters pages, allowing
you to see block names as well as block meters for input (blue) and output (green). when you press ZOOM (push
knob A) , you will see two VU meters for Outputs 1 and 2 at the top of the display. These meters are great for
setting levels with a scale from -20 to +10 dB and a red line at 0. (This is the internal level, NOT a dBu reading.)

Edit Meters  Tools cPu Edit Meters  Toals

(> Scene: 1 Channel Block Level Row Column Channel Block Level Row Column
| Z00M J BYPASS DELETE CABLE CONTROLLERS J BYPASS DELETE CABLE CONTROLLERS

The zoomed out grid shows VU meters atop the screen. Page right to the Meters page for block meters.

To set levels, play your guitar and watch the VU meters. Adjust the output level of the Amp block by selecting it on
the mini grid and turning the Block Level knob (C) until the level hovers at or below the red line. Different types of
playing and different amp models and settings will excite the meter in different ways. Play chords and “chugs” as
their bassy content may push the meters harder, and it is potentially OK to see some red when you do this. If you
want to compare the levels of two presets/scenes/channels, play the same type of material while watching the
meters. Remember that whenever you adjust Drive, Master or other amp tone settings, you will need to revisit this
process.

The Layout view allows you to change Scenes (knob A) and Channels (knob B), so you can compare and adjust
everything all within a single page.

Remember this common sense principle: you must also use your ears. When you use the meters, a punchy clean
amp may end up sounding louder overall than an overdriven amp with a ton of low end.

LEAD/LOUD SOUNDS

You now know how to normalize level across Presets, Scenes, and Channels, but what if you specifically want
some sounds to be louder or quieter than others? A good approach is to begin with the loudest sound and make
the other sounds quieter. This helps ensure that you will have plenty of headroom and avoid clipping. It's OK for
certain tones to be very quiet: Fractal Audio products have an extremely low noise floor and do not easily suffer
internally from the kinds of problems which plague analog gear at lower than “optimal” levels.

Make it easier to adjust levels by using the Looper block to “play” while you operate the level controls.
@ Place the looper between the input and your first block.
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BYPASS AND LEVEL

Block bypass settings also contribute to preset levels. Here are some tips to help you dial in effects so that levels
can remain under control as you bypass or engage blocks.

»

Some effects specifically boost or cut levels. Other times, you want the volume to stay very much the
same as an effect is dialed in. In either case, there’s an easy method you can use to make correct
settings. First, with an effect engaged, set its Mix so the blend of wet and dry sounds just right to you.
Then, with one hand on the block’s Level parameter and the other on its Bypass button (Push-knob

B), switch the effect on and off, making level adjustments until the desired volume is achieved when
the effect is on or off. You can also use a footswitch if one is configured to control the effect.

When placed in series, time-based effects like delay and reverb are usually best with their Bypass Mode set to
“MUTE FX IN". This ensures that the dry level remains constant (“unity”) when you engage or bypass the block.
Because this setting masks possible changes to your dry level, you should use the Meters page of the Layout
menu to ensure that the level is roughly the same before and after these effects when they are bypassed.

Parallel effects should have Bypass Mode set to “MUTE", “MUTE IN”, or “MUTE
OUT” to avoid increasing the dry signal level when the effect is bypassed.

Pitch and certain other effects require special consideration. Depending on the particular type and settings,
you may wish to treat them like a time-based effect with Bypass Mode set to “MUTE FX IN", or you try a totally
different approach with one of the other settings such as “THRU". Try it and see what works best for you.

The various Bypass Modes are detailed in “The Fractal Audio Blocks Guide”.
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8 BLOCKS

The “The Fractal Audio Blocks Guide” covers all effect blocks and parameters for our current products.
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9 MODIFIERS

Modifiers can be one of the most exciting features on the FM3. They allow sound parameters to be remote-
controlled or automated in real time. For example, you might use an expression pedal to operate a wah or
whammy, or use an LFO (Low Frequency Oscillator) to auto-sweep a filter. MIDI can also be used to adjust effects,
control volume, and more. Modifiers are easy to use, but offer incredible depth of power for those who like to
push the limits.

CREATING A MODIFIER

The process of creating a modifier begins right at the parameter you want to control. Parameters that can be
controlled are marked with a yellow circular symbol (shown below on a knob and a switch). When a modifier is
already present, the circle will be solid yellow, like an LED that has been turned ON. You will see the same symbol
whether the target parameter is on a knob page, a text page, or any other type of menu.

() ()

Balance

The open circle The filled circle Here, a switch This parameter

meansyoucanadda  means amodifieris  instead of aknob  has no option for a
modifier here. already present. allows a modifier. modifier.
TO CREATE A MODIFIER...

» Select any parameter that supports a modifier. E
» Press the ENTER button or press the MODIFIER button (Push-knob C) to show the Modifier menu.

» The Modifier Source page will appear. Select a SOURCE to control the
parameter. Learn more about Sources on p. 61.

» Press PAGE RIGHT to switch to the Modify page (you must select a source first!)

» Learn more about Modifier parameters on p. 62. If nothing else, check that MIN and MAX
are set to the lowest and highest values you want to hear as the source changes.

» Press EXIT to leave the modifier menu. You will notice that the dot is now solid.

» Modifiers will animate on-screen knobs, faders switches and graphs. For text-
only menu parameters, a bar graph shows the value of the source.

» You must STORE the preset to save any modifier changes.

TO EDIT OR REMOVE A MODIFIER...

» To edit an existing modifier, use the same process as creating a modifier.
» To remove a modifier, change its SOURCE to “NONE".
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MODIFIER TUTORIAL: WAH PEDAL

Below you will find a basic step-by-step tutorial on setting up the modifier for a Wah pedal.
For this example, let's assume:

= A Wah block is already in your preset.
= You have an Expression pedal ready (see "Expression Pedals” on p. 10).

Here are the steps:
1. On the Layout Grid, NAV to your Wah block and press EDIT to show its menu. @
Page to the Config page of the Wah block’s Edit menu.

Wah
Notice the yellow Modifier dot symbol beneath the on-screen Wah Control parameter. Ssial{fs]

Press ENTER or the MODIFIER Push-knob to show the Modifier menu.

On the Source page, change the SOURCE to your pedal. Depending on how your pedal is connected this
might be “Pedal 1 (Exp/Sw Tip)” (the on-board expression jack of the FM3), or it might be one of the
“External Controllers” (p._67), or it might be one of the “FC” pedal options.

2
3
4. NAV to select that parameter (or just give its knob a twiddle). It will be highlighted (blue) when selected.
5
6

7. Test! The Wah should work when you move the pedal. You'll also see the dot move on the graph. If it
doesn’t work, check your source or make sure the pedal is properly connected and calibrated.

8. Save the preset by pressing STORE, ENTER, ENTER.

The Wah in this example is controlled by an expression pedal. An expression pedal can be used to control other
parameters like whammy control, rotary rate, delay feedback, and many more.

There are also many different sources we could use instead of a pedal. Try an LFO for a modulating auto-wah, or
an Envelope Follower for some funky Mu-Tron action. MIDI opens up a world of controller options.

MODIFIER TIPS AND TRICKS

= The same source can be assigned to multiple modifiers at the same time. For example, one pedal
might adjust Chorus Rate and Chorus Depth at the same time — even in different ways.

= The modifiers for a given block will normally be shared across all of the channels of
that block, but you can also limit a modifier so it applies only to any one channel—
your choice. Change the “Channel” setting inside the Modifier menu to do so.

= Modifiers use a very small amount of CPU power while you use them.
Test any presets which seem close to the edge.

= Any block that can be bypassed also has a Bypass parameter that allows you to assign a modifier.
(The modifier is placed on Bypass and not Bypass Mode as it was on some previous Fractal Audio products.)
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MODIFIER SOURCES OVERVIEW

There are in fact over 60 different choices to use for modifier sources. Learn about them in this overview.

INTERNAL CONTROLLERS LFO 1 LFO 2 ADSR1 | [ADSR2
Internal controllers are built into the FM3. To show the AS N AN /\ . /\ q

Controllers menu, press the CONTROLLERS button on the N
Home page (Push-knob C) or Layout menu (E), or press

the TEMPO button once Sequencer Pitch Envelope Scene Ctrl
The internal controllers can be used as modifier sources 66056480 T = |I 8888
and also have settings of their own which can be saved

with every preset. All of the Internal Controllers (Tempo, LFOs, ADSRs, etc.) are part of a Controllers block. This
block has four channels, so you can have up to four different sets of Controller values in one preset.

You will find one Tempo, two LFOs (Low Frequency Oscillators), two ADSRs (envelope generators), a Sequencer,
an Envelope Follower, a Pitch Follower, five Manual Controllers, four Scene Controllers, and six Control
Switches. See p. 65 for more on internal controllers.

ONBOARD & FC PEDALS & SWITCHES 2

The onboard Pedal jacks of the FM3 and the Pedal or :
Switch jacks of a connected FC series controller can be

assigned directly as modifier sources. In comparison to 1
previous products, it is no longer necessary to assign these

to an External Controller first (though this is still possible).
PEDAL

PEDALS

©

On the FM3, you will find two options per pedal jack: one
for Expression or Switch Tip and another for Switch Ring.

EXTERNAL CONTROLLERS

External controllers are modifier sources with their own custom global assignments to determine what
controls them. External Controllers are a great choice for presets you might share, because different people
will use different controllers in different setups.

For example: you send your band mate a preset containing a Wah
operated by External 1. On your system, External 1 is globally assigned
to “PEDAL 1 (EXP/SW TIP)"— one of the onboard expression jacks.

On your friend's system, External 1 is assigned to “CC#16" because an
older MIDI controller is being used.

The preset works perfectly on both rigs with no changes required!

Ext 1 Ext 2 Ext3 Ext 4

Ext5 Ext 6 Ext 7 Ext 8
The FM3 allows 16 external controllers.

Each one can be operated by to your choice of:

= Any MIDI Control Change (CC#) message.
= One of the onboard Pedal jacks.
= One of the Pedal or Switch jacks of a connected FC controller.

Ext9 | |Ext10| |Ext11] |Ext12

Ext13| |Ext14| |Ext15]| |Ext16

Learn more about External controllers on p. 67.
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MODIFIER PARAMETERS

The default modifier settings are linear. You change the source and the parameter follows in direct relationship.
Modifier parameters allow you to change this relationship. You might tune the taper of a pedal, or make it work in
reverse. Maybe you want the parameter attached to a footswitch to glide instead of snap. Here is an overview of
the additional parameters you can use to create these effects and many more. Find these options on the Modify
page when you set up any modifier.

Min and Max determine the range of parameter change. These are extremely important parameters.

EXAMPLE: The modifier for a pedal controlling Delay Feedback has Min at “10%" and Max at “50%". The
feedback sweeps only from 10% to 50 as the pedal is moved, even though this parameter’s actual range is
from -100% to +100%.

Start, Mid, End, Slope, Scale, and Offset are used to create custom curves which re-map the relationship
between the modifier source and the value of the target parameter. On the Modify page, a graph shows the
relationship between the source (x-axis) and the parameter (y-axis). A dot on the graph tracks the source.

The default settings (first graph below) create a 1:1 linear relationship (the blue line) between source and
parameter. As the source changes, the parameter tracks it directly.

The second two graphs below show examples of the kinds of non-linear curves you can create using Slope, Scale,
and Offset. The pages which follow contain more examples.

Parameter —»

Sourée—»

Attack and Release: These values apply “damping” to slow the rate at which the target parameter value chases
the source. Attack determines the rate of change as the source is increased, and Release controls the rate as it
decreases. At low settings, these add just a little smoothing. Try settings of about 5 ms to “relax” a pedal or to
ease the edges of a square LFO to eliminate clicks and pops. Higher settings can cause sound changes to be
extremely slow and lazy.

Auto-Engage works with Off Value to create effects which turn ON or OFF automatically whenever the source
controller is moved. This is typically used with a Wah pedal so you don't need a toe switch. (Follow the example
on p. 60 and set AUTO-ENGAGE to “SLOW POS" to try it out!) Find additional information on Auto-Engage on p._
64.

PC Reset sets the value of an external source when a preset first loads. This allows you to override the actual
position of an external controller until it is moved or updated. Here's how it works: after applying the modifier,
exit to the parameter again on its Edit page. Notice that the value of that parameter can be edited as usual. If PC
Reset is ON, the value you set and then save will be used from preset load until the source is changed (i.e. the
pedal has been moved).

Update Rate controls how often the modifier is refreshed. The setting of slow is actually very fast, and fine for
the vast majority of applications. The faster settings require additional CPU but provide even smoother sound
performance when ultra fast changes are required (while using a fast LFO for instance). Check this setting if you
think you hear “zipper noise” while a modifier is in use.
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UNDERSTANDING MODIFIER MIN AND MAX

MIN and MAX set the range of a modifier. This lets you fine-tune modifiers in very cool ways. In the example
below, imagine a volume pedal with different settings. Using the principles on this page, you should be able to
achieve a wide range of modifier control scenarios.

Mid: 50.0%  End: 100.0%

- x Max: 10.0
: The pedal “start” (heel position) sets the volume to

. Min: 0.00; silent. The pedal “end” (toe down position)

has the volume at Max: 10 or all the way up.

As you rock the pedal forward, the dot follows the line.

It moves up as it goes and the volume does too.

Here is your basic “vanilla” volume pedal.

Start: 0.0%
‘ Min: 0.0

Max: 10.0

Now, something different: a “boost” pedal with Min set
to 8 and Max still at 10. In the heel position, the volume
will go only as low as 8, instead of 0 as in the previous
example.

Here is a different twist: Min is at 10.0 — the loudest
setting, while Max is at 0.0 — silent.

It looks the same, but this is a reverse volume pedal!

Min: 10.0

USING “MID” TO CREATE BASIC CURVES

Let's imagine a modifier on the feedback of a delay to demonstrate changes to response curves. By now you
should be familiar with the default settings, so let’s skip right to the curved version:

Mid: 25.0% End: 100.0%
\ h Max: 100% As we adjust Mid, the graph shows the curve. At 25%,
5 5 x Max: ° the response is “tapered” so that with the pedal half
| way forward, Feedback is only 25% between Min and
Max.

This type of curve provides gradual control of feedback
: across the lower end of the range, and then a more
v Min: 0% rapid change towards the top.

Start: 0.0%
<€
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ADVANCED MODIFIER CURVES AND SHAPES

You can also adjust Start, End, and Slope (which introduces an “S” or “backwards S” shape). The numbers
beneath each example below show the settings for Start, Mid, End and Slope. With a bit of experimentation, you
will learn to achieve desired modifier effects quickly. Try dialing in the shapes below for practice:

0,75100 50 100,50,0 50 0,100,0 50  0,50,100 0 050,100 100 0,25100 10

Scale and Offset also re-map modifier response. Scale adds vertical exaggeration or compression, while Offset
moves the entire curve up or down on the Y-axis. Segments outside the graph boundaries will be clipped and
replaced by line segments. The examples below show some interesting possible applications.

: : : : 1
5 5 START:  0.0% START:  0.0% START:  47.2%
cereernsseeifflenssnnnnnnns ............. MID: 50% ............. ............. MID: 50% .............. ........... .| mID: 0%
5 5 END:  100% END:  100% END:  60.6%
........................................ SCALE: 2.0 oo | SCALES 0.0 ) Ef..|| SCALE: 10.0
OFFSET: 100% OFFSET: 0% OFFSET: -100%

AUTO-ENGAGE TURNS EFFECTS ON/OFF AUTOMATICALLY

If you have used a Wah pedal with no toe-switch, you will instantly understand the principle of “auto engage.” This
type of Wah turns on automatically when you rock it forward it and then bypasses when you pull it back. That's the
idea behind Auto-Engage.

Auto-Engage engages or bypasses a block when the Source of a modifier changes. Once you try it, we believe you
will quickly find that this capability comfortably eliminates the need for expression pedal “toe” switches.

Set it up using two parameters on the Modify page:

Auto-Engage - Determines whether or not the block will automatically engage or bypass. FAST, MEDIUM and
SLOW settings determine how quickly the effect turns ON/OFF once Auto-Engage is triggered. Use SLOW settings
to “relax” auto-engage, so your effect doesn't switch off too suddenly while you're still using it.

= The three POSITION (“POS") options trigger the effect based on OFF VALUE (see below).

= The three SPEED (“SPD") options engage the effect when the controller is moved quickly.

= Set to “OFF” to disable Auto-Engage.

Off Value - Sets the position threshold that the source must cross for auto-engage to occur. When Off Value is
set below 50%, the effect is bypassed when the controller goes below that value. If Off Value is set to 50% or
higher, the effect is bypassed when the controller goes above that value.

For “heel down = bypassed”, set to 5%. For “toe down = bypassed”, try 95%.

MODIFIERS AND CHANNELS

A modifier is normally shared across all of the channels of the block where it exists. However, you can also limit it
to operating on just a single channel—your choice—using the Channel parameter in the modifier menu.
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INTERNAL CONTROLLERS

Internal Controllers can be programmed per-preset for use as modifier sources. To access these parameters,
push the CONTROLLERS button on the Home page (Push-knob D) or press TEMPO.

9 MODIFIERS

TEMPO Tempo appears in the Controllers menu. For more information, see Section 11: Tempo.

LFO1 + LFO2 LFO
A Low Frequency Oscillator (“LFQ")

generates control signals in the form of a

variety of periodic wave shapes. Examples of LFOs
in use include the pulse of a tremolo, the back and

forth sweep of a phaser, or the random filter in Ship
Ahoy by Frank Zappa.

Type sets the waveform or shape. You can set the
Rate or lock the LFO to the current Tempo. You can
vary the overall Depth and Duty, or symmetry. The
Run parameter starts and stops the LFO. This can be
used to keep it from drifting out of time.

Each LFO outputs “A” and “B” signals, each of which
is an independent modifier source on the list. You
can change the Phase of output B with respect to A.

ADSR

ADSR1 + ADSR2

The two ADSR sources are envelope S
generators with Attack, Decay, Sustain
and Release parameters (thus “ADSR”). The ADSR
is triggered whenever the signal level exceeds its
Threshold measured at the selected input (1 or 2).
The envelope has three self-explanatory modes
(Once, Loop, and Sustain) and can optionally be set
to Retrigger every time the threshold is exceeded.

In comparison to the Envelope Follower, the ADSR
envelope generator always creates the same control
signal, but only triggers when you play hard enough.

PITCH DETECTOR

Pitch
Detector

The Pitch Detector analyzes the pitch of

Quantize changes smooth waveforms into stepped our plaving and outnute  low value for RECHIEN
ones. Try it on the “TRI” waveform for example. your piaying utp .

low notes and a high value for high notes.

SCENE CONTROLLERS ry—
SEQUENCER Sequencer . 5000
The Step-Sequencer generates control 066600 The four Scene Contrpllers provide a way 5000
patterns by looping through 2-32 “stag-  |°°®°°° to change sound settings from one Scene

es.” You set the Value for each stage, the

Number of stages, and the Rate or Tempo. The Run
switch allows you to start or stop the sequence.
Damping slurs the change between steps.

ENVELOPE FOLLOWER
This converts input level to a control signal,

Envelope
Follower

C—1

responding variably to your playing dynam-

ics. The classic example is a touch-wah,

where the frequency of the wah varies based on how
hard you play. You can set Attack and Release times
independently, set the trigger Threshold, and adjust

the Gain at the trigger signal input, which can be set
to Input 1 or Input 2.

to another. Think of each Scene Controller

as a “virtual knob” whose setting can programmed
with a different value in every Scene. By assigning
this knob as a modifier source, you can create “per-
scene” parameters.

For example, you might assign Scene Controller 1 to
Input Drive in the Amp block with a value of 10% in
Scene 1, 50% in Scene 2, 75% in Scene 3, and so on.

As with any source, a scene controller can be
assigned to multiple parameters at the same time,
each with its own modifier settings.

A Scene Controllers tutorial appears on p. 68.
For more on Scenes, see Section 6 on p. 49.

way to copy/paste Controller channels.

65

The Internal Controllers menu offers four channels for four sets of independent settings for ALL of
the items listed above: four tempos per preset, four sequencer settings, etc. When you change the
channel, ALL of the controllers switch to the new channel and the new settings. FM3-Edit provides a
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MANUAL CONTROLLERS

The five Manual Controllers are virtual knobs with no function other than to serve as modifier sources. A Manu-
al controller makes it possible, for instance, to create a “super control” where one knob operates multiple sound
functions at the same time. For example, you might assign delay mix, reverb time and chorus depth parameters
— all at the same time — to the “Manual 1" modifier source. Now, when you adjust Manual 1, all of the above
parameters will change simultaneously as desired.

Another good use for Manual Controllers is to simulate an expression pedal when you do not have one handy.

TUTORIAL: MANUAL CONTROLLERS

In this tutorial, we will set up a Manual Controller to adjust the Feedback and Mix of a delay block. Load the
factory preset “#022 Super Verb.”

1. The first step in using a Manual Controller is to assign it as a Modifier Source to the parameter of your
choice. Enter the Layout grid of the preset, navigate to the Delay block, and press EDIT.

Use the PAGE buttons to locate the Config page of the Delay block.

NAV to the Feedback parameter and notice the open yellow modifier “ring” beneath the knob.

With the Feedback parameter highlighted, press ENTER to display the Modifier menu.

On the Source page, select Manual 1.

Page right to the Modify page. Set Min to 0% and the Max to 50%

Press EXIT to return to the Delay menu. Notice that the open modifier symbol is now a solid yellow dot.

NAV down to the Mix parameter and press press ENTER to display the Modifier menu.

© o N o g bk WD

On the Source page, select Manual 1.

10. Page right to the Modify page. Set Min to 5% and the Max to 75%

11. Now let's try the Manual Controller. Press HOME to show the home page.
12. Press the CONTROLLERS button (Push-knob C).

13. Use the PAGE buttons to locate the Manual page of the Controllers menu.

14. Turn knob A to adjust Manual 1 and listen to your delay settings change. As the knob approaches 100%, the
Delay mix increases (louder echoes) and the Feedback increases (more repeats).

15. Press STORE, ENTER, ENTER to save your work. Not only will all of the modifier settings be saved, but the
position of the Manual knob as well.

CONTROL SWITCHES

The six COntrol Switch sources are used with the onboard footswitches or an FC controller. For more information,
please refer to “The Footswitch Functions Guide” on p. 18.
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METRONOME

A metronome is included for convenience. The Metronome is not technically a controller, but its settings are
accessed through the Tempo page of the Controllers menu. To enable the metronome press the Tempo button
and adjust the level for the desired output(s). Note: the metronome levels persist across presets and are reset to
OFF at power on.

EXTERNAL CONTROLLERS

External Controllers are modifier sources that are in turn controlled themselves via external MIDI or a connected
expression pedal or switch. For example, if the source of a modifier on a Wah effect is set to “External 1" and
External 1 is set to “MIDI CC#16"; a connected MIDI expression pedal transmitting CC#16 then operates the Wah.

The global assignments for External Controllers are set on the External Control page of the MIDI/Remote menu
under SETUP. You can assign a MIDI CC#, an on-board Expression pedal or switch, or a Pedal or Switch on a
connected FC series controller. Choosing an External Controller as the source of your modifier is the same as
assigning any other source (see “To Create a Modifier...” on p. 59). To change which CC# or pedal/switch
operates an External Controller:

1. Open the MIDI/Remote menu in SETUP and page to External Ctrl.

2. Use NAV to select the External Controller you want to change (ex: “External Control 17).
3. Use VALUE to change the assignment. You can also select “NONE" to disable the selected controller.
4. EXIT when finished.

EXTERNAL CONTROLLER INITIAL VALUES

External Controllers assigned to MIDI are given a value of “0” until some MIDI data is received to change them.
You can imagine how a missing or broken MIDI controller might therefore present a big problem...

The External Controller Initial Value parameters can change the startup value for a controller to 100%. Then,
when the FM3 is powered on, any modifiers assigned to the missing controller will be all the way up instead of all
the way down. To change the initial value for an External Controller:

» Page to the General page of the MIDI/Remote menu under SETUP.

» Use NAV to select to whichever controller you want to change (ex: “External Control 1”).
» Use VALUE to change the setting.

» EXIT when finished.

MODIFIERS LIST

The last page of the Controllers menu lists all of the modifiers in the current preset. You can jump to edit each
modifier from this list by pressing ENTER.

As you'll gather from looking at the list, the maximum number of modifiers per preset is 24.
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TUTORIAL: SCENE CONTROLLERS

In this tutorial, we will set up a Scene Controller to adjust the Input Drive of an Amp block. While it is easy enough
to achieve different amp sounds within a preset simply by switching the channel, this example provides an
excellent and easy way to understand how Scene Controllers work.

We will begin with the Wrecker Rocket preset (#030), though any preset with an amp block could be used. For this
example, we chose an amp model where the Drive parameter setting will be more pronounced, and no pre-existing
scenes are set up.

1.
2.

N o gk~ w

10.
11.

12.

13.

14.

15.
16.

17.
18.
19.

20.

Load the factory preset “#030 Wrecker Rocket.”

The first step in using a Scene Controller is to assign it as a Modifier Source to the parameter of your choice.
Enter the Layout grid of the preset, navigate to the Amp block, and press EDIT.

Use the PAGE buttons to locate the Tone page of the Amp block.

NAV to the Input Drive parameter and notice the open yellow modifier “ring” beneath the knob.
With the Input Drive parameter highlighted, press ENTER to display the Modifier menu.

On the Source page, use the NAV buttons to select Scene Controller 1.

For this tutorial, you don’t need any custom settings on the Modify page, so press EXIT to return to the Amp
menu. Notice that the open yellow modifier symbol is now a solid yellow dot.

Now let's set the values for our Scene Controller; press HOME to show the home page.
Press the CONTROLLERS button (Push-knob E).
Use the PAGE buttons to locate the Scene Ctrl page of the Controllers menu.

Reading down, the Controller 1 column shows eight different values. These will set the value for our target
parameter in each of the eight scenes. You can dial in these values now...

...but it’s better if you change scenes as we dial thing in! Press the MORE 1 of 2 button (Push-knob E) to
reveal the Scene +/- and Channel +/- push functions.

Notice the that the current scene is shown above the table at the top of the page. If this isn’t “Scene 1", use
the Scene +/- buttons to select select Scene 1 now.

Dial in the Scene Controller 1 value for Scene 1. Let's set it to about 20% for a “cleanish breakup” type of
sound. Use your ears!

Use the Scene + button (Push-knob B) to switch to Scene 2.

NAV Down to select the Scene 2 row in the Controller 1 column. Dial in the Scene Controller 1 value for
Scene 2. Let's set it to about 45% for more crunch. Again, use your ears.

Using the process in the previous step, set the value for Scene 3 to 75% and Scene 4 to 100% (or as desired).
Press HOME to return to the Home page. Test your first four scenes using the NAV UP/DOWN buttons.

Press STORE, ENTER, ENTER to save your work. If desired, enter Scene Names as outlined in “Saving
Changes” on p. 47.

Feel free to assign other Scene Controllers to other parameters in your preset as desired.

TIP: Most poeple find that FM3-Edit makes this process even easier, with all scenes and scene controller changes
just one or two mouse clicks away. Find the Scene Controllers in FM3-Edit under the “CONTROLLERS” section
below the main FM3-Edit logo.
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10 LAYOUTS & SWITCHES

Footswitch operation on the FM3 is organized around Layouts. A layout is a set of up to 12 footswitch definitions,
each with one Tap and one Hold function. You can change layouts on the fly to change what each of the
footswitches does. For example, one layout might be used to select Presets or Scenes, while a different layout
operates the Looper. The FM3 provides eight layouts, and any switch can be completely customized to your
choice of functions, colors, and more. Layouts even have their own names to make navigating easier.

While not performing, you can easily change the layout on the FM3 itself by turning the FC Layout knob on the
Home page.

THE MASTER LAYOUT MENU

Switching from one layout to another is the key to the versatility of the FM3. There are many ways to do this,
but the built-in Master Layout Menu (“MLM" for short) is very powerful. The Master Layout Menu grants instant
access to other layouts, one per footswitch.

To show the Master Layout Menu, press and hold the middle footswitch from any of the factory layouts.

For an introduction, see “The Master Layout Menu” on p. 8.
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TAP & HOLD FUNCTIONS

Every switch in every layout can be programmed with individual TAP and/or HOLD functions.

Tap functions — used throughout history for guitar effects and beyond — are best for changes that require tight
timing. For example, a tap switch set to SELECT SCENE is ideal to change the sound precisely as a solo begins.

Hold functions on the other hand, require a “long press” and are fired after a brief delay, so their timing is less
precise. Hold switches are perfect for functions like opening the Tuner, or accessing an alternate layout such as
Looper Control.

THE RULES OF SWITCH TIMING

Like every guitar product in history with “hold” footswitches, the FM3 must follow rules for timing so it “knows”
whether you are trying to activate the Tap or the Hold. A switch with a Hold function must wait until it can
determine which one you are trying to activate. When this is the case, the tap is activated when the switch is
released instead of when it is depressed—unless you continue holding the switch past the “Press and Hold
Timeout” window. The following illustrations help explain switch firing and timing:

TIMING FOR A TAP FUNCTION TIMING FOR A TAP FUNCTION TIMING FOR ANY
WITH NO HOLD FUNCTION WITH A HOLD FUNCTION HOLD FUNCTION
Press and Hold Timeout Press and Hold Timeout
(0.50 seconds by default) (0.50 seconds by default)
- A
v VA % A
The Tap function fires at the The Tap function fires when When you hold a switch, its HOLD
moment the footswitch is you release the switch, as long function activates at the moment
depressed. as this happens before the the Press and Hold Timeout runs
Press and Hold Timeout. out—whether or not the switch has
If not, the Hold function aTap ilrj]nc{flon]; Thl? doizs PO’[ cause
eventually fires... € 1ap function to fire.

If you need tight timing from a Tap switch that has a Hold function, tap and release very quickly—even
a fraction of a second early, knowing that the change will occur as your foot comes up.

You can change the duration of the Press and Hold Timeout on the Config page of the FC Controllers/
Onboard Switches menu under Setup. The default is 0.5 seconds. Make it longer if you find that you
are activating Hold functions when you mean to activate Tap functions. Make it shorter to fire Hold
functions sooner.

You can even have the hold function wait to fire until you release the switch, making it possible to
have direct and perfect control over hold function timing.
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FACTORY DEFAULT LAYOUTS

Factory default settings for the FM3 include various pre-defined layouts: one for selecting presets, one for
changing scenes, one for the looper, and so on. These are illustrated on the following page.

The Factory default layouts are designed to be very simple. The idea was that they should require almost no
explanation, so someone using the FM3 for the first time could easily understand its capabilities. In fact there is
no such thing as an ideal layout—no “one-size-fits-all” solution. Those who desire to make changes will find it is
very easy to change any switch on any layout to perform any function. See the new Footswitch Functions Guide
for a complete reference covering all available functions.

RESETTING THE FACTORY LAYOUTS

The FM3 includes a utility to reset the FM3 Factory Layouts. You can do this any time you want to erase any and
all changes you've made to the layouts, whether because you get stuck or simply want a fresh start. To do this:

» Open SETUP: FC Controllers/Onboard Switches
» Page to the RESET page

» Select the desired option (future firmware versions may allow more than one
choice) and press ENTER to Load FM3 Factory Default Layouts.

» Press ENTER again to confirm.
» Press HOME to exit.

WARNING! When you perform Reset System Parameters under SETUP: Utilities, this clears all of
the layouts too. See p. 99 for more on this.
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FM3 FACTORY LAYOUTS

1: PRESETS
( TAP:P1 I TAP:P2 I TAP:P3 J
Hotp: Bank-1)  Howo:mm | wow: Bank+1
2:SCENES
( aP:S1 I TAP:S2 I 7aP:S3 J
Hop: View -1)  Hotb:MM  fHouo: View +1

Three Views cycle through the remaining scenes: [4,5,6] then [7,8]
The unused switch contains a TUNER.

3:EFFECTS

ap:Drive 1 | 7ar: Delay 1 | 1ap: Reverb 1
Hotp: View -1]  Howb: MM JHowo: View +1

Four Views cycle through three effects each:

[Chorus 1, Flanger 1, Rotary 1] [Pitch 1, MultiDly 1, Plex 1] [Comp1, Phaser 1, TremPan1]

4:CHANNELS
.
7AP:AMP 1A | 7ap:AMP 1B | 7ap:AMP 1C
Hoto: View -1} Howo:miv - AHovo: View +1
The Views cycle through channel switches for four different effects:
Amp 1, Drive 1, Drive 2, Delay 1

5:LOOPER

ap:Record Yar:Play/Stop] tar:Undo
HoLo: View -1]  Howp:mim  JHowo: View +1

A second View contains tap functions: ONCE, REVERSE, and HALF SPEED.

6:PER PRESET

7ap:PP1Tap | tar:PP2Tap | tar.PP3Tap
Hop: View -1]  Hotp:mm — JHowo: View +1

Four Views cycle through 12 total Per-Preset Tap “Placeholder” functions.

Per-Preset Hold functions are not supported in this layout.

7:PERFORM
(] nr)

8:UTILITIES
ERENES

Layout 1: Presets is designed for switching presets. It shows
three presets at once, with press and hold functions for BANK
UP and BANK DOWN on the left and right switches.

Hold the middle switch for the Master Layout Menu (MLM).

Layout 2: Scenes shows scenes 1, 2, 3, with hold functions
on the left and right switches to change the “View” to show
scenes 4, 5,6 or 7, 8, and Tuner.

Hold the middle switch for the Master Layout Menu.

Layout 3: Effects is used to engage or bypass effects. The
defaults are Drive 1, Delay 1, Reverb 1, with hold functions on
the left and right switches changing the View to reveal other
effects as shown.

Hold the middle switch for the Master Layout Menu.

Layout 4: Channels is used to change the channel on
designated blocks. The default is AMP 1 (A, B, C) with hold
functions on the left and right switches changing the View to
reveal other effects as shown.

Hold the middle switch for the Master Layout Menu.

Layout 5: Looper offers essential Looper controls.
Hold the middle switch for the Master Layout Menu.

Layout 6: Per-Preset shows the first three per-preset switches
(“placeholders”) with hold functions on the left and right
switches changing the View to reveal a total of 12 per-preset
switches. You will need to add per-preset switch definitions
(see p. 79) for this layout to work. The first few factory
presets include some of these as examples.

Hold the middle switch for the Master Layout Menu.

Layout 7 is an example to accompany a short tutorial. It
represents one possible idea for a simple FM3 performance
layout. There is no switch in this layout to return to the MLM,
though you can easily add one yourself or use the front panel
“E" knob.

Layout 8 contains utilities: Tap Tempo and Tuner.
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EASY (“EZ") EDITS

The FM3 makes it simple to change any footswitch in any layout to perform any function.
The easiest way to do this is with the “EZ” Switch edit page as described below.

IMPORTANT: To avoid annoying screen jumps and sonic mishaps, all footswitches are DISABLED
while you are on the EZ page. To test switch edits, change to a different menu page or press EXIT.
TO USE THE EZ EDIT PAGE:

» Onthe FM3, open SETUP: FC Controllers/Onboard Switches and
page to the “EZ" tab if it isn't already selected.

» Press the footswitch you want to edit.

» An onscreen graphic shows which footswitch you have selected.

FC Controllers EZ

Tap any footswitch to see its settings below.

Layout 1: PRESETS
Switch Ring Color Default

Category Preset
Function Select by #
Preset 1
Mini-Display Label Name

Category Unassigned
Function 5

C Nav Value
RESET SWITCH | COPY SWITCH | PASTE SWITCH

» You can edit both TAP and HOLD functions for any switch.
» Use the A knob or NAV buttons to navigate the list and C or VALUE knobs to make changes.

= Set the desired Category and the Function.

= Set any parameters for the selected Function as desired. For example, when you select Category: Preset
and Function: Select by #, a “Preset” parameter appears to let you dial in the desired preset number.

= You can also customize the ring color for an individual switch, overriding the defaults which are assigned
to the switch Category.

» You can also select from different automatic “labels” for the Mini-Display, or even enter custom text.
» The EZ page also provides buttons to RESET (Clear with confirmation), and COPY/PASTE switches.

» Press another footswitch to move on, or press EXIT when you are finished.

&= Reminder: All changes in the FC Controllers/Onboard Switches menu take effect with no need to store.

For more information, please see “The Footswitch Functions Guide”.

13
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LAYOUT VIEWS

On an FC-12 controller, all 12 switch definitions of any layout are shown one-to-one across the 12 footswitches.
On an FC-6 controller, only the first six are normally shown. On the FM3, only three.

Rather than being wasted, however, the inaccessible switch definitions can be put to use by changing the layout
view. If we think of the FM3 as a window just large enough to show three switches, changing the view moves this
window to show a different set. This concept is illustrated below.

Several of the default layouts — including the Master Layout Menu — use this new feature. For example, when you
press and hold the left or right footswitches in the Scenes layout, a different set of scenes is offered across the
switches of the FM3. In the Effects layout, the same press and hold feature on the outer two switches is used to
change which three effects are controlled by the footswitches.

Here, a layout is loaded and the FM3 shows switches 1, 2, and 3 from that layout.

6 0 9
-

(Switch 1 ISwitch 2 ISwitch 3 ) l l | | | |

“View 1"

Let's say this layout has a “View +1” assigned to press and hold on the right switch...

8 0 O Now the view has been changed and the
l - - J FM3 shows switches 4, 5, and 6.

v

(SWitch 4ISwitch SISwitch 6) | | |
| “View 2" |

Some of the factory default layouts (p. 71) use two hold Ij Ij 'j Here, View 3 shows switches
functions to allow changing the view i either direction. - : \ ) 7.8,and9.

| | | | (Switclh 7Ismu::h BISwitch 9) | |
| “View 3" |

0 9 O

Here, view 4 shows switches 10,11,and 12. |~ ")

v

| | l I | | (Switch 1OISwitch 11ISwitch 12)
| “View 4" |

@ See “The Footswitch Functions Guide” for more information on Views.
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THE LAYOUTS LIST

EZ editing is (you guessed it...) easy, but the FM3 also provides a deeper way to manually edit layouts and
switches. The Edit Layout page of the Foot Controllers menu provides an overview of 12 switches, and also
allows deep editing of individual footswitches, with all of the settings from EZ page and more.

On the FM3, open the Setup: Foot Controllers and page to the “Layouts” tab.
» Use the A knob or NAV buttons to select the desired layout.

FC Controllers Layouts
LAYOUT NAME

Layout 1 PRESETS
Layout 2 SCENES
Layout 3 EFFECTS
Layout 4 CHANNELS
Layout 5 LOOPER
Layout 6 PER-PRESET

Layout 7 PERFORM 1
Layout 8 PERFORM 2
Layout 9 MasterlLayout

C Nav
RESET ALL EDIT LAYOUT EDIT NAME COPY LAYOUT | PASTE LAYOUT

» The push-knobs offer additional functions:
= RESET ALL sets all functions for all switches in all layouts to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)
= EDIT NAME allows you to rename the layout (see “Naming Layouts” on p. 77).
= COPY LAYOUT and PASTE LAYOUT provide a means to replicate a layout to a new location.

» Select any layout and press ENTER or the EDIT LAYOUT button (push-
knob B) to open that layout for deeper editing.

Number 9... As you review or edit layouts, you may notice “Layout 9" in the list.
@ Layout 9 is in fact the Master Layout Menu used to access other layouts (see p. 69).
Do not edit this layout unless you understand what it is, what you're changing, and how it works.
If you modify the Master Layout Menu — intentionally or otherwise — you can easily reset it to factory default

settings without resetting anything else. Just use the “RESET LAYOUT” button on the Edit Layout page
(see p. 76). Unlike all other layouts, #9 reverts to factory settings instead of being completely cleared.

As you get deeper in to the FM3, you may find the ability to modify the MLM quite useful, with options like “Layout
Link” or the ability to add functions instead of unused menus.
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EDIT A LAYOUT

Select any layout on the Layouts page (p. 75) and press EDIT LAYOUT
or ENTER to open the selected layout for deeper editing.

The Edit Layout view has two pages: one for the Tap function and one for the Hold function. Each shows the
Category and the Function for all 12 switches, plus values for the first two parameters of the current function.

» UsetheA, B, C,D, and E knobs, or the NAV buttons and VALUE knob to make changes.

Notice the Tap and Hold pages

Edit Layout 1: PRESETS Tap
CATEGORY FUNCTION VALUE 1 VALUE 2

1Tap Preset Select in Bank 1
2 Tap Preset Select in Bank 2
3 Tap Preset Select in Bank

4 Tap Unassigned

S Tap Unassigned

6 Tap Unassigned

7 Tap Unassigned

8 Tap Unassigned

9 Tap Unassigned

10 Tap Unassigned

11 Tap Unassigned

12 Tap Unassigned

C Nav Category Function Value 1 Value 1
RESET LAYOUT | | EDIT SWITCH | |RESET SWITCH, | COPY SWITCH | | PASTE SWITCH

» The push-knobs offer additional functions:
= RESET LAYOUT sets all switches in the current layout to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)
= EDIT SWITCH opens a single switch for deeper editing.
= COPY LAYOUT and PASTE LAYOUT provide a means to replicate a layout to a new location.

» Select any switch and press ENTER or the EDIT SWITCH button (push-
knob B) to open that switch for deeper editing.

& On the FM3, the middle switch in every layout has its Hold function assigned to the Master Layout Menu.
It is certainly possible that you won't need this, but think carefully before changing it.

@ See “The Footswitch Functions Guide” for information on all categories, functions, and parameters.
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NAMING LAYOUTS

Layout Names appear in the Master Layout Menu and can also appear on dedicated Layout footswitches.
Changing the name of any layout is simple with the same interface used to name presets and scenes.

NAME A LAYOUT:
» Onthe FM3, open the “Layouts” page of the FC Controllers/Onboard Switches menu under SETUP.

» Use the A knob or NAV buttons to select the desired layout.
» Push the EDIT NAME button (push-knob C).
» Enter the desired name, up to ten characters:

= Turn the B knob or use NAV buttons to move the cursor.

= The C knob selects upper case letters.

= The D knob selects lower case letters.

= The E knob selects numbers.

= The VALUE knob selects ALL characters, including symbols.
= Press D or E for INSERT and DELETE functions.

= Press ENTER to commit the name or EXIT to cancel.

&= Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

STARTUP LAYOUTS

The FM3 itself and each connected FC Controller have their own default layout which load automatically when you
power on. You can change the default layout as follows.

SET DEFAULT LAYOUTS:
» Onthe FM3, open the “Devices” page of the FC Controllers/Onboard Switches menu under SETUP.
» Use the C knob or NAV buttons and VALUE wheel to set the desired Default Layout.

» You can also manually change the Current Layout and Current View (p. 74)
for both the FM3 itself and any connected FC controllers.

The Devices page also allows you to set up Mirroring the FM3 to an FC controller.

See the FC Controller Owner’s Manual for more on mirroring.

BACKING UP LAYOUTS

FM3 layouts are included in any backup of the unit's system (p._100),
but you can also back up or restore these individually or all at once
using FM3-Edit (p._13). Find these options in the Edit dropdown of
the Layouts section of the “FC Controllers” area. (shown at right).

LAYOUTS




10 LAYOUTS & SWITCHES

EDIT A SWITCH

Select any switch on the Edit Layout page (see p. 76) and press
EDIT SWITCH or ENTER to open the selected switch for deeper editing.

The Edit Switch view has two pages: one for its Tap function and one for its Hold function.
Each page shows the current Category and the Function for the switch, plus any and all parameters for the
current function.

» UsetheA, B, C,D, and E knobs or the NAV buttons and VALUE wheel to make changes.

» On the Tap page, you can also change the Switch Ring Color for an
individual switch, overriding the usual default Category color.

» You can also select from different automatic “labels” for the Mini-Display, or even enter custom text.
Details on the various label options can be found in “The Footswitch Functions Guide”

Notice the Tap and Hold pages

Edit Layout 5: PRESETS / Switch 5

Category Preset
Function Select in Bank
Preset S
Mini-Display Label Name

Switch Ring Color Default

FC#1
FC#2
FC#3
FC#4

RESET TAP

» The LAYOUT LINK parameters allow the Tap or Hold function of the switch to also change the Layout on the
FM3 and up to two connected FC units. See "The Footswitch Functions Guide” for more on Layout Links.

» The RESET button (Push-knob A) clears the function and all customization from the current page.
(A confirmation screen requires you to press ENTER first.)

A NOTE ON PRESS & HOLD LABELS IN THE MINI DISPLAYS

The Mini-Display for each switch normally shows the label for the Tap function. When a switch is pressed down —
even briefly for a normal “tap” — it changes to show the label of the Hold function, even if you don't keep holding
the switch down until its Hold function fires.

A special “Reveal Hold" utility switch can also cause all mini-displays to persistently show the Hold functions for
their switches. See "The Footswitch Functions Guide” for more on this.
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PER-PRESET SWITCHES

The current lineup of Fractal Audio products support two ways of doing Per-Preset footswitches.

Placeholder switches, like those in FM3 factory layout 6, look through the current preset and automatically place
its custom switch definitions on the floor. For example, the first switch in Layout 6 will always show the first Per-
Preset switch definition (“PP#1") from the current preset.

Overrides happen when a preset takes over one of the switches on a connected controller, effectively clobbering
whatever global definition you have given a switch and instead showing the override instead. For example, a given
preset may be set to force Layout 1, Switch 1 to show “Tap Tempo” instead of its normal function.

Learn more about Per-Preset Switches in the Footswitch Functions Guide available on our web site:

https://www.fractalaudio.com/fas-ffg

Here is a quick introduction covering how to create the definitions used with Per-Preset switches.

CREATING PER-PRESET SWITCH DEFINITIONS

1. Load the desired preset and navigate to its list of per-preset switch footswitch definitions as follows:

= Press HOME, then use Push-knob D to open the FC Per-Preset menu.
= Page to the Per-Preset FC tab if it isn't already selected.

2. Turn the VALUE knob to select your choice of per-preset switch definition “slots” (numbered “PP# 1-24.).
The first twelve per-preset definitions are used by FM3 layout 6.

3. Define the switch. The interface is basically identical to that used by the “EZ” footswitch page.
= You can set Tap Function, Hold Function, LED ring color, Mini-Display settings, and Layout Links.

4. Repeat this process for any other switches you wish to define.

5. Press Home when finished.


https://www.fractalaudio.com/fas-ffg
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STAND-IN SWITCHES

This section requires you to have one or more external switches. These can be connected directly to the FM3
(see p. 12) or to an FC Controller (see your FC Owner’s Manual).

Without the Stand-In Switch feature, the capabilities of an external switch are more limited than the onboard
switches of the FM3. Modifiers and global functions, for instance don’t have any press-and-hold capabilities, and
they can't, for instance, change a BANK, switch a layout, or show the tuner.

To make external switches more powerful, we created Stand-In Switches. This feature allows a connected
external switch to operate like a remote control for any switch that you have already programmed in a layout on
your FM3.

For example, you might normally have Layout 3, Switch 12 set to bypass/engage the Trem Pan 1 block on tap,
and toggle the block’s channel from A to B on hold. When you set up an external switch Stand-In for Layout 3,
Switch 12, it now performs these functions. This even allows an external switch to perform per-preset functions
as described on the previous page. Be aware that the stand-in is just a pointer. If you change the switch it is
remote controlling, its function will change too.

TO CREATE A STAND-IN SWITCH:

From the Home page, open SETUP: FC Controllers/Onboard Switches
Page to the Stand-In Switches tab.

Navigate up or down to the switch you want to set up. For example, “FM3 SW2 Tip”
Select the desired Layout and Switch using the B and C or Value knobs.
Set up any other Stand-In Switches and press Home when finished.

o gk wDd =

Test your switch.



10 LAYOUTS & SWITCHES

USING THE FM3 WITH AN FC CONTROLLER

The FM3 has a FASLINK port to connect a Fractal Audio FC-6 or FC-12. Using an FC controller expands the
number of footswitches to increase your options on the floor — including jacks for 4 additional expression pedals
and 4 external switches per FC. No special configuration is required; simply connect the FC to the FM3 and it
begins working.

Up to two FC controllers can also be daisy chained from the FM3, increasing the total maximum number of
simultaneous footswitches to 27!

Remember that when daisy-chaining, the second FC Controller will require an AC adapter. It is not powered by the
FASLINK “thru” connector on the first FC Controller.

When adding an FC, you will need to customize all FM3 layouts, which have been designed around three
footswitches. The usual way to do this will be to have some layouts dedicated to the FM3 and others dedicated to
the FC-6 or FC-12.

The Layout Link feature becomes especially important in this type of setup, since it allows one foot controller to
change the layout on another controller. See “The Footswitch Functions Guide” for more on this feature.

Similarly, Layout Views (p. 74) can help you get the most from each layout, especially in combination with
Layout Links.

An additional benefit
of using the FM3 with
an FC Controller is
that each attached
controller supports
an additional four
expression pedals
and four external
switches!
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FM3 FOOTSWITCH FAQ

As mentioned many times thoughout this manual, the “The Footswitch Functions Guide” covers everything there
is to know about the many categories and functions that can be assign to Tap or Hold on any switch.

Here is a quick summary of common questions.

Q:
A:

Q

Q

What do the LED rings show for EFFECT footswitches?

The LED Rings show up-to-the-moment information about the assigned effect. If the ring is DIM, the effect
is OFF. If the ring is BRIGHT, the effect is ON. If the ring is completely OFF, then the assigned effect is NOT
AVAILABLE in the current preset.

TIP: One of the most common uses for “Per Preset Footswitches” is to override an
unused effect switch with one for an effect that is used in that preset.

How do | assign presets to footswitches?

This can be done using the PRESET: SELECT function, but this approach is really only appropriate if you use
very few presets in total. Instead, BANKS make it easy to get to get to many presets using few switches.

In fact, the preset Footswitches in the default FM3 layouts use the function “PRESET: SELECT IN BANK".
Banks show presets in the order in which they are located on the FM3. It is easy to re-order presets

using the Manage Presets area of FM3-Edit, where you can copy/paste or use drag-and-drop to swap

preset locations. TIP: While using this tool, turn on the “FC Banks” option at the top of the manager

so you can easily see which presets will map to which footswitches. Press “Save” when finished.

The FM3 includes many empty preset memories, providing room for you to store additional creations. Why
do the preset and bank switches of layout 1 allow me to enter these “Emtpy” preset banks areas of the FM3?

The two press and hold BANK function switches in Layout 1 have options for Upper Limit and Lower Limit.
By default, these step through ALL of the preset memory locations on the FM3. In some cases, you may want
to set these differently. Remember that these limits show BANK numbers and not preset numbers, so you'll
need to do a little mental math. To limit your FM3 to presets in 000-383, set the “Upper Limit" of both bank
switches to “127". (384 presets + 3 presets per bank = 127 banks).

If you want to use only, say, 15 gigging presets, you might set these limits to 5. (15 + 3 = 5).

Help! I can no longer press and hold the middle switch to get to the Master Layout Menu!

Don't panic. You may have accidentally changed this function, and it is easy to re-assign if you know which
switch is misbehaving. The middle switch of almost every Factory layout has its hold function set to Layout:
Select: 9, View 1. (Layout 9, as you may recall, is the Master Layout Menu.) If you changed a switch and want
to set it back, open EZ Edit (p. 73 ), tap the desired switch, then navigate down and set its Hold function

back to Category: Layout, Function: Select, Layout:9, View:1.

FM3-Edit makes this even easier. Use the “FC Controllers” area to make these changes.

A more “Brute Force” way of doing this would be to reset the factory layouts (See p. 73 ).

A: Can | back up, share, or restore my Footswitch Layouts?

A: Yes. Perhaps the most common way to back up is to receive a backup of your SYSTEM using Fractal-

Bot (p._13). The system file contains all of the layouts and FC settings. Another way is to use
FM3-Edit, which includes options to export or import one or all of your layouts. Find these choices
in the Edit menu dropdown located in the LAYOUTS panel of the FC Controllers area of FM3-Edit.
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Tempo is used in electronic music for synchronizing different rates and times, whether inside one machine or
across several. Tempo on the FM3 allows for both internal and external synchronization, providing effects with
a central BPM clock that can stand alone or follow MIDI Beat Clock from a connected device. The FM3 does not
transmit MIDI Clock itself. The Tempo can be set to any whole number value in the range 20-250 BPM. The FM3
flashes its current tempo on a front-panel LED.

THE GLOBAL TEMPO

The Global Tempo value is a system setting outside of any presets, scenes or channels.
You can change it in any of several ways:

1. Tap two or more times on the front panel TEMPO button.
NOTE: By default, the tempo averages across ten taps, but you can set it to use only two taps with an option
found under SETUP: Global: Config: Tap Tempo.

Tap an onboard or FC footswitch assigned to the Utility: Tempo function.
Tap the TEMPO button once and use the Tempo knob (B).
Use an external MIDI device to transmit MIDI Clock to the MIDI IN port of the FM3.

o &~ N

Use a MIDI CC# or external switch assigned to Tempo Tap, located on the Other page of the MIDI/Remote
menu under SETUP. (See NOTE under #1 above).

Be aware that whenever you change the Global Tempo, you are also changing the current Preset Tempo, which will
be saved if you store the current preset (see below). Be on guard not to over-write saved tempos.

PRESET TEMPO

By default, a given preset will ignore the Global Tempo and use its own saved Preset Tempo instead. Notice that a
preset's Tempo page contains two parameters: one is an actual Tempo (BPM) value, and the other is a setting called
Tempo To Use, which determines what will happen when that preset is loaded.

When you load a preset whose Tempo To Use is “PRESET,” the saved Preset Tempo takes over: the tempo LED

flashes accordingly and all tempo-dependent time/rate parameters are re-calculated. In fact the Global Tempo
has not changed; it remains in the background and will be used when you load a different preset with Tempo to
Use set to “GLOBAL".

Be aware that whenever you alter a preset's own Tempo, you are also updating the Global Tempo.

Remember that each of the four channels of the Controllers menu has its own settings for both Tempo (BPM) and
Tempo to Use. You can use this to have some Scenes or Channels change the tempo while others do not.

TO SET “TEMPO TO USE”"...
1. Load the preset.
2. Tap once on the TEMPO button.
3. Change TEMPO TO USE as desired to either “GLOBAL" or “PRESET".
4. STORE the preset.
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SYNCHRONIZING SOUND PARAMETERS

Rates and times in a preset can be set to sync rhythmically to the Tempo by setting their corresponding Tempo
parameters. This is done by selecting from a list of values, ranging from 1/64-note-triplets to double whole notes,
with 76+ options in all. For example, to set the Time of a Delay block to follow the quarter note pulse of the
tempo, find the Tempo parameter on the Config page of the Delay block’s Edit menu and set this value to “1/4.”

The moment you assign a value for Tempo (other than “NONE”), its associated rate or time parameter is
overridden and may not be changed manually — as indicated by its appearance in parentheses. To regain control
of an overridden parameter, set its corresponding Tempo parameter back to “NONE".

Almost every LFO rate and delay time parameter on the FM3 can be synced to the tempo.

TO SYNCHRONIZE A DELAY TO THE TEMPO...

» Navigate to any type of Delay block and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it to “1/4". Feel free to choose/explore
other options. “1/8th dot” is also very useful and popular.

» STORE the preset.

Remember that once a Tempo has been set, you will be unable to adjust Time manually or with a Modifier.

TO SYNCHRONIZE A TREMOLO OR OTHER RATE TO THE TEMPO...

» Navigate to the effect and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it as desired. A typical value here might be
“1/8th" or “1/16th". Feel free to choose/explore other options.

» STORE the preset.
Remember that once a Tempo has been set, you will be unable to adjust Rate manually or with a Modifier.

Note that syncing an LFO to the tempo does not align the phase of that LFO to the Tempo LED, to MIDI song
position pointer, or to other synchronized LFOs. You can synchronize various LFOs together by setting their RATE
knobs fully counterclockwise to “LFO1 SYNC" and then syncing the LFO1 Controller to the Tempo (p. 65).
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The FM3 has a built-in Tuner, an essential tool for the performing or recording musician. The tuner is easy to use
and has high-resolution automatic pitch detection, a calibration control, offsets for modified tuning schemes, and
the option to mute audio while tuning. Find the Tuner on the Home page by pressing TUNER (Push-knob A) or by
pressing and holding the front panel TEMPO button.

The tuner features a note name display, a “zero-center” meter, a spinning “strobe” type display and triangular
indicators for sharp and flat.

ADVANCED TUNER FUNCTIONS

The actual tuner is on the Tune page of the Tuner menu.
The Config and Offsets pages provide options for advanced tuner functions.

Configuration Parameters

OFF/INPUT/OUTPUT

PARAMETER Description.
Source Selects which physical input the tuner should listen at.
Mute Determines how the tuner mute function works.

= OFF: No mute. All signal is passed as usual when the tuner is engaged.
= QUTPUT: The signal is muted at the output. Tails are silenced.
= INPUT: The signal is muted at the noise gate. Tails ring out.

Display Mode

MIXED/ALL FLATS/
ALL SHARPS

Determines whether the tuner shows note names for accidentals as Sharps, Flats, or a
mix of both.

Calibration
430.0 - 450.0 Hz

Calibrates the tuner by setting the frequency of A4 (in the octave above middle C).
The tuner defaults to A440.

Downtune

0 - 4 Semitones

The Downtune control allows for simplified tuning when tuning down one to four
semitones. The Tuner display will read the non-downtuned equivalent note, i.e. if tuning
down two semitones, the D will still show E. While Downtune is set to any value other
than None, any blocks that utilize pitch information will also be transposed accordingly.

Use Offsets Determines whether the Offset settings (see below) are applied or ignored.
OFF/ON

OFFSET PARAMETERS
PARAMETER Description
E1, B2, G3, D4, A5, E6 | Offsets allow the tuner to be calibrated so individual notes diverge from standard
+/-25.00 Cts concert tuning by a defined amount. Use this for example for Buzz Feiten tuning.
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MINI TUNERS » —=

For convenience, mini-tuners appear throughout the FM3. These consist of two green triangles to indicate when a
note is flat (left lit), sharp (right lit) or in tune (both lit).
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Open the menu by pressing the SETUP button (Push-knob E) on the Home page. The current Firmware Version
is shown at the top of the page. To enter a menu, select it with NAV and press ENTER. All changes take effect
immediately without needing to be stored. The settings for Setup parameters are included in a backup of the

System (see "Backing Up & Restorin

"onp. 100)

&= Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

FC CONTROLLERS/ONBOARD SWITCHES MENU

Most of the pages and functions of the FC Controller menu are detailed elsewhere in this manual:

FC: EZ PAGE
"Easy (“EZ") Edits" on p. 73

FC: DEVICES PAGE

"Startup Layouts" on p. 77

FC: RING COLORS PAGE

'Footswitches" on p. 9

FC: STAND-IN SWITCHES PAGE

See also "Mirroring” in the FC Controllers manual.

FC: LAYOUTS PAGE

"Edit a Layout" on p. 76

FC: CONTROL SWITCH MIDI

See "The Footswitch Functions Guide"

FC CONTROLLERS: CONFIG PAGE

PARAMETER

Description

Hold Function Timeout
0.25-2.00 seconds

Hold Function Mode

AUTOMATIC,
SWITCH UP

FC Master Layout Menu
“Switch Combo”
ENABLED/DISABLED

Per-Preset Switch Overrides
ENABLED/DISABLED

This sets the time limit before a Hold function is automatically fired, beginning
from the moment the switch is depressed. When a Hold function is assigned,

a Tap function fires if the switch is released before the press and hold timeout
elapses. See also "The Rules of Switch Timing" on p. 70.

Normally, Hold functions fire automatically after a timeout (above). With this
setting changed from AUTOMATIC to SWITCH UP, they wait for the switch to be
released, granting precise control over the timing of a hold function. Now, you
can use HOLD, for example, to change a Scene precisely on the downbeat.

The Master Layout Menu (aka “MLM”", aka “Layout 9”) provides access to other
layouts. On the FM3, the MLM is normally assigned to the Hold function the
middle switch. However, a connected FC Controller will have a special "Switch
Combination" that can be used to show the MLM. This setting disables or
enables the switch combination. See your FC Owner's Manual for more.

Any FM3 preset can override the function of any footswitch in any layout. This
offers extreme flexibility, making it possible to handle exceptions easily in a
system where everything is normally global. This setting allows you to DISABLE
Per-Preset overrides so only the global switch functions appear.

See "The Footswitch Functions Guide” for more on per-preset functions.

87
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PARAMETER Description
Bank Size Certain footswitch functions automatically map FM3 presets dynamically in
1-12 “Banks” across the switches. The FM3 defaults to 3 presets per bank but you

Preset Number/
Scene Number in
FC Main Display

ON/OFF
Ring Intensity (Bright, Dim)
25-100%, 1-50%,

Main LCD Notification Hold

Mini-Display Contrast
Mini-Display+Ring Brightness
Main Display Messages

CS1 Exclusive, etc.

can change this setting for use with custom layouts . The Bank Size number
should correspond directly to the number of “Preset: Select in Bank” switches
used.

The main display of a connected FC controller shows both

Preset number/Name, and Scene number/name. This option allows you to
individually hide these numbers, so a greater number of characters can be
dedicated to the names. It has no effect unless an FC is connected.

Each FC footswitch has its own segmented LED ring. The rings change color to
show switch function, and change between two brightness levels (and “off”) to
show switch states. These parameters allow you to adjust the intensity of both
dim and bright ring states.

The FC normally displays Preset and Scene names. It sometimes changes,
however, to show other status messages (such as when you toggle an effect on
or off). This parameter sets how long these alternate messages remain on the
screen before the preset/scene display returns.

This sets the contrast in the onboard mini-displays.

This sets the master brightness of all mini-displays and LED rings on the FM3.
This determines how long special footswitch messages will be shown in the
main display of the FM3, for example, when turning an effect on or off.
Although the switches on the FM3 or FC are not numbered, they do correspond
to the 12 switch definitions of any layout in a certain order. Normally, the FC6
shows the first six switches in two rows, but the FC12 places these across one
row, on the bottom. Therefore, if you create a layout for the FC12, it will re-
arrange itself when viewed on an FC-6, which can be a bit confusing. To prevent
this from happening, you can enable "FC-6/FC-12 Compatibility Mode. This
parameter canges switch mapping as illustrated below.

FC-12 Compatibility Mode

7 8 9 10 11 12

1 2 3 4 5 6
Normal

4 5 6 10 11 12

1 2 3 7 8 9
Six options allow you to add each of the six Control Switches to a mutually
exclusive group. Any switch with Exclusivity enabled becomes a member of a

group in which only ONE switch can be turned on at once. Turning any switch in
the group ON will turn all others in the group OFF automatically.

For more on Control Switches, see the Footswitch Functions Guide (p. 18)
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THE GLOBAL SETTINGS MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

GLOBAL SETTINGS: CONFIG PAGE

PARAMETER

Description

Power Amp Modeling
ON/OFF

Cabinet Modeling
ON/OFF

Tone Control Display
AUTHENTIC/IDEAL

Spillover
OFF/DELAY/REVERB/BOTH

Reverb Mix

+/- 50%

This parameter globally enables or disables power amp simulation in all Amp
blocks in all presets. This capability is provided for cases when the FM3 is used
with a guitar-oriented/tube power amp that contributes significantly to tone

and dynamics. Having these characteristics applied twice to the sound—once

in the virtual power amp and once in the real power amp—would result in an
over-processed sound. All those Amp block parameters that are NOT part of
the virtual power amp continue to work normally while Power Amp Modeling is
turned off. Presence and Depth are disabled, and Master Volume becomes a
simple volume control. Remember that like a real amp, the FM3 has separate
preamp and power amp sections. When you disable Power Amp Modeling, the
Amp block still models the preamp, which includes distortion, the tone stack,
and more.

This parameter conveniently enables or disables Cab block processing in all
presets. The Cab block will not physically appear to be bypassed, but acts
exactly as if it had been replaced a shunt. Use this when you are using the FM3
with an amp powering a traditional guitar speaker cabinet, or the sound will be
muffled, muddy, and boomy.

This parameter governs the "Tone" page of the amp block. When set to
Authentic (default) only those controls present on the actual amp are displayed.
When set to Ideal all tone controls are displayed. Also, when set to Authentic,
the Bass, Mid and Treble controls are reset to default values when changing
models to ensure accuracy for models that may not have these controls.

Allows delay and reverb “tails” to ring out or spill over across Preset changes.
You can select whether “DELAY”, “REVERB”, or “BOTH" effects will spill over.
Setting to “OFF” causes effect tails to be cleared upon preset change. Spillover
when switching Scenes or using “IA” Switches is not affected by this parameter.

See also "Spillover” onp. 112.

This boosts or cuts the MIX for ALL Reverb blocks in all presets. Note that

this offset is NOT reflected in the value shown for the actual Reverb block MIX
parameter. This feature is provided because certain dead or lively performance
spaces may require more or less reverb across all presets.

Remember that MIX generally applies only to Reverb blocks which are wired in
series. (Parallel reverbs typically run with MIX at 100%.)
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PARAMETER Description
Effects Mix Boosts or cuts the MIX of all blocks for which the GLOBAL MIX parameter is
+/- 50% set to “ON". This switch must be enabled on a per-block/per-preset basis and is
’ available on the Mix page of the Edit menu for these block types:
Chorus Formant Pitch Ring Mod
Delay Multitap Delay Plex Delay Rotary
Flanger Phaser Reverb Ten-Tap Delay
This feature is provided because certain performance spaces may require more
or less of certain effects across all presets.
Noisegate Offset Globally raises or lowers the THRESHOLD of the Noise Gate for all Input blocks.
+/-40.00 dB If the THRESHOLD for a given preset is set to “OFF”, the global Offset will have

Prompt on Edited Preset
Change

Display Offset
0,1

Default Scene
AS SAVED, SCENES 1-8

Tap Tempo
AVERAGE, LAST TWO

AC Line Frequency

no effect. See "The Fractal Audio Blocks Guide" for more on the noise gate.
When set to ON the unit will prompt before changing presets if the current
preset has been edited. This spares you from accidentally losing your edits.
NOTE: Be sure to change this to OFF before performing!

(Also appears in the MIDI/Remote menu) Causes presets numbers to begin
at 001 instead of 000. This only offsets the display, meaning that it does not
change which preset is actually loaded by a given footswitch or MIDI message.

When set to “As Saved” the scene selected when recalling a preset is the scene
that was active when the preset was last saved. When set to a particular scene
value that scene will always be selected when any preset is recalled.
Determines how the tempo changes when tapping the front panel TEMPO
button or an external tap tempo controller (see p. 98). “AVERAGE" sets the
tempo based on the average of ten taps, meaning taps are more forgiving

but changes are more gradual. “LAST TWO" considers only the time interval
between the last two taps, which means taps must be more precise but
changes occur more quickly.

The “Intelligent” Noise Gate type found in the Input Block provides smart EMI
filtering which reduces hum and buzz. For best results, set this parameter to
match the power line frequency of your country (i.e. 60 Hz for North America,
50 Hz for EU, etc.).
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GLOBAL SETTINGS: OUT 1 EQ PAGE

OUT 1 EQ provides a 10-band graphic EQ, plus a master GAIN adjustment control. Use these to make global
adjustments to the tone or level of ALL presets. This is convenient when you need to compensate for using a
different amp or speakers, or if a particular performance space seems overly bright or boomy. The master GAIN
fader should be used with care as it can cause clipping, and lowering it can affect the signal-to-noise ratio. This
EQs affect ONLY the Analog outputs. SPDIF and USB are not affected.

Output 1 Global EQ settings apply to all instances of the Output 1 mix signal, including the Output 1 balanced
jacks, unbalanced jacks, headphones jack, and signal which might be routed to USB or digital outs.

GLOBAL SETTINGS: CUSTOM SCALES PAGE

The Scales page is used to configure scales for the Custom Shifter type in the Pitch block.

See "The Fractal Audio Blocks Guide" for more on this effect.

PARAMETER Description

Custom Scale Number Selects from among the 32 global custom scales available to edit using the 12
1-32 parameters which follow.

__SHIFT (+/- 24) These 12 parameters are used to set the shift amount for each of the 12 steps

of the chromatic scale. Range is +/-24 semitones (+/- two octaves). To set up
a custom scale, select its number in the field above and then set each of the
12 pitch values as desired. Changes take effect immediately, with no need to
STORE. Soft-buttons provide options to reset a selected value or all values in
the current scale to the default value of +/- 0 semitones.
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THE 1/0 MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

1/0: AUDIO PAGE

PARAMETER Description

SPDIF Out Source This allows you to specify which signal should be transmitted at the SPDIF
Output 1, Output 2, Input 2 digital output.

USB 3,4 Record Source This determines whether USB 3+4 in a connected computer will record the

Input 1, Input 2
USB 3,4 Playback Destination

Input 1, Output 2

Input 1 Source

ANALOG
USB [CHANNELS 3/4]

Input 1 Pad
0,6dB,12dB, 18 dB

Input 2 Mode

STEREO

LEFT ONLY

RIGHT ONLY

SUM L+R

USB (Channel 4) +R

Input 2 Pad
0,10dB, 18 dB

Output 1 Mode
Output 2 Mode

STEREQ,
SUM L+R
COPY L>R

signal from FM3 Input 1 or Input 2.

This determines how the FM3 routes playback from USB 3+4 of a connected
computer. The default option of INPUT 1 is designed for re-amping. The
Output 2 option is provided so you can have backing tracks from the computer
appear at a different set of outputs from your main guitar signal.

This selects which signal source should be routed to the Input 1 block on the
grid. “ANALOG" selects the Input 1 Instrument jack. When “USB (CHANNELS
3/4)" is selected, the FM3 will process signals sent from FM3 Outputs 3 and 4
of a connected computer so you can process computer audio on the FM3 (as
when re-amping).

This pads the signal from IN 1 [INSTRUMENT] jack before it reaches the

A/D converter to prevent clipping. The pad is offset by a corresponding but
opposite boost at the output of the converter, so “what you hear” remains the
same at all settings.

Run this at the lowest possible setting for your guitar, starting at 0 dB and
increasing padding if required to eliminate Input 1 clipping as indicated on the
front panel LEDs.

This setting determines globally how the FM3 handles signals received at

the input 2 jacks, determining whether they should be processed in stereo or
mono—and, if mono, how. The outputs of a connected device and the nature of
the source material will determine which setting is best.

It is important that you choose the setting which corresponds to your actual
physical connections. Setting an input to “STEREQ” and then not connecting
one of the two jacks will result in reduced levels!

This pads the signal at INPUT 2 jacks before it reaches the A/D converter to
prevent clipping. Run this at the lowest possible value for your setup, starting
at 0 dB and increasing padding if required to eliminate Input 2 clipping as
indicated on the front panel LEDs.

These determine how output signals are processed. This control makes it
easy to use the same presets in a variety of stereo and mono performance or
recording environments.

See "Mono vs. Stereo” on p. 6 for more information.
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PARAMETER

Description

Output 1 Level

-10dBV
+4 dBu

Output 1 Phase
Output 2 Phase

NORMAL, INVERT
Output 2 Boost/Pad

0/6/12/18 dB

Output 2 Copy
INPUT 1,
OUTPUT 1,
NONE

1/0: USB PAGE

This sets the nominal levels of the output 1 analog jacks.
Use “10 dBV" for consumer-grade equipment including many guitar products.
Use “+4 dBu“ with professional audio equipment.

The product manual for your connected device should indicate whether it
operates at +4 dBu or -10 dBV (Default). (Some devices are switchable.)

Determines whether signal at the corresponding outputs will be normal
or phase-inverted relative to the actual output of the grid. This lets you
compensate for unwanted inversions elsewhere in the signal chain.

These settings engage a boost/pad which can help lower the noise floor of
Output 2. This may be useful when outputting to a tube amp or modeler or with
the Four-Cable Method.

Boost/Pad helps optimize D/A performance without affecting levels, since a
boost at the converter’s input is paired with a corresponding cut at its output.
Be watchful, however, as boosting makes it easier to clip the converters.
Watch the meters and if clipping occurs, reduce levels within your preset or
turn this setting down.

Enabling this option creates a copy of the Output 1 or Input 1 signal at Output
2. Use this for the convenience of having an extra copy of the Output 1 mix
with separate front panel level control—without the need to insert an additional
block. Use the Input 1 setting to create an analog DI.

This setting works only when the Output 2 block is NOT present on the grid for
the current preset!

The USB/page of the I/0 menu contains parameters to adjust the levels of USB inputs.

USB 1/2, 3/4 - These parameters adjust USB playback levels from -40 to +20 dB. Normally you would set comput-
er audio playback levels in the computer, but these controls are handy when you need a boost or cut.
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1/0: PEDAL PAGE

The Pedal page of the I/0 menu contains parameters to set up and use expression pedals or a switches through
the Pedal jacks on the rear panel of the FM3. Expression pedals should have a linear resistance taper and max
resistance of 10kQ to 100kQ. The Fractal Audio Systems EV-1 and EV-2 expression pedals are recommended. An
external switch may also be used, as long as its contacts make and break the connection between tip and sleeve.
A regular 1/4" guitar cable can be used with switches. Expression pedals must be used with Tip-Ring-Sleeve (TRS)
cables. See "Expression Pedals” on p. 10 and "External Switches" on p. 12.

PARAMETER Description
Pedal 1 Setup Set this according to the what you have connected.
Pedal 2 Setup

For 1 expression pedal, choose EXPRESSION PEDAL

For 1 switch, connect the switch to the TIP and SLEEVE of a TRS connector.
With this setting active, the RING function is disabled as a Modifier/External

EXPRESSION PEDAL,
1 SWITCH (TIP)

2 SWITCHES (TIP + RING) source to avoid mishaps.
For 2 switches, connect one to Tip and Sleeve and the other to Ring and sleeve.
Calibrate PEDAL 1 Calibrate expression pedals connected to an on-board Pedal jack.
Calibrate PEDAL 2 First select this menu choice, then:
» Press ENTER.
» Move the pedal through its full range of motion several times.
» Press ENTER again when finished.
Switches, unlike pedals, do not need to be calibrated.
Switch 1 Tip Behavior A switch with the default setting of "Follow Hardware" behaves exactly as you
Switch 1 Ring Behavior might expect: a latching switch latches, and a momentary switch is momentary.
Switch 2 Tip Behavior If you want a momentary switch to behave like a latching/toggle switch instead,
Switch 2 Ring Behavior use the "Virtual Toggle" option. Now, every time you tap the switch, its state on
FOLLOW HARDWARE, the FM3 will flip from ON to OFF, or OFF to ON.
So for example, imagine a momentary switch mapped to EXTERNAL 1 and
VIRTUAL TOGGLE assigned to the Rate of a Rotary. While you press down on the switch, the
Rotary rate increases. When you step off the switch, the rate slows. With the
Behavior changed to "Virtual Toggle", you would tap once for a fast rate, and
then tap again to toggle the rate to slow.
Note that if you accidentally apply the Virtual Toggle setting to a physical
latching switch, you'll need to tap the switch twice (or more) for it to toggle.
Switch 1 Tip Polarity The FM3 offers the option to reverse the polarity of any connected switch.
Switch 1 Ring Polarity, The option “Normal” assumes a “momentary make” switch. Use the option
Switch 1 Tip Polarity “Reverse” when using a “momentary break” switch, or for creative applications.
Switch 1 Ring Polarity
NORMAL,
REVERSE
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THE MIDI/REMOTE MENU

The MIDI/Remote menu contains global MIDI-related settings, and allows you to make assignments for Global
Controller functions including Block Bypass, Block Channel, the Looper, External Controllers, and more.

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

LEARN MODE

The MIDI Remote menu features a hidden Learn Mode function. Rather than using the knobs to assign a pedal, switch,
or MIDI CC, you can use Learn Mode. This is quick and also potentially saves you from needing to know which MIDI CC
is assigned to a button or pedal on a remote device. Here's how it works:

Navigate to the entry you want to assign: for example, "External Control 1" or "Tempo Tap".
1. Press ENTER to activate Learn Mode.

2. Move the remote pedal, knob, switch, etc. so Learn Mode can detect its activity.

3. The controller will be assigned automatically to your function.
If not, try again, troubleshooting the remote device as necesary, or press Exit to cancel.

MIDI/REMOTE: GENERAL PAGE

PARAMETER Description

MIDI Channel Sets the channel on which the FM3 will receive MIDI messages.

1-16, OMNI OMNI” causes the unit to respond to incoming messages on any channel.

MIDI Thru This enables or disables MIDI thru, which causes messages received at the

Off, On 5-pin MIDI In port to be merged with any internally generated MIDI data at the
MIDI out/Thru port.

Display Offset (Also appears in the Global menu) Causes presets numbers to begin at 001

0.1 instead of 000. This only offsets the display, meaning that it does not change

Scene Revert
ON/OFF

Effect Bypass Mode
VALUE/TOGGLE

Send Realtime Sysex

which preset is actually loaded by a given footswitch or MIDI message.

Selects between two different ways for scenes to work when you change them
via a Footswitch or MIDI:

“OFF” (Default): Scene edits are RETAINED across Scene changes as long as
you do not change PRESETS. So if you tweak Scene 1, switch to Scene 2, then
switch back to Scene 1, your tweaks will still be intact.

“ON": Scene edits are LOST if you change the Scene without saving. So if you
tweak Scene 1, switch to Scene 2, then back to Scene 1, Scene 1 will have
reverted to its previously saved state. This makes Scene changes feel more like
traditional preset changes.

See also "Scene Revert" on p. 54

This setting determines how MIDI messages set the Bypass State of a block.
When set to “Value” the bypass state is controlled by the CC value (0-63=0FF,
64-127=0N). When set to “Toggle” the bypass state toggles whenever the CC
message is received, regardless of the value (0-127).

Causes the FM3 to transmit MIDI messages for Tap Tempo and Tuner so a 3rd
party MIDI controller can display this information.
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PARAMETER

Description

Program Change

ON/OFF
Ignore Redundant PC

ON/OFF

Send MIDI PC

1-16
OMN|
OFF

MIDI PC Offset

PC Mapping

INITIAL VALUE:
External Control 1-16

Determines whether the FM3 will process or ignore incoming MIDI Program
Change messages.

This setting determines whether the FM3 should re-process or ignore a Program
Change message that corresponding to the current preset. With this setting
“OFF”, a preset will be reloaded—all changes discarded—when it is selected
again via PC. This allows you, for instance, to load a preset, use various
“Instant Access” switches to bypass effects, and then stomp the footswitch
that originally selected the preset to have it revert to its saved state. With this
setting “ON”", redundant PC messages are ignored. When PC mapping is used, if
the current Scene has changed, the preset will not reload but the Scene will still
revert to that set in the map.

Determines whether or not the FM3 will automatically transmit a MIDI Program
Change message at its MIDI OUT port when a new preset is loaded.

This is the easiest way for most people to operate a single connected MIDI
device while changing presets on the FM3. Any custom MIDI mapping is left to
the downstream device. To use this feature you simply select which channel
you want the message to be transmitted on. The “OMNI” setting transmits the
message on all channels.

Adds a specified value to all incoming MIDI Program Change requests before
they are processed. This makes it possible, for instance, to address alternate
presets in different “registers.” You might use the same MIDI messages to
access presets 1-16 for a gig with one guitar, and —by specifying an offset
of +16— use presets 17-32 for a different guitar without re-programming your
controller.

PC Mapping determines whether incoming MIDI Program Change messages
load presets 1-for-1, or load other presets and scenes instead. With PC
Mapping turned “OFF”", presets are loaded 1:1 based on incoming MIDI bank
Select and Program Change messages. With custom PC Mapping enabled,
incoming Program Change messages are re-mapped according to the values in
the table on the Custom page of the MIDI/Remote menu (see below).

These sixteen parameters specify the initial value to be used for each of the

16 External Controllers (p._67) when the FM3 is powered on. This value

persists until data is received from the MIDI controller. This is especially useful
when an external MIDI controller is absent. For example, if you normally use an
expression pedal to control the volume in your presets, a missing pedal might
make the preset get “stuck” in a muted position. Setting an initial value of 100%
for the External Controller mapped to that pedal would ensure that when the
pedal is not connected, the volume will stay at 100% instead of 0%. This setting
is only for controllers with a MIDI CC# assignment. It does not apply to local or
FC pedals or switches.
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MIDI/REMOTE: MAPPING PAGE

With PC Mapping enabled (see above), incoming Program Change messages are re-mapped according to the
values in the table in this section.

PARAMETER Description
Map to Preset When PC Mapping (above) is turned “ON”", the parameters in this table specify
Map to Scene which preset and scene are loaded for each incoming MIDI PC message.

See also "Program Change Mapping" on p. 53

MIDI/REMOTE: BYPASS PAGE

The Bypass page of the MIDI menu allows you to map MIDI CC messages—or connected pedals and switches—
to bypass or engage blocks. CC messages can be sent by a MIDI controller or computer connected to the MIDI
IN jack. Each of these settings is global. In every case, the method for mapping a controller to one of these
functions is the same:

1. Use the NAV knob to select the desired function.
2. Use the VALUE knob to assign a controller to the function:

= Select "NONE" to remove all assignments from the selected item.
= The following assignments work with a pedal or switch connected
to the on-board expression jacks of the FM3:
= PEDAL 1 or 2 (EXP/SW TIP) - for an expression pedal or a switch connected to the tip of a TRS cable.

= PEDAL 1 or 2 (SW RING) - for an external switch connected to the ring of a TRS cable.

» FC__ PEDAL 1-4 to assign a pedal connected to the corresponding pedal jack of the designated FC controller.
» FC__ SW 1-4 to assign a switch connected to the corresponding switch jack of the designated FC controller.
= 1-127 to assign a MIDI CC#.

MIDI/REMOTE: CHANNEL PAGE

The Channel page works exactly like the Bypass page except the entries are used to set the Channel of each
block instead of its bypass state. The value of the CC message sets the channel as follows:

0 =ChannelA 1=ChannelB 2=ChannelC 3=ChannelD

The series continues, repeating A, B, C, D for values up to 127 (D).
For additional information, see "Selecting Scenes & Channels Remotely" on p. 52

MIDI/REMOTE: EXTERNAL PAGE

Controller assignments for the sixteen External Controllers used in Modifiers (See Section 9: Modifiers).

MIDI/REMOTE: LOOPER PAGE

Controller assignments for the functions of the Looper.
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MIDI/REMOTE: OTHER PAGE

Controller assignments for various other functions of the FM3.

PARAMETER Description
Tempo Tap Provides the ability to tap the tempo using an external controller.
Learn more about Tempo in Section 11.
Tuner Provides a way to remotely enter or exit the Tuner. Learn more in Section 12.

Preset Inc/Dec
Preset Inc/Dec Start/Stop

Scene Select

Scene Increment
Scene Decrement

Input 1,2 Volume

Output 1,2 Volume

Output 1 Volume Increment,
Output 1 Volume Decrement,

Output 2 Volume Increment,
Output 2 Volume Decrement

These allow you to step up or down through a sequence of presets with pre-
defined start and end/wrap points. Preset mapping and offsets are ignored.

Don't confuse this with the Preset Inc/Dec function of the FM3's onboard
footswitches. These switches have their own settings and ignore this value,
which is used only for changing presets via MIDI.

Selects specific Scenes. The controller value (NOT the CC number) determines
which Scene is loaded:

2 =Scene 3 4 =Scene 5 6 = Scene 7
3 =Scene 4 5=Scene 6 7 =Scene 8

The series continues, cycling through scenes 1-8 for values up to 127 (Scene 8).

0 = Scene 1
1=Scene 2

For more, see "Selecting Scenes & Channels Remotely" on p. 52

The Scene Increment and Decrement functions allow you to step up or down
through scenes. These functions are triggered by CC data values above 63.

Four individual parameters allow you to globally control the levels of the
corresponding Input or Output blocks.

These options provide a convenient way to permanently increase or decrease the
MAIN output volume for the Out 1 or Out 2 Blocks in the currently loaded preset.
Each time Volume Increment is triggered, the MAIN is increased by 1.0 dB and
the preset is saved. This is the same for Volume Decrement, except it decreases
volume.

A IMPORTANT! Any unsaved changes such as altered effect parameters or
bypass states will also be stored when either of these functions is triggered!

&These functions are designed for use with momentary footswitches set up to
send a CC# value of 127 for “ON” and 0 for “OFF." Do not use an expression pedal
or you may change levels +/-20 dB with a single sweep!
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THE UTILITIES MENU

UTILITIES: DISPLAY PAGE

Provides a slider to adjust contrast/viewing angle for the built-in LCD display.

UTILITIES: ADC LEVELS PAGE

Shows Analog-to-Digital Converter levels for the front panel Level knobs and rear panel Expression jacks for
troubleshooting. You can set the output level here at an exact percentage.

UTILITIES: RESET PAGE

This page provides a tool to set parameters in the SETUP menu back to factory default values. Reset system
parameters is one of the first steps of troubleshooting. It never deletes or modifies your presets. You will be
prompted to press ENTER to confirm.

Be very careful with this option. Resetting system parameters is irreversible!

A second utility provides the ability to Clear all Presets. You will be prompted to press ENTER to confirm.

Be very careful with this option. Erasing presets is irreversible!

UTILITIES: FIRMWARE PAGE

This page indicates which firmware version the FM3 is running.

USB and FPGA firmware versions are also shown.
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14 ADDITIONAL TOPICS
FRACTAL-BOT

Fractal-Bot is required for Backing up and Restoring sounds and settings (below),
Updating Firmware (p. 101) and can be used for Transmitting Presets, or
Installing User Cabs (p. 107).

The program is self-explanatory and has instructions built in.

To be able to use Fractal-Bot, Windows users will need to install a driver to enable
communication between the computer and the FM3. The Windows driver is available
at https://www.fractalaudio.com/fm3-downloads/

Computers running 0S X do not require a driver to communicate with the FM3.

Download and install Fractal-Bot from our web site at https:/www.fractalaudio.com/fractal-bot

BACKING UP & RESTORING

You are encouraged to back up your FM3 regularly. Fractal-Bot makes it very easy to do this.

BACKING UP

Fractal-Bot automates the backup process. Select the RECEIVE tab and follow the built-in instructions. Here are
some things to consider when using Fractal-Bot:

» The FM3 doesn't emphasize this distinction, but its Presets are actually divided into banks of 128. To
backup all of your presets, backup all of the banks: A (0-127), B (128-255), C (265-383) and D (384-511).

» A backup of the SYSTEM includes all of the custom settings in the SETUP
menu: Global, /0, MIDI/Remote, and Tuner settings.

» User Cabs are backed up in one bank.

» In Fractal-Bot, you will need to specify a location for the backup files. It is wise to prepare this
in advance. Many pros we work with use a consistent naming system for their backup folders:
“yymmdd - FM3" (two digit year, two digit month, two digit day). In addition to the backup files,
create a text file to remind you what firmware version was installed when the files were created.

RESTORING

Fractal-Bot is also used to restore backup files to your FM3. In this case, the process is less automated but

still very easy. You will need to send over all of the files from your backup set individually. Once the first file
completes, send the next file over, and so on, until they are all finished. Remember to reboot the FM3 immediately
if a System file has been transmitted to it! (Fractal-Bot will remind you.)

You can use the same process to install presets or cab files you download.

MIDI

On the FM3, backup and dumping are not supported over 5-pin MIDI. You can transmit backup files to the unit this
way, but because the transfer rate is so slow, this can take a LONG time and is advised against.
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FIRMWARE UPDATES

Our products are upgradeable, and we are committed to continual improvement. These highly anticipated updates
add new amps, cabs, effects and features, fix issues, and more. We recommend keeping the firmware in your FM3
up to date as new versions are released. Firmware is technically software — the “operating system” of your FM3 —
tracked using version numbers: 1.00, 1.01, 2.00, etc. Every FM3 is shipped from the factory with the latest version
installed. You can check your version any time by pressing the SETUP button (Push-knob E) on the Home page.
The version is displayed at the top left of the SETUP menu.

UPDATING

Updating is safe, easy, and quick with Fractal-Bot (see previous page). Before you begin, please QUIT any other
applications which might interfere, including FM3-Edit and any DAW software or audio/MIDI applications.
1. Download the latest firmware for your FM3 from https:/www.fractalaudio.com/fm3-downloads/

2. Unzip the download file. The archive may contain various documents in addition to the actual firmware file,
which is a MIDI System Exclusive or “SysEx” file. Extract the .syx file to a location you can easily find when
required. Do not double-click the .syx file. Fractal-Bot will prompt you for its location when it is needed.

3. Please read the Release Notes included with the firmware download. They'll et you know what'’s new and
alert you to anything you may need to be aware of before updating to the new version.

4. Before performing a major firmware update, it is recommended to back up your FM3 (see previous page).
5. Launch Fractal-Bot and proceed through three self-explanatory steps.

6. Firmware updates will occasionally be accompanied by new versions of the FM3 Factory Presets. These will
be available on our web site support page and can also be installed using Fractal-Bot.

FIRMWARE Q&A

Q: How do | know the upgrade worked?

A: Check your firmware version anytime by pressing the SETUP button (Push-knob E)
on the Home page. The version is displayed at the top of the SETUP menu.

Q

Can | skip versions to go from a very old firmware version to a much newer one?

A: You can upgrade from any version to any other version. When you skip versions it is recommended that you
also read the Release Notes for all interim versions, all of which are included with every firmware release.

Q

Will updating my firmware erase, modify or “upgrade” my factory presets?

A: Firmware updates do not erase customized presets. However, firmware updates may
alter the sound of existing presets. Always read Release Notes before updating. Saving
presets after a firmware update can render them incompatible with previous versions. It
is always wise to create a full back up using Fractal-Bot before a major update.

Firmware updates do not upgrade Factory Presets. Updated Factory Presets, when offered, are released as a
separate update on our web site support page. Fractal-Bot can be used to transmit this update in the same
way it is used to update firmware.

Q

The firmware update failed mysteriously. What should | do?

A: If the FM3 still boots normally, just try the update again. If successive failures occur, please delete and
re-download the update file before trying again. Trying a different USB port or cable can also solve issues.

Q

After updating, my FM3 will no longer boot normally.
A: See “Recovery” on the next page.
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RECOVERY

PROBLEMS DURING/AFTER FIRMWARE UPDATE

The FM3 has a built-in recovery system known as the “Emergency Boot Loader” to protect you against mishaps
during firmware update. To boot from the emergency boot loader:

1. Power down the unit and wait five seconds.
2. Power on holding both PAGE LEFT and PAGE RIGHT buttons until the Emergency Utility page appears.
3. Update as normal using Fractal-Bot.

PROBLEMS WITH A SINGLE PRESET

If your FM3 will not boot normally, the problem may just be the current preset. You can force the unit to load an
empty initialized preset as follows:

4. Power down the unit and wait five seconds.
5. Power on holding HOME until the boot-up progress bar first appears.

The FM3 will boot with an empty initialized preset in location “000". You can STORE this to any other location to
overwrite a problematic preset.

PROBLEMS WITH GLOBAL SETTINGS OR PARAMETERS

In the very unlikely event that a problematic system parameter prevents the FM3 from booting normally, you may
use the following procedure to recover:

1. Power down the unit and wait five seconds.

2. Power on holding EDIT until the boot-up progress bar first appears.

3. Enter SETUP, open the Utilities menu, and page to Reset.
4

Execute Reset System Parameters as indicated on-screen (Push-knob A followed by ENTER).
WARNING! Do NOT accidentally perform CLEAR ALL PRESETS!!!

5. Follow the on-screen instructions to execute. Press HOME when finished.

You can in fact hold both HOME and EDIT at once to reset the current preset and prevent the loading of
global settings and parameters.

GETTING HELP

Our forum is a source of great help ranging from product Q&A to tutorials and more. Fractal Audio staff
participate in the conversation, and response times can be very fast. Find it at https://forum.fractalaudio.com

Our wiki, maintained by members of the Fractal Audio community, is also an excellent resource:

https://wiki.fractalaudio.com

You can get support directly from Fractal Audio Systems at: https:/support.fractalaudio.com
or internationally via our dealers listed at https://www.fractalaudio.com/international-ordering.

—
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FOOT CONTROL TUTORIAL

The following tutorial explores the factory default layout #7, named “Perform” because it is intended to show one
possible very simple way to use the FM3 while performing. This tutorial will use FM3-Edit but you could perform
all of these operations from the front panel just as easily.

To begin, load preset 382: Performance Tutorial and set up FM3-Edit as shown below.

[ 1) “FC Controllers” Edit mode is turned on.j

2) “Show Edits on FM3" is enabled.

SEM3-EDIT

4) Show As “FM3” and select
“View 1" and “LCDs"

Remember that under Windows, you will need to install drivers before using FM3-Edit.
See Section 3: USB.

Continued on next page.
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UNDERSTANDING VIEWS

This layout uses four different views, each set up like a self-contained mini layout.

Views are detailed on p. 74 but here’s a simple summary.
» The FM3 is based on “Layouts”, each containing programming for twelve footswitches.
» Unlike the larger FC-12 controller, the FM3 can only show three of these “Switch Definitions” at once.

» The view determines WHICH three switches are shown on the FM3.

View 3 View 4 . . .
In FM3-Edit, switches are shown in two rows of
O 0 00 0 O six. Views are arranged as shown.
O O O O O O Try using FM3-Edit to change the view now.
View 1 View 2

ABOUT LAYOUT 7: PERFORM

Layout 7 is designed as a “minimal” performance controller. Each view has its own purpose:

= View 1 selects three scenes. Our example preset contains Clean/Crunch/Lead.

= View 2 allows you to change presets. (The idea is that you might use one preset per song.)

= View 3 contains Tap Tempo and Tuner.

= View 4 is set to toggle three different effects on or off.By default, these are Drive 1, Delay 1 and Reverb

CHANGING VIEWS

View 1 changes the Scene. This layout is based on the idea that you might rely mostly on scene changes for
different sound settings within a song. Here, three switches are forced to Green, Yellow, and Red, making it
easy to recognize this layout. (See also “LED Ring Colors” on p. 9).

View 1
Select Scenes

From within View 1, you can

O O O O O O O O O Press and Hold any switch to
View 2 View 3 View 4 change the view as shown.
Change Presets  Tap/Tune Toggle FX
aka “UTILS"
View 2 View 3 View 4
Change Presets  Tap/Tune Toggle Effects
O O 'O O O O From any other view, Press
CE ? and Hold the middle switch
to go back to View 1
“Home").
O O O (‘Home?)
View 1 Try changing views with your feet now.

Select Scenes
Continued on next page.

—
-~
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Continued from previous page.

MAKING A CHANGE FROM THE FM3

In this next section, we'll use EZ Edit on the FM3 to make a change to one of the footswitches. We're going to
change the Reverb footswitch to one for Chorus. EZ Mode allows us to tap the footswitch we want to change
and make simple edits on the spot, but remember that while you're in EZ mode, the normal functions of the
footswitches won't work! Therefore, if you want to test a switch you first need to exit from EZ Mode!

1. To begin, use your feet to change to the Effects View as shown on the previous page. (You should see three
footswitches labeled “Drive 1" “Delay 1" and “Reverb 1")

On the FM3, open the SETUP Menu (Push Knob E).
NAV to the FC Controllers/Onboard Switches menu choice and press ENTER.
Make sure the “EZ" page tab is selected. If not, use the << PAGE >> buttons to select it.

On the FM3, tap the Reverb 1 footswitch. Notice the “TAP” settings for this switch in the FM3 main display:
Category is set to “Effect”, Function is set to “Bypass”, and Effect is set to “Reverb 1"

6. Nav to Effect and turn the VALUE knob until “Reverb 1" changes to “Chorus 1”.
(Remember that you never need to STORE changes in any SETUP area. They take effect immediately.)

a B w DN

7. Press EXIT twice and test your new Chorus Footswitch on the FM3.

MAKING A CHANGE IN FM3-EDIT

Now we'll use FM3-Edit to change the Chorus switch back into a reverb switch.
1. In FM3 Edit, change to View 4.

2. Click the upper right switch (which is now set to “Chorus 1 if you did the steps above).
3. Inthe “TAP” section of the lower panel, change the Effect from “Chorus 1" back to to “Reverb 1”.
4

. As when using the FM3 front panel, there is no need to STORE. Test your switch on the FM3.

FLNCTIONS

The “Show As” and “View” controls in FM3-Edit are visual aids. They help you focus on those
switches that you need to see. Be aware however, that when you select “FC6" , the order of
switches on the screen is different from the order for “FM3" or “FC12". This is indicated with

small numbers shown inside the LED rings in FM3-Edit.
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CONCLUSION

»

In this tutorial, you learned about Layout 7: Perform. We covered how it
uses VIEWS to create different sets of controls on the FM3.

You learned to change the view in an “out and back” arrangement.

You used EZ Mode to make a change on the FM3 itself, followed by a similar change through FM3-Edit.

ABOUT THE TUTORIAL PRESET

»
»

The tutorial preset is set up with three scenes: 1: Clean, 2: Crunch, and 3: Lead

These scenes are set up in such a way that you can dial in the amp, cab and drive pedal sounds
fully independently. This provides one possible model for designing your own FM3 presets.

= Scene 1 uses Amp Channel A, Cab Channel A and Drive Channel A.

= Scene 2 uses Amp Channel B, Cab Channel B and Drive Channel B.

= Scene 3 uses Amp Channel C, Cab Channel C and Drive Channel C.

Delay and Reverb are set so that the tail will spill over between

scenes, or when you turn these effects on or off.

» The Lead sound uses Delay Channel C, which is a copy of channel A with different mix levels.

= Differences across channels can sometimes alter spillover — changing the Delay Type or the Reverb Size,
for example. See “Spillover” on p. 112.

Other blocks and settings in this preset are shared across all scenes. This replicates

the way real pedals work. A phaser, for instance, will be either on or off and any change

to its knobs will be heard no matter which amp channel you are using.

A nice “Clyde” Wah pedal is included. It uses External 1 as described in “Global Expression Setup” on p. 11.

The LOOPER is included in this preset so that you can try it out. Just remember that the
Performance layout does not include an “Exit” to the Master Layout Menu, so you will
need to press HOME and then change the layout Manually to operate the looper.

If you wanted to add a switch in Layout 7 to show the Master Layout Menu, you could place it
on the un-used Tap function of the middle switch in View 2 or View 3. Follow the steps on the
previous page of this tutorial, choosing Category: Layout, Function: Select, Layout: 9.

NEXT STEPS...

»

Once you have completed this tutorial, we recommend that you explore the
other topics presented in Section 10: Layouts & Switches.

The “The Footswitch Functions Guide” is an essential companion to making the most of the FM3.

As you learn more, use your imagination to decide how you want the FM3 to work for you.
= |f you need help, our forum is a great resource. Fractal Audio staff members participate in the
conversation, and response times can be very fast. Find it at https:/forum.fractalaudio.com

= You can also get support directly from Fractal Audio Systems at: https://support.fractalaudio.com
or internationally via our dealers listed at https:/www.fractalaudio.com/international-ordering

—
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LOADING USER CABS

In addition to thousands of onboard cabs in its factory banks, the FM3 allows you to store up to 1,024 cabs in
user memories. These “User Cabs” allow you to personalize your FM3 with unique tones.

User Cabs — also know as “Impulse Responses (IRs)” — may be transferred to the FM3 as follows:
1. First, you'll need an impulse response file in SysEx format (.syx).

» Fractal Audio Systems offers various professional Cab Packs at https://shop.fractalaudio.com
These include creations by Fractal Audio as well as third-party producers.

= Axe-Change, our file sharing site, is a great resource for FREE cabs. https://axechange.fractalaudio.com
= Don't confuse the newer “.IR" file format, which is intended for re-mixing in Cab-Lab (see below).

2. Using Fractal-Bot or FM3-Edit, transmit the file to your FM3, noting which numbered Slot you are sending it
to. (Example: #215.)

» Fractal-Bot - This basic utility can send individual cabs to any location or transmit entire banks. To import
a single IR, open a Cab block on the grid and set Cab 1 to the Bank and Number you want to transmit a cab
to. Then send the sysex file to the FM3 using Fractal-Bot and the unit will save the IR to that location.

= FM3-Edit - The Manage Cabs tool allows you to drag and drop user cab files into memory slots. Don't
forget to press SAVE! You can also manage entries already in the memory of the FM3 with operations like
copy, paste, rename, and drag-and-drop re-ordering. When you purchase a Cab Pack, this is the best and
easiest way to load multiple IRs at once into your FM3, audition the results, and organize your favorites.

3. Once the IR has been transmitted to your FM3, select the Cab block in your preset and press EDIT.
4. Change the cab to the User Bank and Number that your IR was transmitted to. (Example: “USER, #215").

NOTE: In comparison to older Fractal Audio systems products, user cabs are NOT included in a backup of the
SYSTEM area of the FM3. Conversely, restoring a System backup will never overwrite user cabs.

Cab-Lab is a full-featured 8-channel
IR mixer and toolbox in standalone
and plug-in formats.

For decades, artists, producers
and engineers have created tones
using a mixer to blend the sounds
of different mics or speakers.
While the FM3 provides two mixer
slots, Cab-Lab has EIGHT, and has
additional options and tools, with
the ability to export Cab files and
save mix sessions.

Learn more at:
www.fractalaudio.com/cab-lab-3
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AXE-CHANGE

Axe-Change is the official source for sharing Preset and Cab files for Fractal Audio Systems products. You can
upload your own FM3 presets or browse what others have contributed including some high profile artists (though
regrettably many artists treat their presets as guarded secrets). Axe-Change is also a great source for free Cabs!

Find Axe-Change at https://axechange.fractalaudio.com
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FREQUENTLY ASKED QUESTIONS

Q:
A:

Q

2R =R

Q

Why all the technical terminology?

The language of the FM3 is for the most part the universal language of professional audio. This allows the
FM3 to be used by casual and professional players, producers, engineers, and beyond. The terminology
and concepts you will use and learn are accordingly not unique to the FM3. Understanding them will help
you to master the craft of pro audio and to communicate with others. At the same time, the FM3 is easier
than ever, with dedicated controls and a clear interface that doesn't distract or disrupt the creative flow.

What is “FRFR"?

FRFR stands for “full-range, flat response.” This acronym is used to describe a “neutral”
speaker or speaker system that is designed to reproduce the entire audible spectrum of
20 Hz - 20kHz without emphasis. Examples of FRFR systems would include high-quality
studio monitors and properly designed PA systems or monitors. Many manufacturers are
also now offering FRFR systems designed specifically for direct guitar applications.

How do | upgrade the firmware of my FM3?
Use Fractal-Bot. See p. 100.

Can | load my presets from the Axe-Fx IIl into the FM3 (or vice versa)?

Yes! Axe-Edit and FM3 Edit have both been updated for cross compatibility. The FM3 will do
its best to interpret larger Axe-Fx Il presets but you should always check the results.

= The top 4 rows and first 12 columns of an Axe-Fx Il preset are imported first. This aligns the top-left of the
FM3 grid with the Axe-Fx Ill grid. Any incompatible block will be replaced by a shunt.

= Blocks in rows 5 and 6 as well as columns 13 and 14 of the Axe-Fx Il preset are added to the first available
spaces of the FM3 preset. Incompatible blocks will not be imported.

= When converting an Axe-Fx Il preset to an FM3 preset it is possible to have more blocks than the CPU
can handle. If this happens, the FM3 device will display a blinking red banner in the top-left of the HOME
screen that reads “CPU Limit - Muted”. The FM3 will stop processing audio but allow you to delete and/or
reconfigure the blocks as needed.

= |n regards to the CAB block, an Axe-Fx Ill preset that has bank USER 2 selected will be changed to USER 1
as the FM3 does not have a User 2 bank. Also note, that only “Cab 1" and “Cab 2" selections from the Axe-
Fx Ill preset will be imported as the FM3 only has two selectable cabinets.

What about presets from the Axe-Fx Il, AX8 or FX8?

No, these presets are not cross-compatible, but you can generally transfer parameter settings
by hand with good results. As of this writing, all of the same amp models are present, and
“factory” speaker cabs of the older products are present in the “Legacy” bank on the FM3.

Q: My expression pedal isn't working. What should | do?

>

=R =R

Expression pedals need to be calibrated and assigned to a parameter, controller or remote function. See
“Expression Pedals” on p. 10 for a basic overview. Are you using a TRS cable? Is it connected to the correct
port on the FM3? Is it actually an expression pedal? Did you set up a Modifier as described in Section 9?

My FM3 won't start up correctly.
Please see “Recovery” on p. 102.

My FM3 seems quiet at default settings.

By default, analog outputs 1 is set to -10dBV. To change to +4dBu, use the Output
Level parameters for Out 1 on the Audio page of the I/0 menu under SETUP.
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Can | use a computer or external MIDI controller to remote control the FM3?

Yes. The FM3 has a rich MIDI spec which allows it to be remote controlled. Using a computer, you can
use the built-in USB connection for “MIDI-over-USB”, rather than relying on a third-party MIDI interface.
See “The MIDI/Remote Menu” on p. 95 and “MIDI Implementation” on p. 120 for more on this.

I'm hearing click and pops.

First, check all cables. You'd be surprised by how often a short can be found in a brand new or trusted cable.
Then, check to see whether you are clipping the FM3 inputs or outputs (p. 5).

Excessive CPU usage may also be to blame. Is the CPU meter at or near 80%? If so, you've overloaded

the current preset. Try removing one block and review “Preset CPU Limits” on p. 48 for useful tips.

One or more of my presets produces no sound.

This might be any one (or several) of a number of things. Is every other component in your rig working
correctly? Most of the time, the problem is a faulty or disconnected cable. Checking the FM3 with
headphones can help rule this possibility out. Using the DELETE button (Push-knob C), try changing each
block to a SHUNT, ending with the Amp and Cab blocks. Do some presets work? If so, have you double-
checked to ensure that each has a complete path from the input to the output? Does every preset begin and
end with Input and Output blocks corresponding to inputs and outputs connected to other equipment? Is
there a Modifier assigned to a volume or level control while the pedal or external switch is not present? You
may simply need to change the INITIAL VALUE for an external controller from 0% to 100% (see p. 96).

Does the preset require a USER CAB which is not loaded? Try changing the Cab block to a Factory cab.

Why would | place certain effects before or after an Amp and Cab?

Sonically speaking, the main reason to care about effect placement is that a given
effect will sound different when placed before or after distortion.

How does this difference sound? If you've ever switched the sequence of traditional drive and wah pedals,
you've heard an excellent example. In the case of wah before overdrive, the resonant filter of the wah
“excites” the overdrive in a cool way while still retaining a natural overall tone. When the wah follows
distortion, you might hear a more dramatic sweep that almost sounds synth-like and might be considered
less “classic.” It's not surprising then that wah would traditionally be a run as a “pre” effect between
guitar and amp. The amp’s distortion follows the wah. Many other effects fall in this same category.

A different example is found in overdrive with reverb or delay. In the natural world, reverb and echo occur
because of open spaces around your guitar amp - like a club or concert hall. These effects would therefore
NOT be heard before a distorted amp, but after it. Recording studios often add these kinds of effects “post”,
i.e. at the console—after the mic has picked up the distorted sound from the guitar amp. If you wanted

to simulate this natural sounding reverb or delay these effects would likely be run “post.” This is not to

say that delay or reverb before distortion is a “no-no.” Many “legendary” tones came from echo units in
front of an amp—but this is very different from “post” delay, both tonally, but also in terms of dynamics.

The good news is that the FM3 allows you to experiment easily and find what combinations
of pre- and post-effects work best for you. Creativity begins where conformity ends.

Anything else | should know?
The Layouts and Footswitches section includes its own FAQ. Check out the “EM3 Footswitch FAQ" on p. 82

—
—
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SHORTCUTS

The FM3 has several shortcuts and hidden features. These are summarized below.

IN GENERAL

= Press EDIT to jump to the Edit menu for the currently selected
block. Press repeatedly to step through all blocks.

ON THE HOME PAGE
= Press ENTER to show the Layout Grid for the current preset.
= Use NAV LEFT/RIGHT to select presets and press NAV UP/DOWN or turn knob A to select scenes.

IN THE AMP BLOCK
= Onthe Output EQ page, press ENTER to flatten the EQ.
»  Onthe Output EQ page, press NAV UP/DOWN to change the number of bands.

IN THE CAB BLOCK
= NAV to the Cab Number field and press ENTER to enter the Cab Picker for the selected.

ON THE GRID

= With any block selected, press-and-hold ENTER to create a series of shunts and cables to bridge
empty space to the right. This will also CLEAR existing connectors between a series of blocks.

TO OPEN THE CONTROLLERS MENU
= Press the TEMPO button once.

ON THE SEQUENCER PAGE OF THE CONTROLLERS MENU

=  With any Stage selected, press ENTER to randomize the values of all stages.

—
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SPILLOVER

Spillover allows delay and reverb tails to “ring out” when an effect is bypassed or when you change channels,
scenes, or presets. This section covers how to set up spillover in different scenarios.

WHEN BYPASSING AN EFFECT...

Effect block spillover is easy and requires only a particular setting in the block. For tails to ring out when an
individual block is bypassed, set that block’s Bypass Mode to “MUTE FX IN”. If an effect is running in parallel, use
“MUTE IN" instead. Be aware that different channels share effect memory, so changes to delay time, reverb size,
etc, may cause a “sweep” in the tail.

WHEN SWITCHING SCENES...

Switching Scenes provides one of the best ways for sound changes to have perfect spillover. Since Scenes simply
bypass or engage blocks one-by-one or in groups, just refer to the instructions above for all blocks in your preset.

WHEN CHANGING PRESETS...

Spillover across different presets is a bit more involved. The first step is to open the SETUP: Global Settings:
Config and set the Spillover parameter to determine whether “DELAY”, “REVERB", or “BOTH" will spill over when
you change presets. This setting is OFF by default.

You must also ensure that the same Delay or Reverb blocks exist in each of your presets where you want spillover.
These need to be the same block and the same number (i.e. Delay 1 spills over only through Delay 1, Delay 2
through Delay 2, etc.).

For spillover to work perfectly, the blocks must also have similar settings and placement on the grid. The moment
you change to a new preset, the parameter settings can change. For example, if you change from a preset where
Delay 1 has a time of 500 ms to a preset where Delay 1 time is 100 ms, the tails will suddenly be heard as 100

ms echoes instead. You would likewise hear a difference in the tail, for instance, if that delay was placed after a
clean amp block in one preset, and before an overdriven amp block in another! Bypass states and Bypass Mode
settings must also be considered.

For a simple preset spillover experiment, create a preset, then save an exact copy to a new location and
test spillover. Then begin making changes as needed to settings outside of those blocks that you want
to spill over. FM3-Edit also makes it easy to copy and paste a block from one preset to another.

—
—
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SENDING AND RECEIVING MIDI

MIDI Messages are received at the MIDI In port and transmitted at the MIDI OUT/THRU port of the FM3. Use 5-pin
MIDI cables between the FM3 and the MIDI ports of other devices.

RECEIVING MIDI

The FM3 responds to MIDI Program Change Messages, MIDI CC messages — which can be used for a wide variety
of purposes including Scene Select, Effect Bypass/Engage, Modifier Control, and more — and will sync internal
tempo to MIDI clock messages for use with delay time, LFO rates, etc.

The FM3 is NOT a USB MIDI Device. It uses COM ports over USB for Fractal-Bot and FM3-Edit, and will not appear
as a MIDI device in a DAW or other MIDI program.

MIDI THRU

The FM3 MIDI Qut port also features a soft “MIDI Thru” capability. This merges any data received at the MIDI In
port with any generated MIDI messages at the MIDI Out port. This option must be enabled. See “The MIDI/Remote

Menu” on p. 95.

SEND MIDI PC

The simplest MIDI capability of the FM3 is transmitting a single MIDI program change message (“PC") each
time a new Preset is loaded—whether via the front panel, using an FC Footswitch, or in any other way. To enable
this, open the SETUP | MIDI/Remote menu and page to the “General” tab. Set Send MIDI PC to the desired MIDI
channel.

THE SCENE MIDI BLOCK

A more sophisticated MIDI tool is the Scene MIDI Block. Once you place this block on the grid, it transmits MIDI
messages automatically whenever a new scene is loaded—whether via the front panel, with a footswitch, or by
any other means. The Scene MIDI block can transmit up to eight total custom PC or CC messages. Remember
that a “default scene” loads automatically when you select a new preset, so any FC footswitch that selects a new
Preset or a new Scene can also cause the FM3 to send a burst of MIDI messages. See the “The Fractal Audio
Blocks Guide” for more on the Scene MIDI Block.

—
—
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CONTROL SWITCH MIDI

Another way for the FM3 to transmit MIDI messages using Control Switches. The primary function of a Control
Switch is to operate as a Modifier source to control FM3 parameters. Beyond this, however, each of the six
Control Switches has the capability to transmit a custom “payload” of MIDI data every time the switch is turned on
ON or OFF. Because this isn't tied to another event such as a Preset or Scene change, Control Switch MIDI is more
flexible and dynamic.

Because Control Switches can be momentary or latching (and even mutually exclusive), the CS MIDI system
is very versatile. You might change a connected MIDI-controlled amp, operate a remote processor, control a
sequencer, switch a lighting system, and more.

Here is a summary of the MIDI Capabilities of a Control Switch:
» The Control Switch function can be placed in any FC Layout.

» Control Switches 1-6 appear in the list of Modifier sources on the FM3. The role of a switch as
a modifier source is not compromised if you also use it to transmit MIDI. The same switch can
simultaneously control the FM3 and a connected device. See Section 9: Modifiers to learn more.

» Each Control Switch has its own global MIDI Payload containing up to four Program
Change (“PC") or Control Change (“CC) messages on any MIDI Channels, with custom
values from 0-127, or disabled (“-") for both the ON and OFF states of the switch.

» Each MIDI Payload also has a “master switch” allowing it to be enabled or disabled.

SETTING UP THE MIDI PAYLOAD FOR A CONTROL SWITCH:

» Open the SETUP | FC Controllers/External Switches menu and page to the “CS MIDI" tab.
» Use NAV buttons and the VALUE wheel to get around the page.

» Select the desired control switch at the top of the menu. (CS1, CS2, etc.)

» Make sure ENABLED is set to “YES” if you want the switch to send MIDI.

» NAV through the table and create your desired MIDI Payload of up to
four commands, with different values for ON and OFF

= For each command, select whether you want a Program Change (PC) or Control Change (CC) message.
Set the MIDI Channel for that command as desired from 1-16.

If you chose a CC Command, set the CC Number.

Set the desired Values for when the switch is ON and when it is OFF.

You can select values from 0-127, or “-" which means “send nothing.”

» There is no need to save CS MIDI settings. They take effect immediately.

See the “The Footswitch Functions Guide” for more on Control Switches.

@ Remember, Control Switches can be switched manually using a footswitch, or automatically by Scenes.

—
—
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MIDI REFERENCE TABLES

MIDI BANK & PROGRAM CHANGE

The following table lists the MIDI Bank and Program Change messages required to select FM3 presets.
MIDI Bank Select (CC#0) Value , Midi Program Change = FM3 Preset Number.

0,0 =0 0,42 = 42 0,84 = 84 0,126 = 126 1,40 = 168
0,1 =1 0,43 = 43 0,85 = 85 0,127 = 127 1,41 = 169
0,2 =2 0,44 = 44 0,86 = 86 1,0 = 128 1,42 = 170
0,3 =3 0,45 = 45 0,87 = 87 1,1 =129 1,43 = 17
0,4 =4 0,46 = 46 0,88 = 88 1,2 = 130 1,44 = 172
0,5 =5 0,47 = 47 0,89 = 89 1,3 = 131 1,45 = 173
0,6 =6 0,48 = 48 0,90 = 90 1,4 = 132 1,46 = 174
07 =17 0,49 = 49 0,91 = 9 1,5 = 133 1,47 = 175
0,8 =38 0,50 = 50 0,92 = 92 1,6 = 134 1,48 = 176
0,9 =9 0,51 = 51 0,93 = 93 1,7 =135 1,49 = 177
0,170 = 10 0,52 = 52 0,94 = 94 1,8 = 136 1,50 = 178
0,11 =M 0,53 = 53 0,95 = 95 1,9 = 137 1,51 = 179
0,12 = 12 0,54 = 54 0,96 = 96 1,10 = 138 1,52 = 180
0,13 = 13 0,55 = 55 0,97 = 97 1,11 = 139 1,53 = 181
0,14 = 14 0,56 = 56 0,98 = 98 1,12 = 140 1,54 = 182
0,15 = 15 0,57 = 57 0,99 = 99 1,13 = 1M 1,55 = 183
0,16 = 16 0,58 = 58 0,700 = 100 1,14 = 142 1,56 = 184
0,177 = 17 0,59 = 59 0,101 = 101 1,15 = 143 1,57 = 185
0,18 = 18 0,60 = 60 0,102 = 102 1,16 = 144 1,58 = 186
0,19 =19 0,61 = 61 0,703 = 103 1,17 = 145 1,59 = 187
0,20 = 20 0,62 = 62 0,104 = 104 1,18 = 146 1,60 = 188
0,21 = 21 0,63 = 63 0,105 = 105 1,19 = 147 1,61 = 189
0,22 = 22 0,64 = 64 0,706 = 106 1,20 = 148 1,62 = 190
0,23 = 23 0,65 = 65 0,107 = 107 1,21 = 149 1,63 = 191
0,24 = 24 0,66 = 66 0,108 = 108 1,22 = 150 1,64 = 192
0,25 = 25 0,67 = 67 0,709 = 109 1,23 = 151 1,65 = 193
0,26 = 26 0,68 = 68 0,110 = 110 1,24 = 152 1,66 = 194
0,27 = 27 0,69 = 69 0,111 = 111 1,25 = 153 1,67 = 195
0,28 = 28 0,70 = 70 0,112 = 112 1,26 = 154 1,68 = 196
0,29 = 29 0,71 =T 0,113 = 113 1,27 = 155 1,69 = 197
0,30 = 30 0,72 = 72 0,114 = 114 1,28 = 156 1,70 = 198
0,31 = 31 0,73 =73 0,115 = 115 1,29 = 157 1,71 = 199
0,32 = 32 0,74 = 74 0,116 = 116 1,30 = 158 1,72 = 200
0,33 = 33 0,75 =75 0,117 = 117 1,31 = 159 1,73 = 201
0,34 = 34 0,76 = 76 0,118 = 118 1,32 = 160 1,74 = 202
0,35 = 35 0,77 =77 0,119 = 119 1,33 = 161 1,75 = 203
0,36 = 36 0,78 = 78 0,120 = 120 1,34 = 162 1,76 = 204
0,37 = 37 0,79 =79 0,121 = 121 1,35 = 163 1,77 = 205
0,38 = 38 0,80 = 80 0,122 = 122 1,36 = 164 1,78 = 206
0,39 = 39 0,81 = 81 0,123 = 123 1,37 = 165 1,79 = 207
0,40 = 40 0,82 = 82 0,124 = 124 1,38 = 166 1,80 = 208
0,41 = 41 0,83 = 83 0,125 = 125 1,39 = 167 1,81 = 209

—
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1,82 = 210 2,6 = 262 2,58 = 314 2,110 = 366 3,34 = 418 3,86 = 470
1,83 = 21 2,7 = 263 2,59 = 315 2,111 = 367 3,35 = 419 3,87 = 471
1,84 = 212 2,8 = 264 2,60 = 316 2,112 = 368 3,36 = 420 3,88 = 472
1,8 = 213 2,9 = 265 2,61 = 317 2,113 = 369 3,37 = 421 3,80 = 473
1,86 = 214 2,10 = 266 2,62 = 318 2,114 = 370 3,38 = 422 3,90 = 474
1,87 = 215 2,11 = 267 2,63 = 319 2,115 = 371 3,39 = 423 3,91 = 475
1,88 = 216 2,12 = 268 2,64 = 320 2,116 = 372 3,40 = 424 3,92 = 476
1,8 = 217 2,13 = 269 2,65 = 321 2,117 = 373 3,41 = 425 3,93 = 477
1,90 = 218 2,14 = 270 2,66 = 322 2,118 = 374 3,42 = 426 3,94 = 478
1,91 = 219 2,15 = 271 2,67 = 323 2,119 = 375 3,43 = 427 3,95 = 479
1,92 = 220 2,16 = 272 2,68 = 324 2,120 = 376 3,44 = 428 3,96 = 480
1,93 = 221 2,17 = 273 2,69 = 325 2,121 = 377 3,45 = 429 3,97 = 481
1,94 = 222 2,18 = 274 2,70 = 326 2,122 = 378 3,46 = 430 3,98 = 482
1,95 = 223 2,19 = 275 2,71 = 327 2,123 = 379 3,47 = 431 3,99 = 483
1,96 = 224 2,20 = 276 2,72 = 328 2,124 = 380 3,48 = 432 3,100 = 484
1,97 = 225 2,217 =271 2,73 = 329 2,125 = 381 3,49 = 433 3,101 = 485
1,98 = 226 2,22 = 278 2,74 = 330 2,126 = 382 3,50 = 434 3,102 = 486
1,99 = 227 2,23 =279 2,75 = 331 2,127 = 383 3,51 = 435 3,103 = 487
1,100 = 228 2,24 = 280 2,76 = 332 3,0 = 384 3,52 = 436 3,104 = 488
1,101 = 229 2,25 = 281 2,77 = 333 3,1 = 385 3,53 = 437 3,105 = 489
1,102 = 230 2,26 = 282 2,78 = 334 3,2 = 386 3,54 = 438 3,106 = 490
1,103 = 231 2,27 = 283 2,79 = 335 3,3 = 387 3,55 = 439 3,107 = 491

1,104 = 232 2,28 = 284 2,80 = 336 3,4 = 388 3,56 = 440 3,108 = 492
1,106 = 233 2,29 = 285 2,81 = 337 3,5 = 389 3,57 = 441 3,109 = 493
1,106 = 234 2,30 = 286 2,82 = 338 3,6 = 390 3,58 = 442 3,110 = 494
1,107 = 235 2,31 = 287 2,83 = 339 3,7 = 391 3,59 = 443 3,111 = 495
1,108 = 236 2,32 = 288 2,84 = 340 3,8 = 392 3,60 = 444 3,112 = 496
1,109 = 237 2,33 = 289 2,85 = 341 3,9 = 393 3,61 = 445 3,113 = 497
1,110 = 238 2,34 = 290 2,86 = 342 3,10 = 394 3,62 = 446 3,114 = 498
1,111 = 239 2,35 = 291 2,87 = 343 3,11 = 395 3,63 = 447 3,115 = 499
1,112 = 240 2,36 = 292 2,88 = 344 3,12 = 39 3,64 = 448 3,116 = 500
1,113 = 241 2,37 = 293 2,89 = 345 3,13 = 397 3,65 = 449 3,117 = 501
1,114 = 242 2,38 = 294 2,90 = 346 3,14 = 398 3,66 = 450 3,118 = 502
1,115 = 243 2,39 = 295 2,91 = 347 3,15 = 399 3,67 = 451 3,119 = 503
1,116 = 244 2,40 = 296 2,92 = 348 3,16 = 400 3,68 = 452 3,120 = 504
1,117 = 245 2,41 = 297 2,93 = 349 3,17 = 401 3,69 = 453 3,121 = 505
1,118 = 246 2,42 = 298 2,94 = 350 3,18 = 402 3,70 = 454 3,122 = 506
1,119 = 247 2,43 = 299 2,95 = 351 3,19 = 403 3,71 = 455 3,123 = 507
1,120 = 248 2,44 = 300 2,96 = 352 3,20 = 404 3,72 = 456 3,124 = 508
1,121 = 249 2,45 = 301 2,97 = 353 3,21 = 405 3,73 = 457 3,125 = 509
1,122 = 250 2,46 = 302 2,98 = 354 3,22 = 406 3,74 = 458 3,126 = 510
1,123 = 251 2,47 = 303 2,99 = 355 3,23 = 407 3,75 = 459 3,127 = 511
1,124 = 252 2,48 = 304 2,100 = 356 3,24 = 408 3,76 = 460

1,125 = 253 2,49 = 305 2,101 = 357 3,25 = 409 3,77 = 461

1,126 = 254 2,50 = 306 2,102 = 358 3,26 = 410 3,78 = 462

1,127 = 255 2,51 = 307 2,103 = 359 3,27 = 411 3,79 = 463

2,0 = 256 2,52 = 308 2,104 = 360 3,28 = 412 3,80 = 464

2,1 = 257 2,53 = 309 2,105 = 361 3,29 = 413 3,81 = 465
2,2 = 258 2,54 = 310 2,106 = 362 3,30 = 414 3,82 = 466
2,3 =259 2,55 = 311 2,107 = 363 3,31 = 415 3,83 = 467

2,4 = 260 2,56 = 312 2,108 = 364 3,32 = 416 3,84 = 468
2,5 = 261 2,57 = 313 2,109 = 365 3,33 = 417 3,85 = 469
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14 ADDITIONAL TOPICS

CC VALUE TO SCENE

When selecting Scenes using the global options found on the Other page of the MIDI/Remote menu under SETUP,
the value of the designated CC# determines the Scene:

0........ 1 16....... 1 32....... 1 48....... 1 64....... 1 80....... 1T 96....... 1T 1M2...... 1
T 2 17....... 2 33....... 2 49....... 2 65...... 2 81....... 2 97....... 2 1M3...... 2
2........ 3 18....... 3 34....... 3 50....... 3 66....... 3 82....... 3 98....... 3 114...... 3
3. 4 19....... 4 35....... 4 51....... 4 67....... 4 83....... 4 99....... 4 115...... 4
4........ 5 20....... 5 36....... 5 52....... 5 68....... 5 84....... 5 100...... 5 116...... 5
S5 ... 6 21....... 6 37....... 6 53....... 6 69....... 6 85...... 6 101...... 6 117...... 6
6........ 7 22....... 7 38....... 7 54....... 7 70....... 7 86....... 7 102...... 7 118...... 7
7.0 .. 8 23....... 8§ 39....... 8 55....... 8 T71....... 8 87....... 8§ 103...... 8 119...... 8
8........ 1T 24....... 1 40....... 1 56....... 1 72....... 1 88....... 1 104...... 1 120...... 1
9........ 2 25....... 2 4. 2 57....... 2 T73....... 2 89....... 2 105...... 2 121...... 2
10....... 3 26....... 3 42....... 3 58....... 3 T4....... 3 90....... 3 106...... 3 122...... 3
Mmoo 4 27....... 4 43....... 4 59....... 4  T75....... 4 91....... 4 107...... 4 123...... 4
12....... 5 28....... 5 44 ... 5 60....... 5 76....... 5 92....... 5 108...... 5 124...... 5
13....... 6 29....... 6 45....... 6 61....... 6 77....... 6 93....... 6 109...... 6 126...... 6
14....... 7 30....... 7 46....... 7 62....... 7 78....... 7 94....... 7 110...... 7 126...... 7
15....... 8 31....... 8 47....... 8 63....... 8 79....... 8 95...... 8 111...... 8 127...... 8
CC VALUE TO CHANNEL

When changing Channels using the global options found on the Channel page of the MIDI/Remote menu under
SETUP, the value of the designated CC# determines the Channel:

0........ A T6....... A 32....... A 48....... A 64...... A 80....... A 96....... A 112...... A
T B 17....... B 33...... B 49....... B 65....... B 81....... B 97....... B 113...... B
2. C 18....... C 34...... C 50....... C 66....... C 82....... C 98...... C 14...... C
3. D 19....... D 35...... D 51....... D 67....... D 83...... D 99....... D 15...... D
4........ A 20....... A 36....... A 52....... A 68....... A 84....... A 100...... A 116...... A
S B 21....... B 37....... B 583....... B 69....... B 85...... B 101...... B 117...... B
6........ C 22....... C 38...... C b54...... C 70....... C 86....... c 102..... C 18...... C
7........ D 23....... D 30....... D 55...... D 71....... D 87....... D 103...... D 119...... D
8........ A 24...... A 40....... A 56....... A T72....... A 88....... A 104...... A 120...... A
9........ B 25....... B 41....... B 57....... B 73....... B 89....... B 105...... B 121...... B
10....... C 26....... C 42....... C 58...... C 74...... C 90....... C 106...... C 122...... C
M. D 27....... D 43....... D 59....... D 75....... D 91....... D 107...... D 123...... D
12....... A 28....... A 44....... A 60....... A T76....... A 92....... A 108...... A 124...... A
13....... B 29....... B 45....... B 61....... B 77....... B 93....... B 109...... B 125...... B
14....... C 30....... C 46....... C 62....... C 78....... C 94...... C 110...... C 126...... C
15....... D 31....... D 47....... D 63....... D 79....... D 95....... D 11...... D 127...... D
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15 SPECIFICATIONS

15 SPECIFICATIONS

INSTRUMENT INPUTS

Connectors: Rear 1/4" phone jack, unbalanced, with “Secret Sauce”
Impedance: 1MQ
Max. Input Level: +16 dBu

ANALOG INPUT 2

Connectors: (2) 1/4" phone jack balanced (TRS)
Impedance: 1 MQ

Max. Input Level: +20 dBu

A/D CONVERSION

Bit Depth: 24 bits

Sample Rate: 48 kHz

Dynamic Range: 114 dB

Frequency Response:
Crosstalk:

20 - 20kHz,-0.01 to +0.01 dB
110dB (typ) Interchannel Isolation

ANALOG OUTPUT 1
Connectors: (2) XLR balanced with Ground Lift
Selectable between -10 dBV and +4 dBu in software
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 2
Connectors: (2) 1/4" phone jack unbalanced (Humbuster™)
Impedance: 600 Q
Max Output Level: +20 dBu
HEADPHONE OUTPUT
Connector: 1/4" stereo phone jack
Impedance: 35Q
D/A CONVERSION
Dynamic Range: 114 dB

Frequency Response:

20 - 20kHz, +0 /-1 dB

DIGITAL OUTPUT

Connectors: RCA Coaxial Type for S/PDIF
Format: Uncompressed PCM

Sample Rate: 48 kHz fixed

USB AUDIO

Format: USB Audio Class 2.0 compliant
Channels: 4 input, 4 output

USB Audio Clock: 48 kHz fixed

MIDI INTERFACE

Input Connector: (1) 5-pin DIN

Out/Thru Connector: (1) 5-pin DIN

—
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15 SPECIFICATIONS

PEDAL INTERFACE
Connectors: (2) 1/4" TRS phone jack
Format: Pedal: 10-100 kQ max
Tip-Ring Switch: make/break; momentary or latching
Sleeve-Ring Switch: make/break; momentary or latching
FASLINK Il INTERFACE
Connectors: (1) XLR-F
WARNING: Connect ONLY to the FASLINK Il connector on a Fractal Audio FC Series controller
GENERAL
Finish: Powder-coated steel chassis
Controls: 12 buttons, 8 knobs (5 with additional “push” functions)
Display: 800x480 high contrast color LCD
Dimensions: 11.1"W. x 4.05"H.x9.3"D.
281Tmm W. x 103mm H. x 236mm D.
Weight: 7 Ibs 1.6 0z (3.22 kg)
Input Voltage: 90-264 VAC, 47 - 63 Hz (universal input)
Power Consumption: <40 W
Backup Battery Life: >10 years
Backup Battery Type: CR-2032
Ventilation: Onboard fan with side and bottom venting. WARNING: Do not block vent holes!
ENVIRONMENTAL

Operating Temperature:

Storage Temperature:
Humidity:

320122 °F (0 to 50 °C)
-22't0 167 °F (-30to 70 °C)
Max. 90% non-condensing

—
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15 SPECIFICATIONS

MIDI IMPLEMENTATION

The FM3 features a robust MIDI implementation detailed below.

Function Tx Rx | Remarks
Basic Channel Default 1 1
Changed 1-16 | 1-16
Note Number True Voice X X
Velocity Note ON X X
Note OFF X X
After Touch Keys X X
Channels X X
Pitch Bend X X
Control Change 0 0 Receivable CCs are globally soft-assigned to
functions via the MIDI/Remote menu under SETUP.
These include Input and Output volumes, Tap Tempo,
Tuner, 16 “External Controllers” (assignable as
modifiers to one or more parameters on a per-preset
basis), some Scene functions, all Looper functions,
and all block BYPASS and CHANNEL switches.
MIDI CC Transmit is performed using the Scene MIDI
Block or Control Switch MIDI.
Program Change True Number 0 0 The FM3 can transmit PC messages upon preset
Bank Select X 0 | change, or via the Scene MIDI Block or Control
Switch MIDI.
System Exclusive Fractal Audio 0 0 | SysExis used extensively for FM3-Edit.
Real time 0 X
Non-Real time X X
System Common Song Position X X
Song Select X X
Tune Request X X
System Real time Clock X 0 FM3 Global Tempo syncs automatically to MIDI Beat
Commands X x | Clock. FM3 does not transmit MIDI clock.
Auxiliary Messages | Local ON/OFF X X
All Notes OFF X X
Active Sense X X
Reset X X

—
N
o



WARRANTY

WARRANTY

Fractal Audio Systems warrants that your new Fractal Audio Systems product shall be free of defects in materials
and workmanship for a period of one (1) year from the original date of purchase.

During the warranty period, Fractal Audio Systems shall, at its sole option, either repair or replace any product that
proves to be defective upon inspection by Fractal Audio Systems.

Fractal Audio Systems reserves the right to update any unit returned for repair and to change or improve the
design of the product at any time without notice. Fractal Audio Systems reserves the right to use reconditioned
parts and assemblies as warranty replacements for authorized repairs. This warranty is extended to the original
retail purchaser for units purchased directly from Fractal Audio Systems or one of its authorized distributors or
resellers.

This is your sole warranty. Fractal Audio Systems does not authorize any third party, including any dealer or sales
representative, to assume any liability on behalf of Fractal Audio Systems or to make any warranty for Fractal
Audio Systems. Fractal Audio Systems may, at its option, require proof of original purchase date in the form of a
dated copy of original authorized dealer’s invoice or sales receipt. Service and repairs of Fractal Audio Systems
products are to be performed only at the Fractal Audio Systems factory or a Fractal Audio Systems authorized
service center. Fractal Audio Systems may require advanced authorization of repairs to authorized service
centers. Unauthorized service, repair or modification will void this warranty.

DISCLAIMER AND LIMITATION OF WARRANTY

THE FOREGOING WARRANTY IS THE ONLY WARRANTY GIVEN BY FRACTAL AUDIO SYSTEMS AND IS IN LIEU OF
ALL OTHER WARRANTIES. ALL IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR ANY PARTICULAR PURPOSE, EXCEEDING THE SPECIFIC PROVISIONS OF THIS WARRANTY ARE
HEREBY DISCLAIMED AND EXCLUDED FROM THIS WARRANTY. UPON EXPIRATION OF THE APPLICABLE EXPRESS
WARRANTY PERIOD (1 YEAR), FRACTAL AUDIO SYSTEMS SHALL HAVE NO FURTHER WARRANTY OBLIGATION OF
ANY KIND, EXPRESS OR IMPLIED. FRACTAL AUDIO SYSTEMS SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES SUFFERED BY THE PURCHASER OR ANY THIRD PARTY, INCLUDING
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS OR BUSINESS, OR DAMAGES RESULTING FROM USE OR
PERFORMANCE OF THE PRODUCT, WHETHER IN CONTRACT OR IN TORT. FRACTAL AUDIO SYSTEMS SHALL NOT
BE LIABLE FOR ANY EXPENSES, CLAIMS, OR SUITS ARISING OUT OF OR RELATING TO ANY OF THE FOREGOING.
Some states do not allow the exclusion or limitation of implied warranties so some of the above limitations and
exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights,
which vary, from state to state. This warranty only applies to products sold and used in the USA and Canada.
Fractal Audio Systems shall not be liable for damages or loss resulting from the negligent or intentional acts of
the shipper or its contracted affiliates. You should contact the shipper for proper claims procedures in the event
of damage or loss resulting from shipment.

—
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EULA

EULA

BY ACCEPTING, INSTALLING OR USING ANY PART OF THIS PRODUCT YOU ARE CONSENTING TO ALL OF THE TERMS AND CONDITIONS OF THIS ENTIRE END USER LICENSE AGREEMENT (“EULA"). IF YOU
DO NOT AGREE TO ALL THE TERMS AND CONDITIONS OF THIS ENTIRE AGREEMENT, ARE UNABLE OR UNWILLING COMPLY WITH THESE TERMS AND CONDITIONS, YOU MUST DISCONTINUE USE OF THE
PRODUCT IMMEDIATELY AS YOU HAVE NO AUTHORITY OR LICENSE TO USE THE PRODUCT.

TERMS AND CONDITIONS
1) GRANT OF LICENSE FOR PRE INSTALLED OR USER UPGRADED FIRMWARE (“THE SOFTWARE")

Subject to the terms and conditions set forth herein, Fractal Audio Systems, (“FAS”) grants you an individual, personal, non-sub licensable, nonexclusive license to use this product in accordance with the
applicable end user documentation, if any (the “License”). The user will not, directly or indirectly, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code or underlying
ideas or algorithms of the Software; modify, translate, or create derivative works based on the Software; or copy (except for archival purposes), rent, lease, distribute, assign, or otherwise transfer rights to the
Software (except as expressly authorized by this Agreement); remove any proprietary notices, comments, terms and conditions and or labels on or in the Software. As between the parties, you acknowledge
that FAS and its licensors retain their respective ownership of the Software, any portions or copies thereof, and all rights therein throughout the world. Upon termination of this Agreement for any reason, the
License and all rights granted to you under this Agreement will terminate and you will cease to use the Software. You may permanently transfer the limited rights of use of the Software granted to you under
this Agreement only as part of a permanent sale or transfer of the hardware device containing the software, and only if the recipient agrees to be bound by the terms and conditions of this Agreement. You
acknowledge that you have no rights in or to, and may not transfer or otherwise authorize the use of, any “beta” or “preview” software of FAS and its licensors. THIS LIMITED LICENSE TO USE AND TRANSFER
THE SOFTWARE IS PROVIDED AS-IS AND IS SUBJECT TO THE RESTRICTIONS, INDEMNITY AND WARRANTY DISCLAIMERS AND LIMITATIONS OF LIABILITY SET FORTH BELOW.

2) RESTRICTIONS, WARRANTY DISCLAIMERS AND INDEMNITY OBLIGATION AGREED TO BY YOU IN EXCHANGE FOR LIMITED GRANT OF LICENSE.

YOU WILL ONLY USE THE SOFTWARE FOR LAWFUL PURPOSES AND IN COMPLIANCE WITH ALL APPLICABLE LAWS. YOU HEREBY AGREE TO DEFEND AND INDEMNIFY FAS AND ITS LICENSORS AGAINST ANY
CLAIM OR ACTION THAT ARISES FROM YOUR USE OF THE SOFTWARE IN AN UNLAWFUL MANNER (INCLUDING, WITHOUT LIMITATION, ANY CLAIM OR ACTION ALLEGING INFRINGEMENT OF ANY PATENT,
COPYRIGHT, TRADEMARK, TRADE SECRET, OR OTHER INTELLECTUAL PROPERTY; UNFAIR COMPETITION; VIOLATION OF GENERAL BUSINESS LAWS; OR VIOLATION OF ANY OTHER LAWS OR RIGHTS) OR ANY
OTHER USE OF THE SOFTWARE NOT EXPRESSLY AUTHORIZED PURSUANT TO THIS AGREEMENT.

3) IMPULSE RESPONSE EXPORT FOR COMMERCIAL USE

Offering for sale any Impulse Response data (e.g. “Tone Match Export/Save/Dump”, “User Cab Export/Save/Dump”) created, converted or modified using Fractal Audio Systems hardware and/or software
requires a commercial use license. Recording studios, consultants, and other commercial entities may use these features in conjunction with work performed for their commercial customers, but the resulting
data files created may not be offered for sale or gifted to their commercial customers or other third parties without a commercial license from FAS and its licensors where applicable. Contact sales@
fractalaudio.com to obtain a commercial license.

4) IMPULSE RESPONSE DATA EXPORT FOR NON-COMMERCIAL USE

You are free to export Impulse Response data for non-commercial use. This includes producing, converting, or modifying Impulse Response data for yourself, or offering/distributing such data at no charge to
third parties. Files created without a commercial license cannot be included for free with another product or package that is offered for sale. Contact sales@fractalaudio.com to obtain a commercial license.

5) SUPPORT

Subject to the terms hereof, FAS will provide you with e-mail support services for the Software. Under no circumstances will FAS have any obligation to provide you with hard-copy documentation, upgrades,
enhancements, modifications, or telephone support for the Software.

6) TERMINATION

This Agreement is effective until terminated. Either party may terminate this Agreement upon written notice to the other party. FAS may also terminate this Agreement immediately, without prior notice or
liability, if you breach any of the terms or conditions of this Agreement. All sections of this Agreement which by their nature should survive termination will survive termination, including, without limitation,
warranty disclaimers and limitations of liability and limitations of use and transfer of the Software.

7) WARRANTY DISCLAIMER

The software is provided as is without warranty of any kind. FAS disclaim all warranties, expressed or implied, including but not limited to implied warranties, fitness for a particular purpose, and non-
infringement. Some states do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

8) LIMITATION OF LIABILITY

NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT OR OTHERWISE, YOU AGREE THAT FAS AND ITS LICENSORS WILL NOT BE LIABLE WITH RESPECT TO THE SUBJECT MATTER OF THIS
AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY, INFRINGEMENT OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE
DAMAGES OF ANY KIND. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE MAY NOT APPLY TO YOU.

9) EXPORT RESTRICTIONS

You acknowledge that the Software, or any part thereof, or any process or service that is the direct product of the Software (the foregoing collectively referred to as the “Restricted Components”) are of U.S.
origin. You agree to comply with all applicable international and national laws that apply to these products, including the U.S. Export Administration Regulations, as well as end-user, end-use and destination
restrictions issued by U.S. and other governments.

10) MISCELLANEOUS

The failure of either party to exercise in any respect any right provided for herein will not be deemed a waiver of any further rights hereunder of FAS and or its licensors. If any provision of this Agreement

is found to be unenforceable or invalid, that provision will be limited or eliminated to the minimum extent necessary so that this Agreement will otherwise remain in full force and effect and enforceable.

This Agreement will be governed by and construed in accordance with the laws of the state of New Hampshire without regard to the conflict of laws provisions thereof. You agree that this Agreement is the
complete and exclusive statement of the mutual understanding of the parties and supersedes and cancels all previous written and oral agreements, communications and other understandings relating to the
subject matter of this Agreement, and that all modifications to this EULA, or any commercial license that you may have obtained from FAS and or its licensors must be in a writing signed by you, FAS and or its
licensors, where applicable, except as otherwise provided herein. No agency, partnership, joint venture, or employment is created as a result of this Agreement and you do not have any authority of any kind to
bind FAS and or its licensors in any respect whatsoever. In any action or proceeding to enforce rights under this Agreement, the prevailing party will be entitled to recover costs and attorneys’ fees. All notices
under this Agreement will be in writing and will be deemed to have been duly given when received, if personally delivered; when receipt is electronically confirmed, if transmitted by facsimile or e-mail; the day
after it is sent, if sent for next day delivery by recognized overnight delivery service; and upon receipt, if sent by certified or registered mail, return receipt requested.
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